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CC stands for carbon copy. There’s verylittle difference between puttingall your
addressees on the “To:”line (separated by semicolons) and putting them on the
“CC?line; the only difference is that your name in the “CC:line implies, “I sent
you a copy because | thought you'd want to know aboutthis correspondence, but
I’m not expecting you to reply.”

 

Once again, use the address book to quickly type in these names, and be sure to
separate email addresses with semicolons. Press Tab when yourre finished.

3. ‘Type the topic of the message in the “Subject:”field.

Some people, especially those in the business world, get bombarded with email.
That's whyit’s courteous to put some thought into the Subject line (use “Change
in plans for next week” instead of “Hi,” for example),

Press the Tab key to move your cursor into the large message-body area.

4, Choose a format (HTML orplain text), if you like.

When it comes to formatting a message’s body text, you have two choices: plain
text or HTML (Hypertext Markup Language).

Plain text means that you can’t format your text with bold type, color, specified
font sizes, and so on. HTML,on the otherhand,is the language used to create Web
pages, andit lets you use formatting commands (such asfontsizes, colors, and bold
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oritalic text). But there’s a catch: Some email programs can’t read HTML-format-
ted email, and HTMLmail is muchlarger, and therefore slower to download, than
plain-text messages. (Forthat reason,it really irritates many computer pros.)

rTee 
So which should you choose? Plain text tends to feel a little more professional,
neverirritating anybody-—and yow’re guaranteed that the recipientwill see exactly
what was sent. If you send an HTML message to someone whose email program
can’t handle HTML,all is not lost—your message appearsin a friendly, plain-text
format at the top, and then again at the bottom,cluttered with HTML codes.

‘fo specify which format Outlook Express proposes for all new messages (plain
text or HTML), choose Tools—Options. Click the Send tab. Then, in the section
labeled Mail Sending Format, choose either the HTMLorPlain Text button, and
then click OK.

No matter which setting you specify there, however, you can always switch a par-
ticular message to the opposite format. Just choose Format—Rich Text (HTML),
or Format—Plain Text.

If you choose the HTMLoption,clicking in the messagearea activates the HTML
toolbar, whose variousbuttons control the formatting,font,size, color, paragraph
indentation,line spacing, and other word processor—like formatting controls.

Onething to remember:Less is more. Ifyou go hog-wild formatting your email, the
message maybedifficult to read. Furthermore, since mostjunk email is formatted
using HTMLcodes, using HTML formatting may route your message into some
people’s Junk Mail folders.

wn . Enter the message in the message box (the bottom half of the message win-
dow). 
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You can use all standard editing techniques, including Cut, Copy, and Paste, to
rearrange the text as you write it.  
i

Tip: if Microsoft Word is installed on your PC, you can aiso spell-check your outgoing mail—ust choose
Tools-»Spelling (or press F7) in the new message window. 

6. Add a signature, if you wish.

Signaturesarebits of text that get stamped at the bottom of outgoing email mes-
sages. They typically contain a name,a mailing address, or a Monty Python quote.
(Infact, some signatures are longer than the messages they accompany.)

To create a signature, choose ‘Iools—Options,click the Signatures tab, and then
click the New button, Theeasiest way to composeyour signatureis to type it into
the Edit Signatures text box at the bottom of the window. (If you poke around
long enoughin this box, you'll realize that you can actually create multiple signa-
tures—andassign each one to a different outgoing email account.)

Once you've created a signature (or several), you can tack it onto your outgoing
mail for all messages (by turning on “Addsignaturesto all outgoing messages”
at the top of this box) or on a message-by-message basis (by choosing Insert»
Signature in the New Message window).

7. Click the Send button.

Alternatively, press Alt+S, or choose File>Send Message. Your PC connects to the
Internet and sends the message,

Ifyou'd rather have Outlook Express place each message youwrite in the Outbox folder
instead of connecting to the Net each timeyouclick the Send button,see “Send tab.”
on page 398. There you'll discover how to make Outlook Express quietly collect your
outgoing mail—until youclick the Send/Recv button on the toolbar, thatis.

The Address Book

Accumulating names in an address book—the same one described on page 196—
eliminates the need to enter complete email addresses whenever you want to send
a message. Click the Addresses button on the toolbar; then, to begin adding names
and email addresses,click New.

Fip: Outlook Express offers a convenient timesavingfeature: the ToolsAdd Sender to Address Book com-
mand. Whenever you chooseit, Outlook Express automatically stores the email address of the person whose
message is on the screen. (Alternatively, you can right-click an email address in the message and choose
‘Add to Address Book"from the shortcut menu.) 

Altachingfiles to messages
Sendinglittle text messages is fine, butit’s not much help when you want to send
somebody a photograph, a sound recording, a Word or Excel document, and so on.
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Fortunately, attaching suchfiles to email messagesis one of the world’s most popular
email features.

‘To attachafile to a message,use either of two methods:

+ The long way. Click the Attach button on the New Message dialog box toolbar.
Whenthe Insert Attachmentdialog box opens, navigate the folders on your drive to
locate thefile and selectit. (In the resulting navigation window, Ctrl-click multiple
files to attach them all at once.)

Whenyou click the Attach button, the name of the attached file appears in the
message in the Attach text box.(In fact, you can repeat this process to send several
attached files with the same message.) When you send the message, thefile tags
along.  

Note: |f you have a high-speed connectionlike a cable modem,havepity on your recipients if they don't.
A big picture or movie file might take you only seconds to send, but fie up your correspondent's modem
for hours. If you intend to send a photo,for example, use the technique described on page 219, and ake
advantage of X?’s offer to scale downthe imageto emailable size before sending it

+ The short way. If you can see the icon ofthefile you wantto attach—inits folder
window behind the Outlook Express window—then attachit by draggingits icon
directly into the message window. That’s a handy technique when you're attaching
manydifferentfiles. 

Tip: To remove a file from an outgoing message before you've sent it, right-click its icon and choose Remove
{rora the shortcut menu—orjust left-click it and then press the Delete key. 

Reading Email
Just seeing a list of the names of new messages in Outlook Express is like getting
wrapped presents; the best part is yet te come. There are two ways to read a message:
using the preview pane, and opening the message into its own window.
To preview a message,click its namein thelist pane; the body of the message appears
in the preview pane below. Don’t forget that you can adjust the relative sizes of the list
and preview panes by dragging the gray border between them up or down.
To open a messageinto a windowofits own, double-click its namein thelist pane. An
open message hasits own toolbar, along with Previous and Next message buttons.
Regardless of your viewingpreference, any attached pictures, sounds, or moviesalso
appear in the body of the message; what's more, these sounds and movies can be
played in the email messageitself.

Once you’ve read a message, you can view the next one in the list either by pressing
Ctrl +right arrow (for the next message) or Ctrl +U (for the next unread message),
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or byclicking its name in thelist pane. (If you're using preview mode, and haven't
opened a message into its own window, you can also press the up or down arrow key
to move from one message to the next.)  
 

Tip: To mark a message that you've read as an unread message, so thatits name remains bolded, right-click
its namein thelist pane and choose Mark as Unread from the shortcut menu. 

Here’s another timesaver: To hide all the messages you've already read, just choose
View—Current View—>Hide Read Messages. Now, only unread messagesare visible
in the selected folder. To bring the hidden messages back, choose View—>Current
View—Show All Messages.

How to Process a Message
Once you've read a message and savored the feeling of awe broughton by the miracle
of instantaneouselectronic communication, you can process the message in any of
several ways.

Deleting messages
Sometimesit’s junk mail, sometimes you're just done with it; either way,it’s a snap
to delete a message.Just click the Delete button on the toolbar, press the Delete key,
or choose Edit—Delete. (You can also delete a batch of messages simultaneously by
highlighting the entire group and then using the same button, menu command, or
keystroke.)

Either way, the message or messages don’t actually disappear, just as movingafile
icon to the Recycle Bin doesn’t actually deleteit. Instead, these commands movethe
messages to the Deleted Items folder; if you like, click this folder to view a list of the
messages youve deleted. You can even rescue some simply by dragging them into
anotherfolder (such as right back into the Inbox).

Outlook Express doesn’t truly vaporize messages in the Deleted Items folder until
you “empty the trash.” You can empty it in any of several ways:

TAC igla
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- Right-click the Deleted Itemsfolder. Choose “Empty ‘Deleted Items’ Folder” from
the shortcut menu. 

» Click a message, ora folder, within the Deleted Items Folder list and then click the
Delete button on the toolbar(or press the Delete key). You'll be asked to confirm
its permanentdeletion.

+ Set up Outlook Express to delete messages automatically when you quit the pro-
gram. To do so, choose ToolsOptions. On the Maintenance tab, turn on “Empty
messages from the ‘Deleted Items’ folder on exit.” Click OK.

Replying to Messages
To reply to a message, click the Reply buttonin the toolbar, or choose Message—Reply
to Sender, or press Ctrl+R. Outlook Express creates a new, outgoing email message,
preaddressedto the sender’s return address.

To save additional time, Outlook Express pastes the entire original message at the
bottom of your reply (complete with the > brackets that serve as Internet quoting
marks); that’s to help your correspondentfigure out what you'retalking about.(‘To
turn off this feature, choose Tools—+Options,click the Sendtab, and turn off“Include
message in reply.”) Outlook Express even tacks Re: (“regarding”) onto the front of
the subjectline.

Your cursor appearsat the top of the message box; now begin typing your reply. You
can also add recipients, removerecipients, edit the subject line or the message, and
so on.

oe

Tip: Usethe Enter key to create blank lines within the bracketed original message in orderto place your
own text within it Using this method, you can splice your own comments into the paragraphsof the originai
message, replying point by point. The brackets precedingeach line of the original message help your cor
respondentkeep straight what's yours and what's hers. 

Note, by the way, that there are three kindsofreplies, each represented by a different
icon on the toolbar:
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- A standardreply goesto the sender of the message (click the Reply button). Ifthat
sender is a mailinglist (see the sidebar box below), then the messagegets sent to
the entire mailing list, which has gotten more than one unsuspecting novice PC
fan into trouble.

 

+ Reply Group (available only when you're reading newsgroup messages) creates a
reply intended for the entire Internet—thatis, everyone whoreads this newsgroup.
(By contrast, click Reply to shoot a private note to only one person: the person
whotyped the message.}

* The Reply To All button addresses a messageto all recipients of the original mes-
sage, including any CC recipients. This is the button to useifyou're participating
in a group discussion of sometopic. For example,six people can simultaneously
carry on an email correspondence, always sending each responseto the otherfive
in the group.

Forwarding Messages
Instead of replying to the person who sent you a message, you may sometimes want
to forward the message—pass it on—to a third person.

To do so, click the Forward button in the toolbar, choose Message--Forward, or
press Ctrl+F A new message opens, lookinga lotlike the one that appears when you
reply. Once again, before forwarding the message, you havethe option of editing the
subjectline or the messageitself. (For example, you may wishto precede theoriginal
message with a commentof your own,alongthelines of: “Frank: ] thought you'd be
interested in this joke about Congress.”)

All that remainsis for you to specify whoreceives the forwarded message.Just address
it as you would any outgoingpiece of mail.

Figure 12-4:
Before you click OK, be sure
to click the nameofthe exist-

ing folder that you wantto
contain your new one. Most
of the time, you'llprobably
wantto click the Local Fold-

ers icon before creating the
new folder.

Filo Edit vient - Tools. Message. Hel
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Printing Messages
Sometimes there’s no substitute for a printout of an email message-—an area where
Outlook Express shines. Just click the Print button in the toolbar, choose File->Print,
or press Ctrl+P. The standard WindowsPrint dialog box popsup, so that you can
specify how manycopies you want, what rangeof pages, and so on.Finally, click the
Print button to begin printing.

 

Filing Messages
Outlook Express lets you create new foldersin the Folderslist; by dragging messages
from your Inbox ontooneofthese folder icons, you can file away your messagesinto
appropriate storage cubbies. You might create one folder for important messages,
anotherfor order confirmations when shoppingon the Web,still another for friends
andfamily, and so on.In fact, you can evencreate foldersinside these folders,a feature
beloved by the hopelessly organized.

To create a new folder, choose File>Folder>New,orright-click the Local Folders
icon (in the folderlist), and choose New Folder from the shortcut menu (Figure 12-4,
left). Either way, a Create Folder window appears, providing a place to name the new
folder (Figure 12-4, right).
 

Fip: To rename an existing folder, right-click it and choose Rename from the shortcut menu. 

To move a message into a folder, proceed like this:

+ Drag it out of the list pane and onto the folder icon. You can use anypart of a
message’s “row”in the list as a handle. You can also drag messages en masse onto
a folder.

* Control-click a message (or one of several that you've highlighted). From the
resulting shortcut menu, choose Move to Folder. In a dialog box, the foider list
appears; select the one you want, then press Enter or click OK.

Fip: When you click a + button in the Folder‘ist, you seeall folders contained within that folder, exactly as
in Windows €xplorer, You can drag folders inside otherfolders, nesting them to create a nice hierarchical
folder structure. (To drag a nested folder backinto the list of “main”folders, just drag it to the Local Folders
icon.} ,

You can also drag messages betweenfolders; just drag one from the messagelist onto the desired folder
ai theleft side of the screen.

This can be a useful trick when applied to a message in your Outbox. If you decide to postponesending it,
drag it into any otherfolder; Outlook Express wan't send it until you dragit Back into the Outbox, 

Flagging Messages
Sometimes, you'll receive an email message that prompts you to somesort of action,
but you may not havethe time(or the fortitude) to face the task at the moment. (“Hi
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there... it’s me, your accountant. Would you mind rounding up your expenses for
1993 through 2001 and sending mea list by email?”)

 
That’s why Outlook Express provides the Flag commands, which let you flag a mes-
sage, positioningalittle red flag in the corresponding column next to a message’s
name. Theselittle red flags are simply visual indicators that you place for your own
convenience, meaning whatever you want them to mean, You can bringall flagged
messages to the top ofthelist by choosing View—Sort By>Flag,

To flag a messagein this way, select the message (or several messages) and choose Mes-
sage—>Flag Message. (Use the same command again to cleara flag from a message.)
ttia
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Opening Attachments
Just as you can attach files to a message, people can also sendfiles to you. You know
when a message has an attachment because a paper clip icon appears next to its name
in the Inbox.

Outlook Express doesn’t store downloaded files as normal file icons on your hard
drive. All your messages and all the attached files are part of one big, specially en-
coded mail file. To extract an attachedfile from this mass of software, use one of the

following methods:

+ Click the attachmenticon (Figure 12-5), select Save Attachmentsfrom the shortcut
menu, and then specify the folder in which you want thefile saved.

+ Click the attachmenticon. A shortcut menu appears, from which youcan either
choose the name of the attachment to open the file directly (in Word, Excel, or
whatever), or Save Attachments to save it to the disk.

 
+ If you've double-clicked the message so that it appears in its own window, then

drag the attachment icon out of the message window and onto any visibie portion
of your desktop, as shown in Figure 12-5.

 

« Again ifyou've opened the message into its own window, you can double-click the
attachment’s icon in the message. Once again, you'll be asked whether you want
to open the file or save it to the disk.

Nofe: Whenever you open dn attachmentdirectly from within the email (rather than savingit to the disk
first), use the FileSave As commandto savethefile into a foider! Otherwise, you won't be able to open
the file again except from within Outlook Express~and any changes you make to that documentwill appear
only when you open: it from within Outlook Express, too.
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An important reminder:Ifthe Save As shortcut menuis dimmed,orifyou see a “This
attachment has been blocked” message,it’s because Outlook Expressis protecting you
from an attachmentit believes might contain a virus. See page 338 for details and
workaroundsto this Service Pack 2 feature.

Message Rules
Once you know howto create folders, the next step in managing your email is to set
up a series of message rules, Message rulesarefilters that can file, answer, or delete an
incoming message automatically based on its subject, address, or size. Message rules
require you to think like the distant relative of a programmer, but the mental effort
can reward you many times over. In fact, message rules can turn Outlook Express
into a surprisingly smart andefficient secretary.

Setting up message rules
Now that you're thoroughly intrigued about the magic of message rules, here’s how
to set one up:

Figure 12-6:
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sage rule entails specifying
which messages you want Ete efor conta page
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1. Choose Tools>Message Rules—Mail-

The New Mail Rule dialog box appears, as shown in Figure 12-6 at topleft.
 

M . Use the top options to specify how Outlook Express should select messages to
process.

For example,ifyou'd like Outlook Express to watch out for messages from a par-
ticular person, you would choose, “Where the From line contains people.”

To flag messages containing loan, $$$$, XXXX, !!/!, and so on, choose, “Where the
Subject line contains specific words.”

Ifyou turn on more than one checkbox, you can set up another condition for your
message rule. For example, you canset up thefirst criterion to find messagesfrom
your uncle, anda second that watchesfor subject lines that contain “humor.” Now,
only jokes sent by your uncle will get placed in,say, Deleted Items.

(If you've set up more than onecriterion, yowil see the underlined word and at
the bottom ofthe dialog box. It indicates that the message rule should apply only
if all of the conditionsare true. Click the and to producea little dialog box, where
you havethe option to apply the rule if any of the conditions are met.)

ww . Using the secondset of checkboxes, specifywhat you wantto happen to messages
that match thecriteria.

If, in step 2, you told your rule to watch for junk mail containing $$$$ in the Sub-
ject line, here’s where you can tell Outlook Express to delete or move the message
into, say, a Spam folder.

With a little imagination, you'll see how these checkboxes can perform absclutely
amazing functions with your incomingemail. Outlook Express can delete, move,
or print messages; forward or redirect them to somebody; automatically reply to
certain messages; and even avoid downloadingfiles bigger than a certain number
of kilobytes(ideal for laptop lovers on slow hotel room connections).

a . Specify which words or people you want the messagerule to watch out for.
In the bottom of the dialog box, you can click any of the underlined phrases to
specify which people, which specific words, which file sizes you want Outlook
Express to watch out for—aperson’s name, or XXX, in the previous examples.

If you click contains people, for example, a dialog box appears in which you can
access your address book to select certain individuals whose messages you want
handled bythis rule. If you click contains specific words, you can type in the
words you wanta certain rule to watch outfor (in the Subject line, for example;
see Figure 12-6, top). And so on.

5, In the very bottom text box, name your mail rule. Click OK.

Now the Message Rules dialog box appears (Figure 12-6, bottom). Here, you can
managetherules you've created, choose a sequencefor them (thoseat the top get
applied first), and apply them to existing messages (by clicking Apply Now).
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Tip: Outlook Express applies rules as they appear-from top to bottom-in the Message Rules window;if
a rule doesn’t seem to be working properly, it may be that an earlier rule is intercepting and processing
the message before the “broken”rule even seesit. Te fix this, try moving the rule up or down in the list by
selecting it and then clicking the Move Up or Move Down buttons.

 
 

Two sneaky message-rule tricks
You can use message rules for many different purposes. But here are two of the
best:

« Create a spam filter. When a spammer sends junk email, he usually puts your
address on the “BCC:”(blind carbon copy)line, to prevent you from seeing who
else received the message. This characteristic makesit easy to screen out such mail,
and create a message rule that looks for messages where the “To:” or “CC:”line
contains your address—and files them into the Inbox as usual.

But then create another message rule for “For all messages” that puts messages
into a folder that you've created-—cailed, for example, Possible Spam. Because the
second rule doesn’t kick in until after the first one has doneits duty, the second
rule affects onlymessages in which your name appeared on the “BCC:”line (which
is almost always spam). Once a week,it’s wise to look throughthe Possible Spam
folder in case a legitimate message foundits way there.

* The email answering machine.If you're going on vacation, turn on “Forall mes-
sages” in step 2, and then “Reply with message”in step 3. In other words, you can
turn Outlook Express into an email answering machinethat automatically sends
a canned “I’m away until the 15th” message to everyone whowrites you.

Tip: Be sure to unsubscribe from,or turn off, any email mailing lists before you turn on “Forall messages”.
otherwise, you'll incur the wrath of the otherInternet citizensby littering their email discussion groups with
copies of your auto-reply message.

Configuring Outlook Express
Outlook Express has enough features and configuration optionsto fill a very thick
book. You can see them for yourself by choosing ToolsOptions from the Outlook
Express window(see Figure 12-7). Here’s an overview of someof the features you'll
find.

General tab

Most of the controls on the General tab govern what Outlook Express does when
you first launch it. Take note of the options for configuring automatic connection
to your ISP. You can select the option to check for messages every few minutes, and
then use the drop-down list to tell Outlook Express how, and whether, to connectat
that time—if you're notalready online,
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Read tab
Use these optionsto establish how the program handles messages in the Inbox. One
of these options marks a message as having been read—changing its typeface from
bold to non-bold—ifyouleaveithighlightedin thelist for five seconds or more, even
without openingit. That’s one option you may wantto consider turning off. (This
is also where you choose the font you wantto use for the messages you're reading,
which is an important consideration.)

 

  

Figure 12-7:
The Options dialog box has ten tabs,
each loaded with options. Most tabs
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Receipts tab
You can addareturn receipt to messages you send. Whentherecipient reads your mes-
sage, a notification message (receipt) is emailed back to you under two conditions:if
the recipient agrees to send a return receipt to you, andifthe recipient's email program
offers a similar feature. (Outlook Express, Outlook, and Eudoraall do.)

Send tab

The optionson the Sendtab govern outgoing messages. One option to consider turn-
ing offhereis the default option, “Send messages immediately.” That's because as soon
as you click the Send button, Outlook Express tries to send the message, even if that
meanstriggering your modemto dial. All of this dialing—and waiting for the dial-
ing—drives some people crazy, especially in households with only one phoneline.

 
 

 
398 WINDOWS XP PRO! THE MISSING MANUAL HP Inc. - Exhibit 1007 - Page 12 Be



HP Inc. - Exhibit 1007 - Page 413

 

If you turn this option off, then clicking the Send button simply places a newly writ-
ten message into the Outbox. As you reply to messages and compose new ones, the
Outbox collects them. They're not sent until you choose Tools—Send and Receive
(or click Send/Recv on the toolbar, or press Ctrl+M). Only at that point does Outlook
Express command your modem to dial the Internet. It then sendsall the waiting
outgoing mail at once,

 

Tip: To see the messages waiting in your Outbox, click the Outbox icon at the left side of the screen. At this
point, you can click a message's name (in the upper-right paneof the screen)to view the messageitself in
the fower-right pane, exactly as with messages in your Inbox,

Don't botherto try editing an outgeing messagein this way, however, since Outlook Express won't fet you
do so. Only by double-clicking a message's name(in the upper-right pane), thus openingit into a separate
window, can you make changes to a piece of outgoing mail.

The Sendtabalso includes features for configuring replies. For example, you can dis-
able the function that puts the original message at the bottom ofa reply.

Finally, the “Automatically put people I reply to in my Address Book”can be a real
timesaver. Each time you reply to somebody,his email address is automatically saved
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in your address book, so that the next time you wantto write him a note, you won't
need to look up the address—justtype thefirst few letters ofit in the “To”box. 
Compose tab
Here’s where you specify the font you want to use when writing messages and
newsgroup messages.

This is also the control center for stationery; it houses custom-designed templates,
complete with fonts, colors, backgrounds, borders, and other formatting elements
that you can use for all outgoing email. Needless to say, sending a message format-
ted with stationery meansthat you're using HTML formatting, as described earlier,
complete with its potential downsides.

To choosea stationery style for all outgoing messages, turn on the Mail checkbox
and then click the Select button. You're offered a folder full of Microsoft stationery

templates; click one to see its preview. You can also click the Create New button on
the toolbar, which launchesawizard that walks you through the process of designing
your own background design.  

Tip: You don't have to use oneparticularstationery style for ali outgoing messages. When sending a mes-
sage, instead of clicking the Create Mail button onthe OutlookExpress toolbar,just click the tiny down-arrow
triangle next to it Doing so opens a windowthatlists several stationery styles, letting you choose one ona
message-by-message basis.  

 
 

Signatures tab
As noted earlierin this chapter, you usethis tab to design a signature for your messages.
Byclicking the New button and entering more signature material in the text box, you
can create several different signatures: one that’s for business messages, one for your
buddies, and so on. (Outlook Express calls them Signature #1, Signature #2, and so
on, To renamea signature,click its name and then click the Rename button.)

 

To insert a signature into an outgoing message, choose Insert—Signature, then choose
the one you wantfrom thelist that appears.

Spelling tab
The Spellingtab offers configuration optionsfor the Outlook Express spell-checking
feature (which requires that you have Microsoft Word), You can even force the spell
checker to correct errors in the original message when you send a reply (although
your correspondent may not appreciate it}.

Security tab
This tab contains options for sending secure mail, using digital IDs, and encryption.
If youre using Outlook Express in a business that requires secure email, the system
administrator will provide instructions. Otherwise, you'll find that most of these
settings have noeffect. 
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Tip: Oneof these optionsis very useful in the modern age: “Warn me when other applications try to send
mail as me."That's a thinly veiled referenceto virus programsthat, behind the scenes, send out hundredsof
infected emails to everybody in your address book. This aption ensuresthat if some software—not you—tries
io send messages, you'll know aboutit.

 
 

Connection tab

You change options for making and sustaining the connection to your ISP in the Con-
nection tab. For example, you cantell Outlook Express to hang up automaticallyafter
sending and receiving messages (and reconnect the next time you wantto perform
the sametasks), As noted in the dialog box, though, Outlook Express otherwise uses
the same Internet settings described in Chapter9.

Maintenance tab

This tab is your housekeeping center. These options let you clear out old deleted
messages, clean up downloads, and so on.

Newsgroups

Newsgroups have nothing to do with news; in fact, they’re Internet bulletin boards.
Thereareat least 50,000 of them, on every conceivable topic: pop culture, computers,
politics, and every other special (and very special) interest; in fact, there are several
dozen just about Windows. Use Outlook Express to read and reply to these messages
almost exactly as though they were email messages.

Furthermore, Outlook Express lets you use multiple news servers (bulletin-board
distribution computers), subscribe to individual newsgroups,filter messages in your
newsgroups using rules, and post and read messages complete with attachments.
 

Note: if a news server (not an individual newsgroup) is selected in the Folders list, then the rightmostportion
of the Outlook Express interface displays a list of newsgroupsavailable on that server.

aTSodaa
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Setting Up an Account
Setting up a new newsaccountis similar to setting up a new email account; the ad-
venture begins by contacting your Internet service provider and finding outits news
server address, along with your user name and password.

 
Next, choose Tools—Accounts; click the Newstab, click the Add button,and then
click News.

Now a wizard steps you through the process of creating a news account in Outlook
Express;it involves entering your email address and the address of your news server.
(Sometimes you get newsgroup access with your regular Internet account.If your
ISP doesn’t provide newsgroup access, you'll have to subscribe to a newsservice. The
price depends on how much you download each month; visit www.easynews.com,
www.supernews.com, or www.newsguy.com for more information.)

Downloadthe List of Newsgroups
Whenyou'refinished with the wizard, Outlook Express invites you to downloada list
of newsgroups available on your server. Click the Yes button, and then wait patiently
for a few minutes.

Outlook Express goes to work downloadingthelist, which can be quite long—more
than 50,000 entries, in many cases—andtakes several minutes if you connect to the
Internet with a dial-up modem. Oncethat’s done, though, you won't have to doit
again.

You wind up withthe dialog box shown in Figure 12-8. (You can alwaysget to this mas-
ter list of newsgroups by choosing ToolsNewsgroups, or by pressing Ctrl+W.)

Figure 12-8:
fn the text box af the top,

ee ace : | enter the text you want to
[Akio seam deserpfionsos Jaok for in the newsgroup’s

a i title (such as windowsxp, as
oe “4 Shawn here—in cyber-

$8microsalt public. nindowssp. general space, there are no spaces
mniroentpubiswindowesaherder | between words). ifyou turn

8miprosott public. windowsup.help_and_sunpot | up an appealing-sounding
microsoft. public. windowreypmageenger A topic inthe gigantic list
snicrosolt public. eirdowanp.music: beneath, dick its name and
sferoceft puble windovesep retwots web L click the Subscribe button to

microsa y g.perlorn,. : subscribe fo ft, Now Outlook
mictosott public. windovwssapphotos ; Express will downloadthe
saicrosaltausblic. windowsappaint_fax § atest messages on that
oe : Eee: : : topic each time you connect. 
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Finding Newsgroups and Messages
If you're lookingfora particular topic, such as Windows XP, you can viewalist of
matching discussions by typing a phrase into the text box that’s labeled, however un-
grammatically, “Display newsgroups which contain’at the top ofthe window. Outlook
Express hides any newsgroups that don’t matchthattext (see Figure 12-8).

Reading Messages
Once Outlook Express has downloadeda list of available newsgroups,it’s up to you
to sift through them andselect the discussions you want to monitor.

Fortunately, Outlook Express makesit easy to follow the raging Internet discussions
with a feature called subscriptions. To subscribe to a newsgroup,select its name in
the list, and then click the Subscribe button. When you click OK, an icon for that
discussion topic appears under the server's namein the Folderlist, acting as though
it’s a nested folder.

The next time you connect to the Internet, Outlook Express downloads all of the
message summaries in the discussions to which you've subscribed. (There may be just
a few messages,or several hundred; they may go back only a few days or a couple of
weeks, depending on the amount of “traffic” in each discussion and the amount of
storage space available on the news server.) These are not the messages themselves,
just the keaders—the author’s name,the subject, and the date the message wassent.

To read the actual messages in a newsgroup,eitherclick an entry in thelist ofmessages
to download the contents of the message anddisplay it in the previewwindow (Figure
12-9), or double-click an entry to open thelist of messages in a new window.

Figuve 12-9:
ifyou've been using
Outlook Express for
email, the newsgroup
portion of things should
fook familiar. it uses the

 

some three-pane view:
The Folders pane fists
news servers to which

you've subscribed. the
top-rightpanelists the
names ofmessages in
a selectednewsgroup,
and the bottom-right
pane displays the
actualtext of the mes-

sage you've highlighted
in the messagelist. (Ifa
newsgroup name is too
long to see in its litte
panel, pointto it without
clicking, as shown here.)

a Outlook Express
1) Local Foiders

2 AG Inbow (25)
Eh Outbox

© 98% Sent Thoms
fiGQ Deleted items (149)<3 Drafts (2)

ea Newsoptontne.net
a Sy iicvoseft puble.aindowsap Bip

Jobr BE. Carty
eMhyhe?
Stari Brown
Kelly

(5 Gl te: Cant acess "HELP and SuppORT" cybs
EY Re: Cart accacs "HELP acd SUPPORT" Ron SmithPaul Ternahan

Oday, Tn an idiot... Here's what happened:

First, for some strange reason, my computer (running KP Professional)
| arbitrarily decided to delete the ‘Open! option for FoldersFileFolders such

that when I double clicked on a folder, they would open in a DOS shell
mastead, (Nota bene. The ‘Cornmand Prompt Here’ option was a nen-
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Someparticularly large attachments in newsgroups are automatically divided into
multiple segments, in part to accommodate those with slow Internet connections.If
you're having trouble saving a multipart attachmentto your hard drive, make sure
that you’ve selected the message that containsthefirst part. (Even then, you mayfind
that joining multipart newsgroup messagesisn’t one of Outlook Express’s strongest
features.)
 

Tip: You can set up message rules to screen out messages from certain people, messages with certain
phrases in their Subject lines, and so on. It works exactly like the message rules for email, as described
earlierin this chapter.

 
 

Replying, Composing, and Forwarding Messages
Working with newsgroup messagesis very similar to working with email messages,
except that you must be consciousofwhetheryou're replyingto the individual sender
of a message orto the entire group. Otherwise, you can reply to messages, forward
them, or compose them exactly as described earlier in this chapter. As with email,
you can useplain text or (if you don’t mind annoyingthe other Internetcitizens)
HTMLformatting, and includefile attachments, too (use the Attach toolbar button,
for example).
 

Tip: Aside from posting advertisements and HTMLformatted messages,the best wayto irritate everyone on
a newsgroupis to ask a questionthat has already been answered recently on the newsgroup. Before asking a
question, spendfive minutesreading the recent newsgroup messagesto see whether someone has already
answered your question.Also considervisiting the Groups tab at www.gaogie.com, a Website that lets you
search ail newsgroupsforparticular topics.
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Printing, Fonts,
and Faxing

the PC explosion had exactly the opposite effect: Thanksto the prolifera-tion
of inexpensive, high-quality PC printers, we generate far more printouts than

ever. There’s not much to printing from Windows XP, so this is a short chapter.

Technologists got pretty excited about “the paperless office”in the eighties, but

installing a Printer

A printer is designed to follow computer instructions called printer codes from your
PC. These codestell the printer what fonts to use, how to set margins, which paper
tray to use, and so on.

But the codes aren't identical for every printer. Therefore, every printer requires a
piece of software—the printer driver—thattells the printer how to interpret whatit
“hears” from your computer.

Windows XP comes with hundreds of printer drivers built right in; your printer also
came with a set of drivers on a CD or floppy. You can often find more recent driver
software for your printer on the manufacturer’s Web site, such as www.epson.com or
www.lexmark.com, or from a central driver repository like www.windrivers.com.

Existing Printers
Did you upgrade your PC to Windows XP from an earlier version—onethat worked
fine with your printer? In that case, Windows XP automatically notices and inherits
your existing settings. Ifit’s a fairly recent printer with a fairiy recent driver, it'll prob-
ably work fine with Windows XP.
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PSEaril Butif the printeris especially elderly, the printer software may be incompatible with
Windows XP.In thatcase, yourfirst activity after dinner should beto search the printer
company’s Website for an updatedversion,or check Microsoft’s master Windows XP
compatibility list at www.microsoft.com/hel.

If you just bought a new computer or a new printer, however, you'll have to hookit
up yourself andinstall its software. In general, there’s not muchtoit.
 

Note: Only people with Administrator accounts can install a new printer to a Windows XP machine (see
Chapter 16). 

USBPrinters

If youre like most people at homethese days, you use an inkjet printer that connects
to your PC’s USB (Universal Serial Bus) port. As a technology, USB has lots of advan-
tages: USB gadgets are easy to connect and disconnect, are very fast, conserve space,
can be plugged and unplugged while the PC is running, andso on.

Just the act of connecting a USB printer to your PC, for example, inspires Windows
XP to dig into its own bagofincluded driver modulesto install the correct one (Figure
13-1). See Chapter 14 for more onthis process.

Figure 13-1;
You gotlucky. Windows recognizes your
printer, has the appropriate driver, and
has putthe softwareinto place. Let the

J) Found New Hardware i |. printing begin.
| Your new hardwareis installed and ready to use { 

Network Printers

If you work in an office where numerouspeople on the networksharea single laser
printer, the printer usually isn’t connected directly to your computer. Instead,it’s
elsewhere on the network; the Ethernet cable coming out of your PC connects you
to it indirectly.

In general, there’s verylittle involved in ensuring that your PC “sees”this printer. Its
icon simply showsupin the Start—>Control PanelPrinters and Faxesfolder. (Ifyou
don’t see it, run the Add Printer Wizard described in the following section. Onits |
secondscreen, you'll be offered the chance to look for “A network printer, or printer
attached to another computer.” That’s the one you want.)
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Parallel, Serial, and Infrared Printers eTeg
Although USBprinters are the world’s most populartype today, there was, believe
it or not, a time before USB. In those days, most homeprintersfell into one ofthese
categories:

° Parallel. Before USB changed the world, most printers connected to PCs using a
printer cable or parallel cable, The cable connects to your PC’s parallel port, which
Microsoft's help screenscall the LPT1 port—a 25-pin, D-shapedjack. (On many
PCs, this connectoris marked with a printer icon on the back panel.)

¢ Serial. Otherolder printers use a cable connected to one ofyour computer’s serial
(or COM)ports, the connectors that often accommodate an external modem. The
primary advantage of a serial connection is the extended cable length: Parallel
cables must be no more thanninefeet long, while serial cables up to 50 feet long
work fine.

ip: To protect its innards, turn off the PC before connecting or disconnecting a parallelorserial cable. 

 
   Figure 13-2: rel

Top: As the note Add Printer Wizard

  
   
 
  

aessay Welcometo the Add Printer
yourprinter doesn’t Wizard
connect to your USB or
FireWire (IEEE 1594) This wizard helps youinstall a printer or make printer
port. connections.   
   
 Bottom:In this window,
   
  
    

 
 

    
   
      

 

  
  

  

5 a 4 i if you have a Plug and Flay printer that connects
uy the ‘Automatically YD through & USB port for any ather het pluggable
detect and install my port, such as IEEE 1394, sara and so on), youPlug and Playprinter’ ss : do not need to use this wizard, Click Can
option first, as shown Add Printer Wizard
here. If Windows can’t =
automatically detect the Local or Network Printer
brand and modetof the The wizard needs to know which type of printer to set up.
printer you've attached, = — Sa
return to this screen Select the option that describes the printer you want ta use:
and turn off this option. cs
You'll wind up in the >» Local printer attached te this computes
dialog box shown in the Automatically detect and install my Plug and Play printer
next illustration. €>A network printer, or a printer attached te another computer  

  
 

: To sat up a network printer that is not attached to a print setver,LD isa the "Local printet” option,
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Epa W agCp + Infrared. Certain printers from HP, Canon, Citizen, and other companies print
using infrared technology—thatis,there’s no cable atall. Instead,ifyour PC has an
infrared lens (as manylaptops do), it can communicate with the printer’s similar
lenswirelessly, as long as the printer and PC are within sightof, and relatively close
to, each other.

If the technology gods are smiling, you can just connect the printer, turn on your
Windows XP machine, and delightin the “Found new hardware” message that appears
on your taskbar. You're ready to print.

But if Windows doesn’t “know about” the printer model you've hooked up,it can’t
install its drivers automatically. In that case, the Add Printer Wizard appears (Figure
13-2)—or you can always openit. (Choose StartControl Panel—>Printers and Faxes;
click the Add Printer link.) Click Next to walk through the questions until you've
correctly identified your printer andinstalled the appropriate software.
Hereare the guidelines for using the next screen:

: Try the “Automatically detect andinstall my Plug and Playprinter” checkboxfirst
(see Figure 13-2 at bottom). If it doesn’t succeed in locating your printer and
installing the software, run the wizard again,this time turning that option off.

- If the “Automatically detect” option didn’t work, you'll be asked to specify which PC
port yourprinter’s connectedto. You'll then be asked to indicate, from a gigantic
scrolling list of every printer Microsoft has ever heard of, your exact brand and
model (Figure 13-3).
 

 
Figure 13-3:
Theleft panelists every
printer manufacturer Micro-
soft has ever heard of. Once

you've selected yourprinter's
ms : s eT 4 manufacturer, a list ofall
3 Select the manufacturer and modelof yourprinter. If your printer came with an installation

Pvt (ne CaTclmeatTa

Install Printer Software ea:
The manufacturer and model determine whichprinter software to use. a

 disk, click Have Disk. If yourprinteris not listed, consult your printer documentation for the printer models from that
compatible printer software, manufacturer (that Windows

XP knows about) appearsin
the right pane. Click the Have

ery spay ; : 5 ey Disk button if yourprinter's
|Manuiacturer F Printers oh |)|driver software is on a diskjAgts ME Apple Lasenatiter Select 260 —— ||supplied by the manufacturer.

Pas SSF Apple Laserwiiter v23.0 |
oo &Y Apple Personal Lasetwriter NTR ¥2010.129Apple “

APSPS wa | EH Laserwiter Personal NT v51.8
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At this point, you must lead Windowsby the noseto the printer’s driver software.
On the Add Printer Wizard screen,select your printer from thelist of printers. If
Windows doesn’t list your printer there, or if its manufacturer supplied the Win-
dows XP driver on a disk,click the Have Disk button, and then navigate to the CD,
floppy disk, or downloaded Internetinstallation file that contains the driver.

Either way, subsequent wizard screenswill invite you to type a short namefor your
printer, in order to make it available to other computers on the network (yes, Win-
dows can even share, for example, a USB inkjet, even though it’s not technically a
network printer), to print a test page, and so on. {If the test page doesn’t print out
correctly, Windows XPlaunchesits printer troubleshooter-—a specialized wizard that
offers you one troubleshooting suggestion after another until either you or Windows
quits in frustration.)

  
  

  
  

  

  
  
  
  

 
 
  

_ The Printer Icon

If your driver-installation efforts are ultimately successful, yowre rewarded by the
=. appearance ofan icon that represents your printer.

’ This icon appears in the Printers and Faxes window—an important window that
- you'll be reading about over and over again in this chapter. Exactly how you arrive
-there depends on how you've set up Windows XP:

+ If you've set up your Start menuto display a submenufor the Control Panel (page
“« 57), just choose Start>Control Panel—Printers and Faxes.

 

 4 Ifyou view your Control Panel in Classic view (page 249), choose Start>Control
- Panel, and then open the Printers and Faxes icon,

«Tf you view your Control Panel in Category view, choose Start->Control Panel,
click the Printers and Other Hardware link, and finally click the “View installed
printers or fax printers” link.
 

 The Printers and Faxes window should belisted in your Start menu, which saves
you some burrowingifyou usethis feature a lot. If it’s not there, for some reason, 
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ETE right-click the Start button. From the shortcut menu,choose Properties. On the
Start Menutab, click Customize, then click the Advancedtab. Scroll down in the
list of checkboxes, and finally turn on “Printers and Faxes.” Click OK twice.

yeBenita hr renirs

: Fle Edk Yiew Favorites Tools" >

 f2search 7i ig 832), @

Rae

Gy) {a} Add aprinter
3) See what's orinting
fa) Select paintingpreferences

2Y Pause printing
| gop Share this printer
bi) Renamethis printer

fe) KR Delete this printer

Figure 13-4:
Atfirst, the task panein
the Printers and Faxes
window offers only two
commands, But when

youclick a printer icon,
a longlist of useful
options appears, as
shown here. Manyof
them duplicate the op-
tions that appear when
you right-click @ printer
icon-something you'd
be wise to remember

the day yourright
mouse bution breaks.

EPSON Stylus

GEM IN THE ROUGH

Installing Fake Printers

If yourprinter hastwo papertrays, switching to the secondary
oneis something of a hassle. You must spend time making
the changesin the Print dialog box, as described laterin this
ParetocolpmmST tant tH)PansiCiatems USM OdaCLE Le Kex00CODaTn Geb
say, 300 dpi to 600 dpi when printing important graphic
documents is a multi-step procedure.

That's why you mayfindit useful to create severaldifferent
icons for the sameprinter. The beauty of this stuntis that
you can set updifferent settings for each ofthese icons. One
might store cannedsettings for 600 dpi printouts from the
PaverSaye)PAC MTO)amUL PacesAOLOLelBe
from the bottom one, and so on. When it comestime to
PATa OUResiam ceocaRcM UMERRSIaA
and easily.

To create another icon, just run the Add Printer Wizard a
second time, as described on the preceding pages. At the
Perineal andNaseeltCONpR iareuteh certAnoea recASoA LLNeEALE
a name that describes this printers alternate settings, like

 

HP6-600 dpi or Lexmark-Legal siz

Whentheinstallation process is complete, you'll see both
MittmeceeatieReCCAeeNURUTMeReuseKa)
window.Right-click the new “printer”icon, choose Printing
Preferences from the shortcut menu, and change the settings
to matchits role.

To specify which one you want as yourdefault printer—the
ofe you use most ofthe time-right-click the appropriate icon
and choose Set as Default Printer from the shortcut menu.

But thereafter, whenever you want to switch to the other
set of printer settings-when you need better graphics, a
Mice oreama EACMeola,TameteeSCoe OM Ceeee
ment—just select the appropriate printer from the Printer
Name drop-downlist in the Print dialog box (see Figure 13-5
at top), You've just saved yourself a half-dozen additional
mouseclicks and settings changes.
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Fip: \f you'te using your Start menuin Classic view (page 249), you get to your Printers and Faxes window
by clicking Start—Settings—Printers and Faxes.i

In any case, the Printers and Faxes window nowcontains an icon bearing the name
you gave it during the installation (Figure 13-4). This printer icon comes in handy
in several different situations,as the rest of this chapterclarifies,

Printing

Fortunately, the setup described so far in this chapter is a one-time-only task, Once
it’s over, printingis little more than a one-click operation.

 
 Figure 13-5:

Top: The options in
the Print dialog box
are different on each

printer model and
each application,
50 your Print dialog
box maylook slightly
different.
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 For example, here

are the Print dialog
boxes from Microsoft
Word and WordPad.

Most of the time, the
factory settings shown
here are what you
want (one copy, print
ailpages). Just click
OK or Print (or press
Enter} to close this
dialog box andsend
the documentfo the

printer.
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Printing from Applications
After you've created a document you want to see on paper, choose File>Print (or
press Ctrl+P). The Print dialog box appears,as shown in Figure 13-5.
This box, too, changes dependingonthe program you're using—thePrint dialog box
in Microsoft Word looks a lot more intimidating than the WordPad version—but
here are the basics:

* Select Printer. If your PC is connected to several printers, or if you've created
several differently configured icons for the sameprinter, choose the one you want
from this drop-down list or scrolling panel of printer icons.

+ Preferences/Properties. Clicking this button opensaversion ofthe printer’s Prop-
erties dialog box, as shown in Figure 13-6.
 

Figure 13-6:
When you choose Properties from the Print dialog
box, you can specify the papersize you're using,
whether you wantto print sideways on the page
(“Landscape’orientation), whatkind ofphoto pa-
peryou're using, and so on. Here, you're making
changes onlyfor a particularprintout; you're not
changing any settings for the printer itself. (The
specific features ofthis dialog box dependonthe
program you're using.)

€ EPSON Stylus Photo 785EPX Properties
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» Page range. These controls specify which pages ofthe documentyou wantto print.
If you wantto print only someofthe pages,click the Pages option and typein the
page numbers you want (with a hyphen,like 3-6 to print pages 3 through 6).
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mete

Hip:You can alsotype in individual page numbers with commas, like 2 4 9 to print only those three pages—or
even add hyphensto the mix, like this: #3, 5-6, 13-78 

Click Current Pageto print only the page that containsthe blinking insertion point,
Click Selection to print only the text you selected (highlighted) before opening the
Printdialog box.(If this option buttonis dimmed,it’s because you didn’t highlight
any text—or because you're using a program that doesn’t offer this feature.)

* Numberofcopies. To print out several copies of the same thing, use this box to
specify the exact amount. You'll get several copies of page 1, then several copies of
page 2, and so on-—umless you also turn on the Collate checkbox, which produces
complete sets of pages, in order,

* Print. The Print drop-down list in the lower-left section of the dialog box offers
three options: “All pages in range,” “Odd pages,” and “Even pages.”

Use the Odd and Even pages options when you haveto print on bothsides of the
paper, but yourprinter has no special feature for this purpose. You'll have to print
all the odd pages, turn the stack of printouts over, and run the pages through the
printer again to print even page sides.

+ Application-specific options. The particular program you're using may add a few
extra optionsofits own to this dialog box. Figure 13-7 shows a few examples from
Internet Explorer’s Print dialog box.

Whenyou've finished making changesto the printjob, click OK or Print,or press Enter.
Thanks to the miracle of backgroundprinting, you don’t have to wait for the document
to emerge from the printer before returning to work on your PC.In fact, you can even
exit the application while the printoutis still under way, generally speaking.
 

Fip: You'll probably never want to turn off background printing. But if you must for sometechnical reason,
you'll find the on/off switch in the Advanced Properties dialog box for yourprinter (see Figure 13-10 for
instructions on getting there). Select “Print directly to the printer” to turn off background printing,
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Printing from the Desktop
You don’t necessarily haveto print a documentwhile it’s openin frontofyou.You can,
if you wish,print it directly from the desktop—via an open disk or folder window,
or WindowsExplorer, for example—in any ofthree ways:

* Right-click the documenticon, and then choose Print from the shortcut menu.
Windows launches the program that created it—Wordor Excel,for example. The
Print dialog box appears, so that you can specify how many copies you want and
which pages you wantprinted. When youclick Print, your printer springs into
action, and then the program quits automatically (if it wasn’t already open).

« If you've openedthe Printers and Faxes window,you can drag a document’s icon
directly onto a printer icon.

- If you've opened theprinter’s own print queue window (Figure 13-8) by double-
clicking the Printers icon in your Printers and Faxes window, you can drag any
documenticon directly into the list of waiting printouts.Its name joins the others
on thelist.

Theselast two methods bypassthe Print dialog box, and therefore give you no wayto
specify which pages you want to print, nor how many copies. You just get one copy
of the entire document.
 

 

—i

ae Figure 13-7:et The Web page aboutto be printed

[ General|Options|uses frames(individual, indepen-—pbsresal a = dent, rectangular sections). The Print
7 Print frames eaeeae | dialog boxin Internet Explorer recog-

© Aslaid out on screen nizes frames, andlets you specify
exactly which frame or frames you
wantto print. If the page contains© Only the selected frame :

© All frames individually |] finks to other Web pages (andthese
fn emi | days, what Web page doesn’t?), you

| [Printall finked documents [7] Print table oflinks can print those Web pages, too, or
justprint a table ofthelinks (a list of
the URL addresses).     
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Printing from the Internet
Ifyou use Internet Explorer to browse the Web (see Chapter 11), the Print dialog box
offers a tab called Options, which containsa few special features for printing Web
pages. Figure 13-7 illustrates a few of them.

Controlling Printouts

Between the moment when youclick OKin the Print dialog box andthearrival of
the first page in the printer’s tray, there’s a delay. When printing a complex document
with lots of graphics, the delay can be considerable.

Fortunately, the waiting doesn’t necessarily make you less productive, since you can
return to work on your PC,or even quit the application and go watch TV. An invis-
ible program called the print spooler supervises this background printing process.
The spoolercollects the documentthat’s being sent to the printer, along with all the
codes the printer expects to receive, and then sends this information,little bylittle,
to the printer.

 

 

Note: The spooler program creates huge temporary printerfiles, so 2 hard drive that’s nearly full can wreak
havoc with backgroundprinting.  

To see the list of documents waiting to be printed—the ones that have been stored
by the spooler—open the Printers and Faxes window, and then double-click your
printer’s icon to open its window.
 

Fip: While the printeris printing, a printer icon appears in the notification area. As a shortcut to opening the
printer's window,just double-click that icon. 

 
   Figure 13-8:

The first decument, called
“Microsoft Word—Voice

phones.doc,” has begun

 
  

 
 
 
 
 

 
 

   
 

 

 
  
 
 

  
 
 
 

 

 
 
 

printing; the second ial Microsoft Wore - Voice phones.doc Chris Olson 4 BSL4KB 14:33:87 AM 3/21/2002 ‘
one, you've put on hold. 8 ki Microsoft Word - Goofus and Gallant.dac Paused ChrisOlson 3 S2.4KB 14:33:26 AM 3/21/2002 ;
Several other documents ba] Microsoft Werd - Working Cutline.doc Chris Olsen 2 43,.0KB 11:33:32 AM afzif20o2 @

ape . . Guest 18 S27 KR bth:57PM Sf2ifzooe
are waiting. By right-click- Bt) Full page print — Chris Olson: SOOKE 2:07:35 PM 3/24/2002  ing documents in this list
you can pause or cancel
any documentin the
queue—or alf of them at
once,

Chris Olson 1 T76KB=2:0%:48PM 3fz1/2062
 

Cancel
 f ial Full page print

Properties 
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ererus The printer’s windowlists the documents currently printing and waiting;thislist is
Cd called the print queue(or just the queue), as shown in Figure 13-8. (Documents in

thelist print in top-to-bottom order.)

You can manipulate documentsin a print queuein anyofthe following ways during
printing:

* Put one on hold. To pause a document(putit on hold), right-click its name and
choose Pause from the shortcut menu. When yourereadytolet the paused docu-
mentcontinueto print, right-click its listing and reselect Pause to turn off the
checkmark.

» Put them all on hold. To pause the printer, choose Printer—»Pause Printing from
the printer window menubar. You might do this when,for example, you need to
changethe paperin the printer’s tray. (Choose Printer—Pause Printing again when
you wantthe printingto pick up from whereit left off.)
  

Note:You can also pause theprinter by right-clickingits icon in the Printers and Faxes window and choosing
PausePrinting from the shortcut menu. (To undothis procedure, right-click the icon and choose Resume
Printing.)  

- Add anotherone. As notedearlier, you can drag any documenticondirectlyfrom
its disk orfolder windowintothe printer queue.Its namejoins thelist ofprintouts-
in-waiting.

* Cancel one. To cancela printout, click its name and then press the Delete key—or,
alternatively, right-click its name and choose Cancelfrom the shortcut menu. Either
way,if you click Yes in the confirmation box, the document disappears from the
queue; nowit'll never print out.

* Cancel all ofthem. To cancel the printingofall the documents in the queue, choose
Printer—>Cancel All Documents.(Alternatively, right-click the printer iconitself
in the Printers and Faxes window and choose Cancel All Documents from the
shortcut menu, as shown in Figure 13-4.)
  

Nofe: A page or so may still print after you've paused or canceleda printout. The explanation: Yourprinter
hasits own memory (the buffer), which stores theprintout asit's sent from your PC. If you pause or cancel
printing, you're only stopping the spoolerfrom sending more data to the printer. 

» Rearrange them.Ifyou're usedto, say, Windows Me,it may take you amoment—or
an afternoon—to figure out why you can’t simply drag documents up or down in
the list ofwaiting printouts to rearrangetheir printing order. In WindowsXP, the
procedureis slightly more involved.

Start by right-clicking the name of one of the printouts-in-waiting; from the
shortcut menu,choose Properties. On the General tab, dragthePriority slider left
or right (documents with higherpriorities printfirst).
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Fancy Printer Tricks

The masses ofWindowsusers generally slog throughlife, choosing File>Print, click-
ing OK,and then drummingtheirfingers as they waitfor the paperto slide out ofthe
printer. But your printer can do more than that—much more.Here are just a few of
the stunts that await the savvy PC fan.

Printing at 39,000 Feet
Printing any documentis really a two-step procedure. First, Windows converts the
documentinto a seething mass of printer codes in the form of a spool file on your
hard drive. Second,it feeds that mass of code to the printer.

Whenyou're not connected to your printer—for example, when yourresitting in seat
23B several miles over Detroit—you can separate these two tasks, You can do the
time-consuming partof the printing operation (creating the spoolfiles) right there
on the plane. Then,later, upon your happy reunion with the printer, you can simply
unleash the flood of stored spoolfiles, which will print very quickly,
To set this up, right-click the icon for your printer in the Printers and Faxes window
(Figure 13-4). From the shortcut menu, choose Pause Printing. That’s ail thereis to
it. Now you can merrily “print” your documents, 100 percentfree of error messages,
Windows quietly storesall the half-finished printouts asfiles on your hard drive,

Whentheprinteris reconnected to your machine,right-clickits icon once again——but
this time, choose Resume Printingfrom its shortcut menu,You'll find thatthe printer
springsto life almost immediately, spewing forth your stored printouts with impres-
sive speed.

Sharing a Printer
Ifyou have more than one PC connected to a network,as described in Chapter 18, they
all can use the sameprinter. In the old days, this convenience wasrestricted to expensive
Ethernet network printerslike laser printers. But in Windows XP, you can share even
the cheapestlittle inkjet that’s connected to the USB port of one computer.
To begin,sit down at the computer to which the printer is attached. In the Printers
and Faxes window,right-click the printer’s icon and, from the shortcut menu, choose
Sharing. Proceed as described in Figure 13-9,

Once you've shared the printer, other people on the network can addit to their own
Printers and Faxes windowslike this:

1, In the Printers and Faxes window,click “Add a printer”in the taskpane at theleft
side.

The Add a Printer Wizard appears, exactly as described earlier in this chapter.

2. Click Next. On the second screen,click the bottom option: “A network printer,
or a printer attached to another computer.” Click Next.
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Fancy Printer Tricks

second button and then type the printer’s UNC code(page 582). Andifyou're geeky
beyondbelief, you can use the third option, which lets you send your printouts
to a printer somewhereelse on the Internet. (The downside: Bringing the printouts
back to your desk can take days.)
 

2Apple LaseriWriter Setect 360 Properties

“SelShiaPoiAderess|DeveSetegs|
vA. You can share this printer with other users on your network. To
| enable sharing forthis printer, click Share this printer.

©} Do notsharethis printer

~~ © Share R printer eer eee
Share name? |EPSONSy| ee

 

Divers

| IFthis printer is shared with users running different versionsof
Windows, you may wantto install additional drivers, so that the
users do not haveto find the print driver when they connectto
the shared printer.

Additional Drivers...

 

fidd Printer Wizard

Browse far Printer
‘whenthelist of printers appears, select the one you want to use.

Printer; |\MNSPIRONSEPSON Stylus Photo 785EPXDeen a rn

ShavedpinesSeSeeerrreeeee AMReTaay
[af Microsoft Windows Network aa

@ MSHOME |
&} \DELL4TOOGFAAccuSet v523 AGFAAccuSet v523 |

*fm) DELL4106IE] INSP |
Panel j Sob biewaruurpadod |

Painter information
Comment:

Status: Ready Dacuments waiting:

Figure 13-9:
Top: Turn on “Sharethis printer,”
and then give the printer a name in
the Share name text box. (No spaces
or punctuation allowed-andkeepit
short) Click OK. The printer is now
available on your network.

Bottom: Other people, seated attheir
own computers, can now bring your
printer onto their own screens.(If the
other PCs aren't running Windows
XP, click the Additional Drivers button
on the Sharing tab and turn on the
checkboxes for the Windows versions

they are using.)

Nowyou're asked tolocate the printer that’s been shared.Ifyou're like most people,
you'll want to browseforit (chooseit fromalist). Ifyou're a geek, you can click the
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3. Select “Connect to this printer (or browse for a printer),” and then click Next.
Onthe screen that appears, click the nameof the printer you want, as shown in
Figure 13-9 at bottom.

Onthe final screens of the wizard, you'll be asked if you wantthis printer to be your
default (primary) printer. After answering,click the Finish button to close the wizard.
The shared printer now appears in your Printers and Faxes folder, even though it’s
not directly connected to your machine.

Printing to a File
Whenit comes to printing, mostof the time you probably think ofprinting onto pa-
per. In certain circumstances, however, you may not actually wanta printout. Instead,
you might want to create an electronic printer file on your hard drive, which can be
printed later. You might want to doso, for example, when:

* You're working on a documentat home, and you've got only a cheesy $49 inkjet
printer. By creating a printerfile, you can delay printing until tomorrow, in order
to use the office’s $4,000 color laser printer.

* You plan to send your finished work to a service bureau—thatis, a professional
typesetting shop. Sending a finished printer file avoids incompatibilities of ap-
plications, fonts, layout programs, and so on.

+ You want to give a document to someone whe doesn’t have the program you used
to create it, but has the same printer. If you email the printerfile to her, she'll get
to see your glorious design work slide out of her printer nonetheless.

Creating a printerfile
To create such a printerfile, choose File—Print,just as you would print any document.
The Print dialog box appears; now turn on the “Print to file” option. When you then
click OK or Print, the Print to File dialog box opens.It resembles the standard Save
As dialog box,in that you can choosea drive, a folder, and a filename.Thefile type
for a document printing to a file is a Printer File, which has thefile extension .prn.

Printing a printer file
‘To printa printerfile, choose Start—All Programs—AccessoriesCommand Prompt.
You've just started an MS-DOS command session; your cursor is blinking on the
commandline.

Now type this:

copy c:\foldername\filename.prn Ipti: /b

Here’s how this instruction breaks down:

* Copy is the name of the command youuseto print the file—noticethatit’s fol-
lowed by a space.
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Fancy Printer Tricks * C: is the letter of tthe drive that contains your printer file. Omit this part if the
printerfile is on the current drive (usually C:).

* \foldernameis the nameofthe folder into which yousaved theprinterfile.

« \filenameis the nameyou gavethefile.

* .prn is the filename extension (which Windows added tothe file automatically
when you saved theprinterfile).

+ Iptl: is the port to which theprinter is connected. Note the colon following the
name, and also note there’s a space before this part of the command.If the printer
is attached to LPT2,substitute that port name.

+ /b tells the Copy commandthatthefile is binary (containing formatting and other
codes), not simply text.
 

Note:A printerfile (@ .prn file) can only be printed on the same modelthat was selectedin the Print dialog
box whenthefile was generated.If you wantto create a printer file for that color printer at work, in other
words, be suretofirst install its driver on your computer.

 

Figure 13-10:
Right-click your printer’s icon in the Printers

Fentataneedaneatal AcvarcedMcaaiaiManaueacatincal and Faxes window. From the shortcut menu,

|GoveSheenaPots| eats choose Properties, then click the Advancedtab,© Always available shown here, Select ‘Available from,” and use

@ Available trom [00400 AM por V6 the time setting controls to specify when your
aes - underlings are allowedto use this printer from

Priority: fl across the network. Clicking OK renders the
printer inoperable during off-hours.

& NEC SuperScript €/70 Properties

Driver: iNEC SuperSctipt 870a

® Spoolprint documents so program finishes printing faster

© Startprinting afterlast page is spooled

@® Startprinting immediately

© Print directly to the printer

[TJ Hold mismatched documents
Print spooled documentsfirst

{] Keepprinted documents

 
ayEnable advanced—features
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Limiting Hours of Access
' Tf it’s just you, your Dell, and a color inkjet, then youre entitled to feel baffled by

» this feature, which lets you declare your printer off-limits during certain hours of
the day. But if youre the manager of some office whose expensive colorlaser printer
makes printouts that cost a dollar apiece, you may welcomea feature that prevents

~. employees from hanging aroundafter hoursin orderto print out 500 copiesoftheir
“head shots.

- ‘To specify such an access schedule for a certain printer, follow the instructions in
’ Figure 13-10.

“These settings let soy associate color profie(e} wlth your color -.
LAS] printer, Color profiles contralthe color oni your pwinter based onthe”tepe ct media being used and the ptinter configuration.

£2) Automatic: ‘alestons will automatically salect tha bast clotpresthe fot of associated calor profiles Fecommendadt

, OMareat Menuial) selet! the defeat colar patie fe al cutpat oes.. ic. this device irom the fist of associated color profiles sets

Default cater pri. ARGH Color Space Protte, “we
Cobar Fiefiles eunenilyaiowh tis fini:
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Add a Separator Page
Ifyour PC is on a network whose other members bombarda singlelaser printer with
printouts, you mightfind separator pages useful—theprinter version of fax cover
sheets. A separator pageis generated before each printout, identifying the document
and its owner.

This option,too,is accessible from the Advancedtab ofthe printer’s Properties dialog
box (Figure 13-10). Click the Separator Page button at the bottom ofthe dialog box.
In the Separator Page dialog box,click the Browse button to choose a .sep (separator
page)file.

You'll see that Windows XP comes with four of them:

+ Sysprint.sep is the one you probably want. Not only does this page include the
name,date, time, and so on,butit also automatically switches the laser printer to
PostScript mode—fit’s not already in that mode.

+ Pcl.sepis the sameidea, exceptthatit switches thelaser printer to PCL mode—com-
monly found on HPprinters—before printing. (PostScript and PCL are the two
most commonlanguages understood byoffice laser printers.)

* Pscript.sep switchestheprinter to PostScript mode, but doesn’t print out a separa-
tor page.

- Sysprtj.sep prints a separator page, switches the printer to PostScript mode, and
sets Japanese fonts,if they're available on your printer.

SavePrintouts for Later
Ordinarily, each printouttravels from your PC into a temporary holdingfile on the
hard drive (the spoolfile), gets fed from there to the printer, and then disappears
forever.

But sometimesit can be useful to keep the spoolfiles on handfor use later. Maybe
you print standard contractsall the time,orpricelists, or restaurant menus. It’s much
faster to reprint somethingdirectly from the spoolfile than to open the original docu-
ment and print it again from scratch.

The key to making Windows hangonto your already-printed documentsis in the
Advancedtab of the printer’s Properties dialog box (see Figure 13-10). Just turn on
“Keep printed documents.”

From nowon,every timeyou generate a printout, Windowsmaintainsa copyofit in
the printer’s window (the one that appears when you double-click the printer icon
in the Printers and Faxes window;see Figure 13-8). To reprint a document you've
already printed,right-click its namein this list and chooseRestart from the shortcut
menu.(Ifyou dothis frequently, consider dragging the printer icon to your desktop,
to the Start menu, or to the Quick Launchtoolbar so that it will be easier to open
the next time around.)
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Tip: Behind the scenes, Windows XP stores these saved printouts in the Local Disk (C)-Windows—>
System32—Spool—»Printers folder. Over time, all of your saved printouts can consume quite a bit of disk
space,It's worth openingupthat folder now andthen to clean out the anes you no longer need. 

Printer Troubleshooting
If youre having a problem printing,thefirst diagnosis you must makeis whetherthe
problem is related to software or hardware. A software problem meansthe driverfiles
have become damaged. A hardware problem meansthere’s something wrong with
the printer, the port, or the cable.

Test the printer by sendingit a generic text file from the commandline. (Printing a
regular printer disk file isn’t an effective test, because if there’s a problem with the
driver, the codesin thefile are likely to contain the problem.) To perform sucha test,
locate a text file, or create one in Notepad. Then chooseStart—>All Programs—<Ac-
cessories—Command Prompt;sendthefile to the printer by typing copy filename.
txtprn and then pressing Enter,(Of course, rememberto typethefile’s actual name
and three-letter extension instead offilename.txt.)

If the file prints, the printing problem is software-related. If it doesn’t work, the
problem is hardware-related.

For software problems,reinstall the printer driver by opening the Printers and Faxes
window,right-clicking the printer’s icon, and choosing Delete from the shortcut menu.
Thenreinstall the printer as described at the beginningofthis chapter.

if the problem seemsto be hardware-related,try these steps in sequence:

* Check the lights or the LED panel readouton theprinter. If you see anything
besides the normal “Ready”indicator, check the printer’s manual to diagnose the
problem.

* Turn the printer off and on to clear any memory problems.

* Check the printer's manual to learn howto printa test page.

+ Check the cable to make sure both endsare firmly and securely plugged into the
correct ports.

* Test the cable. Use anothercable, or take your cable to another computer/printer
combination.

Another way to check all of these conditionsis to use the built-in Windowstrouble-
shooter—a wizard specifically designed to help you solve ptinting problems, To run,
choose Start—Help and Support. In the Help center, click “Printing and faxing,”
and on the next screen, click “Fixing a printing problem.” Finally,click “Printing
Troubleshooter.”
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Pac If noneofthese stepsleadsto an accurate diagnosis, you mayhave a problem with the
port, which is more complicated. Or even worse, the problem mayoriginate from your
PC’s motherboard (main circuit board),or the printer’s. In that case, your computer
(or printer) needs professional attention.

Fonts

Some extremely sophisticated programming has gone into the typefaces that are
listed in the Fonts dialog boxes of your word processor and other programs. They
use OpenType and TrueType technology, meaningthat no matter whatpointsize you
select for these fonts, they look smooth and professional—both onthe screen and
whenyou print.

Managing Your Fonts
Windows XP comeswith several dozen great-looking OpenType and TrueTypefonts:
Arial, Book Antiqua, Times New Roman,and so on.But the worldis filled with ad-
ditional fonts. You may find them on the CD-ROMsthat come with PC magazines,
on Windowssoftware Websites, or in the catalogs of commercial typeface compa-
nies, Sometimesyou'll find new fonts on yoursystem after installing a new program,
courtesy ofits installer.

To review thefiles that represent your typefaces, open the Fonts icon in the Control
Panel.

Figure 13-11:

Fle Edk View Favortes Tools Help All ofyour fonts sit in
the Fonts folder (top);

—_——oe =e you'll frequently finda ‘tp iG | : an independentfonta a ieee fylal QldTac adit 4 file for each style ofa
nee font: bold, italic, bold

al Sal italic, and so on. YouEe can tell a TrueTypefont
; alEee === by its TTicon, or an

; =) Openlype fontby its O
9) — 7 rial Narrow Bold (OpenType) | icon Those rnited by

meeeanA maybe PostScriptBeakantiaua Bockarsous ontype Font,DigitallySigned,TrueType Outlines—
ypeface name: Arial Narrow _— fonts, which come with
ile size: 136 KB a phalanxoftheprinterrersion: Version 2.30 4
ypaface © The Monatype Corporation pic. Data @ The Monotype Corporation pic / Type i fontfiles that they

Golutions Inc. 1990-91 All Rights Reeerved, require; others may
emabcdefghijkimnoparstuywyz | [ookfine on the screen,

RBCDEFGHIJKLMNOPQRSTUVWXYZ | but maynotprint out
23456789.;,:(717) “| smoothly. Double-click

The quick brown fox jumpe overthe lazy dog. 1234567890 . a font’s icon to see .
a The quick brown fox jumpsover the lazy dog. 1234567891 What the font lookslike
.. The quick brown fox jumpsover the lazyd| ©"

ee »” 3
- iF PSseach ade

Aviad Harrow. 
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Tip: The Fonts iconin your Control Panel window is only a shortcut to the reatfolder, which is in your Local
Disk (C)->Windows— Fonts folder. 

When youopen the Fontsfolder, you'll see that for every fontthat appears in the Font
menusof your various programs, there’s an icon on your hard drive—orseveral. As
Figure 13-11 illustrates,it’s easy and enlighteningto explore this folder.

 
To remove a font from your system, simply dragits file icon out of this window,
right-click it and then choose Delete from the shortcut menu, or highlight it and
then choose FileDelete. To install a new font, dragits file icon into this window
(or choose FileInstall New Font, and then navigate to, andselect, the fontfiles you
wantto install),

Either way, you'll see the changes immediately reflected in your programs’ Font
dialog boxes.
 

Tip: Somefonts appear in your menus, but nof in your Fonts menu. Thesearethe fonts that Windows uses
in its menus, windows, and dialog boxes (Courier, MS SansSerif, Small Fonts, Symbol, and so on). If you
accidentally remove or move any of these fonts, Windows will substitute something that doesn't took righi,
and you'll wonderwhatthe heck is going on with the typography of your programs.That's why, unless you've
iumed on the “Show hiddenfifes" option (page 84), these files are invisible in the Fonts folder. 

Faxing

It’s a good thing you bought a book about Windows XP. If you hadn’t, you might
never have known about one of Windows XP’s most spectacular features:its ability
to turn your PC’s built-in fax modem into a fax machine. This feature works like a
charm,savesall kinds ofmoney on paper and fax cartridges, and may even spare you
the expense of buying a physical fax machine—butit isn’t installed in the standard
Windowsinstallation,

Here's the basic idea: When faxes comein,you can optto have them printed automati-
cally, or you can simply read them on the screen. And sending a fax is even easier ona
PC than ona real fax machine;youjustuse the regular File>Print command, exactly
as though you're makinga printout of the onscreen document.

If this sounds goodto you, grab your Windows XP CD-ROM andread on.

installing the Fax Software
‘To turn on the hidden fax feature, open your Printers and Faxes window (page 411),
and then click “Set up faxing” on the task pane on theleft side (Figure 13-12, left).
After a moment, you'll be asked to insert your Windows XP Professional CD.  
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aeS

(aS Tip: Whenthe big blue "Welcometa Microsoft Windows XP" screen appears, just click its close button.It’sobscuring the real action in the Configuring Components dialog box behind it.eeIESeetaeaee

Whentheinstallation is over, you'll find a new Fax icon in your Printers and Faxes
folder (Figure 13-12, right). You'll also find a few fax utilities in your Start—All Pro-
grams—Accessories—>Communications—Fax submenu,which you can read about
in the followingsections.  

Note: Upgrading your PC to Windows XP from an earlier version of Windows enables you to import your
old fax collection into the newersoftware. For instructions, choose Start—»All Programs—»Accessories—>
Communications—>Fax—>Fax Console. Choose Help—>Help Topics, and read the help topics under the first
headline (“Fax after upgrading to Windows XP").

Figure 13-12:
Top: In the Printers and Faxes

: File Edit view Favorites Tools Help | ae el window, click the “Set up faxing”
: diiteee as y i : link on the task paneatthe left
eee we Printersand Faxes a Sata Ste se side ofthe window. Insert the

area Windows XP Professional CD
aee é | hes F when the wizard asks you to

4 do so.

byUleastimesecs

|| [iB] Add a printer fa |
S| @> Setup faxing rh Bottom: The Fax icon is added to

the Printers and Faxes window,

ready to use.

(aleles
View Favorites Tools Help

Printers and Faxes

fa] Add 4 printer
i) Senda fax

j EPSON Stylus Photo 785EPa
ee See Also

(2) Troubleshant printing
@) Set help with printing

 
Getting Ready to Fax
Before you fax, choose Start—All Programs—Accessories>Communications—
Fax—>Fax Configuration Wizard (or choose Tools—Configure Fax from the Fax
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Console window). You'll be treated to the Fax Configuration Wizard, whose screens
walk you through thesesteps:

> Filling in your own name, email address, fax number, address, and other infor-
mation. This information will appear on your fax cover sheet, so that the iucky
recipient can contact youif the fax didn’t come through.(All ofthis information
is optional.)

+ Choosingthe fax device. This drop-down list is provided solely for the convenience
of those rich people who actually have more than one fax modem ontheir PCs.

There are two useful checkboxes here for everyone, however: Enable Send and
Enable Receive. Theability to send faxes is a no-brainer. But not everybody wants
their PC to receive faxes; see “Receiving a Fax” on page 432.

* Specifying your own fax number. Microsoft calls this the TSID (transmitting sub-
scriber identification) information—-the name and fax numberthatwill appear
on the screen of the receiving fax machine.

* Specifying your fax numberagain. You see this screen only if you indicated that
you wantyour PCto receive faxes. Once again, you're supposedto enter your name
and fax number, which will appear on the screen ofthe sendingfax machine during
transmission.

Figure 13-13:
if “Use dialing rules” is
turned off, thenjust type
the entire fax number.
complete with the area
code. the number } for
long distance, andso
on, into the second “Fax
number” box. Commas,
parentheses, and dashes
are irrelevant. But ifyou
turn on “Use dialing
tules,”you can choose
one of the canneddialing
setups—complete with
calling card information,
bizarre local area code
dialingprocedures, and
So on—that you set up as
described on page 318.

 
 
 
 
 
 

 
 
 
 
   Recipient Information

Ente: the name and number of the person you wantto send the fax to,
of click Address Book to select a fax recipient,
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* Choosinga fax destination. Here again, you see this screen only ifyou've declared
that you wantyour PC to receive faxes. Windowsgives you the option of having
incomingfaxes automatically printed,or stored as graphicsfiles in a certain folder.
(This option stores a second copy of each fax as a file; each fax is automatically
stored in the Inbox of Fax Console, which is describedlater.)

The final wizard screen displays a summary ofthe settings you've made. Click the
Finish button, and youreallset. You can changethesettings at any time,just by run-
ning the wizard again.

Sending a Fax
Theonebig limitation of PC-basedfaxingis that you can only transmit documents
thatare,in fact, on the computer. Thatpretty muchrules out faxing notesscribbled on
a legal pad,clippings from People magazine, and so on (unless you scan them first).
If youre still undaunted,the procedure for sending a fax is very easy. Just open up
whatever document you want to fax. Choose File—Print. In the Print dialog box,
click the Fax icon (or choose Fax from the Name drop-down list), and then click
OKorPrint.

Now the Send Fax Wizard appears. This is where you can typein the phone number
of the fax machine you're trying to reach (Figure 13-13)—orclick Address Book to
select the fax machine of somebody in your address book.
 

 
 
 

  
  

  

Figure 13-14:
Top left: The Fax Monitor
keeps you posted dur-
ing faxing. If you click
More>>, you can see a log

Wicemsesepcntea ofall your fax activities

ommeee

Diating 1 212 485-4499
The time elapsed is 0:02  See aes (top right). The more you(Cl Keep this dialog visible at all tines (1) Keep this disiog visible at all times usethe fax software, the

[Disconnect_}less you mayfeel that you
ThE needthis little windowin

BARZIPM «Ringing | your face~eventually, you
57:25PM—Ringing || mayprefer to continue
GA726PM Thecallwesanewered a working while Windows
aes tes “| doesits faxing in the
ROBSSPM Sending page} of 3 a background. In that case,

aes || click Hide.

Bottom:After you've faxed
successfully, you hear a

 
 

« tiny trumpetfanfare and
a see this message on your

notification area.
 
   
 

4) The fex was sent successfully |
Tha Fax to Lloyd Smithers was sent successfully, |

  Pai tant Pee eee
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Click Next. On the second wizard screen, you can opt to precedethe fax with a cover
page. This screen also gives you a place to typein a subjectline anda little note,if
you like, which will also appear on the cover page.

Whenyouclick Next again, Windows asks when you wantthe fax sent. Most of the
time, of course, you'll just accept the proposed choice—Now—andclick Next. But
if you work in an office where the fax line is busyall the time, you can schedule your
fax to go out at a specified time (“Specific time in the next 24 hours”) or “When
discount rates apply.”

POWER USERS’CLINIC

Cover Page Art Class

You don?t have to be content with the handful of fax cover _

pages that Microsoft provides. The Fax Console program
comes withits own little cover page design studio. To get
started, choose Tools-Personal Cover Pages.

At this point, you could
fa Cahetchrcm\classiacergC

call up a pure, empty,
AseAct SeNCoMi PreredcHm BIEL
iscechosanNeeyy
ie mclmeae Omors lat
orileneyRtalches(esuiareaanuel

pages, make changes to
ROEIRCUnearlCeara npte(ol
a different name.

B peneric.cov- Fax Cover sree art

Cee & Lee

IS OOKo G&® ij

To do so,click the Copy
butten now in front of

you, and then open one

of the four cover page
templates thatWindows

presents. Windows puts
itinto what's now a one-itemlist in the Personal Cover Pages
window.Click Renameto give ia new name,if you like, and
then dick Open to begin work on your redesign. (You'll see
a “Did you know?” Tips window; read thetips, if you like,
and thenclick OK.)

The design programworks like any standard drawing pro-
gram. In orderto type text that won't change—a confident:
ality notice, for example~click the Text tool on the toalbar

‘Recipient'sNamey

‘Pocpien'sFox#) - nagar tp etsges

{Sender'sNeme}
{Sender'e Fer: #}

(whichlooks like this: ab]), and then click on the page. Use
the commandsin the Insert menu to plop placeholder text
boxes onto the page~special rectangles that, on the actual
caemsUn Neco |clea (OntrerIgncen rch anaielano\cem iia

LeaVOLSLMRO EN SLeyCoMETC!
soon. You can transfer

your owncompany loge
onto the page just by

pasting it there (Edit—>
Paste}.

acid

Every item thai you
= eT EXelcetoy dace pss \edcrerc!

. Hous)oeesnscloners]
Beer SoneeasaaoyCcree

xgaitarclenyotmectomrasia

around independently
Uist aha tatemenane) Cole) bl
In fact, you can even

move a selected object
rameisea| coupesgsio)iscclan
evancrma)ayace Sa hc

commandsin the Layout menu.

Whenyou're finished with your masterpiece, choose File
Sera CNem MLSa ney AiCoM (elatedsecd sslentaTON ZO
My Documents—>Fax—Personal Cover pages folder (mean-
ing that only you have access to it-not other people who
share the PC and Jog in with their own accounts).
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ee. Nofe: “When discount rates apply”is a lame-duck holdoverfrom the days when longdistance companiescharged more during business hours. If this still matters to you, however, you must first tell Windows when
discount rates apply. To doso,right-click the Fax icon in your Printers and Faxes window, choose Properties.
Click the Devices tab,click the Properties button, and usethe “Discountrates start” and “Discountrates stop”
controls to specify your window of opportunity. 

Onthefinal wizard screen, you can simply click Finish to send the fax. However, you
may wantto click the Preview Fax buttonto giveit a final inspection before it goes
forth over the airwaves. When you're finished lookingit over, close the window and
thenclick Finish.

After a moment, a little window appearscalled Fax Monitor (Figure 13-14). It keeps
you posted on the progress of the fax.

Your recipientis in for a real treat. Faxes you send straight from your PC’s brain
emerge at the receiving fax machine looking twice as crisp and clean as faxes sent
from a stand-alone fax machine.Afterall, you never scanned them through a typical
fax machine’s crude scanner on your end.
 

Tip: |f you just have a few quick words to fax to somebody, you can use the Send Fax Wizard by
itself, without first opening a document on your PC. Choose Start—>All Programs—Accessories—
Communications—>Fax—>SendaFax. Fill in your recipient's phone number, click Next, and onthe Preparing
the Cover Page screen, type your memoto the recipient into the Note field. Windows will send only the
cover page, complete with your note. 

Receiving a Fax
Thereare several reasons whyyou maynotwant your PCto receive faxes. Maybe you
already have a stand-alonefax machinethatyou usefor receiving them. Maybe your
house only has one phoneline, whose number you don’t wantto give out to people
who might blast your ear with fax tones.

But receiving faxes on the PC has a numberof advantages, too. You don't pay a cent
for paper or ink cartridges, for example, and you have a handy, organized software
program thathelps you track every fax you've ever received.

Exactlywhathappens whenafax comesin is uptoyou. As notedearlier,you can make
this decision by running the Fax Configuration Wizard,or by openingthe dialog box
shown in Figure 13-15, to change its behavior at any time.

Hereare your options (see Figure 13-15):

* Manual. This option is an almost-perfect solution ifyour PC and your telephone
share the same phone line—thatis,ifyou use the line mostly for talking, but oc-
casionally receive a fax. From now on,every time the phonerings, a balloon in
your notification area announces: “Thelineis ringing. Click here to answer this
call as a fax call” (Figure 13-15, middle).
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Whenyou do so, the Fax monitor program appears and downloadsthefax. To see
it, open your Fax Console program, described on page 434.

* Answer automatically. Use this option if your PC has a phone lineall to itself.
In this case, incoming faxes produce a telephone-ringing sound, but there’s oth-
erwise no activity on your screen until the fax has been safely received (Figure
13-15, bottom). Once again, received faxes secrete themselves away in your Fax
Console program.

 
 Figure 13-15:

Top: This dialog box offers ail of the aptions for
receiving faxes. Getting here, however, is no
picnic. Right-click the Fax icon in your Printers
and Faxes windaw; choose Properties. Click
the Devices tab, and then click the Properties
button. in the resulting dialog box, dick the
Receive tab.

 
  

 
 

end! Receive ||Cleanup|  

 
 Specify settings fnr receiving faxes

 
  

 
 
 

Enable device to receive

 The Called Subscriber Identification (CSID) identifies you as a fax recipient,
andis transmitted by a device wher jlau receive an incoming fax. The
CSID usually consists of a fax number, and business name.  

 

Middle: Ifyou have only one phonefine that
yourtelephone shares, this note will appear ev-
ery time a call comesin. Most of the time, you'll
just answer the phone, and this message goes
away. If you click it though, your PC treats the
call as an incoming fax.

 
 

 
 
 

 
 
 

 
 
 
 

. ESIDs =
myAnswei ‘tide
= Manual.
a DAtemalcater woke |

 
 
 

 

Bottom: Once a fax is safely snuggled inte your
Fax Console program, this note lets you know,  
 

a whenafaiie rede

Pints 
 
 

  
 "Successfully Teceived faxes aieSereinthe laboarchive of Fax

: Console, Choose this option to:saveeri ‘additionaloc ofthe Fae iin Ey/ there folder specter: : 

 
 
 4 ae) The fine is ringing|

Click here toanswerthis call as a fax call

 iy New fax received From 205 359 6644
Cilck here to view the Fax,
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* Printit out. If you like, you can direct Windowsto print out each incomingfax,
using the printer you specify here. Of course, doingso defeats the environmental
and cost advantages of viewing yourfaxes on the screen,butat least you've got
something youcan hold in your hand.

* Save a copy in a folder. Ordinarily, incoming faxes are transferred to your Fax
Console program,as described next.Ifyou turn onthis option, however, you can
direct Windowsto place a duplicate copy of each one—storedas a graphics file—in
a folder ofyour choice. (Either way,it’s handy to knowthatthese are standard TIFF
graphicsfiles that you can email to somebody else—orevenedit.)

To look at the faxes you've received, you mustfirst launch the Fax Console program.
You can get to it by choosing Start—All Programs—>Accessories—>Communications>
Fax—>Fax Console,but yourfingers will be bloody stumpsbythetime you'refinished
mousing that deeply into the menu.Fortunately, once you’ve openedthe program for
the first time,it appearsin the lower-left quadrant ofyour Start menu. From there, you
can drag its name to a more convenientlocation,like the desktop, the Quick Launch
toolbar, or the more permanenttop Jeft portion of your Start menu.

 
 comera eyte] |

 
 
 
 

 
anteoem torah:
Siislicap 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
  

Figure 13-16:
Top: Until you delete them
in Fax Console (by selecting
them and then pressing the
Delete key), your sent and
received faxes stay here
forever. Someofthe toolbar

buttons are useful, including
Save (turns the fax into a
graphics file on your hard
drive) and Mail (sends the
fax via email).

Bottom: Double-click a

fax to openit into its own
window. Click the little

magnifying glass to enlarge
yourview, orjust make the
window bigger. Rotate it by
clicking one ofthe two ro-
tate buttons near the center
ofthe toolbar. You can even

addnotes using the three
tools on thefarrightside.

  
434 WINDOWSXP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 448
aa

  

 

 



HP Inc. - Exhibit 1007 - Page 449

In any case, Fax Console looks somethinglike an email program, as shown in Figure
13-16. Click the Inbox,for example,to see a list of faxes that have come in—and then
double-click one to open it up (Figure 13-16, bottom).

Tip: Another great way to capitalize on the power of your PC for fax purposesis to sign up for J2 of eFax
(wwj2.com and wwnefax.com). These services issue you your own personal fax number. And here's the
twist: Ail faxes sent to that numberarrive at your PC as email attachments.

Thebrilliance of the system, of course,is that you don’t need another phoneline forthis, and you can get
these faxes anywhere in the world, even on the road. And here's the best part: As of this writing, both of
these services are absolutely free. (You might consider reserving a separate email address just for your §2 or
eFax account, however, since wavesof junk mail are part of the “free” bargain.)  
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ware to open a TruValuestore. Fortunately, you don’t have to worry about
akingall of your PC’s preinstalled components work together. In theory,

at least, the PC makerdid that part for you. (Unless you built the machineyourself,
thatis; in that case, best of luck.)

S A PC containsseveral poundsof wires,slots, cards, and chips—enough hard-

 
“> Butadding new gear to your computeris another story. Hard drives, cameras, printers,
~ scanners, network adapter cards, video cards, keyboards, monitors, gamecontrollers,
: palmtop synchronization cradles, and other accessories can all makelife worth living

for the power user. When you introduce a new piece of equipment to the PC, you
-: must hookit up andinstall its driver, the software that lets a new gadgettalk to the
~~ rest of the PC.
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The Master Fortunately, Microsoft has taken much of the headache out of such installation
Compatibility List rituals byits invention of Plug andPlay. This chapter guides you through using this

feature—and counsels you on whatto do when Plug and Play doesn’t work.

Note: Chapter 13 contains additional hardware-installation details specific to printers. 

The Master Compatibility List
Remember that WindowsXPis based on Windows2000.It’s compatible with many
morepieces ofadd-on equipmentthan Windows 2000is, but nowhere near as broadly
compatible as previous “home”versions ofWindows(like Windows98 andWindows
Me). For anybody who’s switching to WindowsXP from an earlier version, discovering
that a piece of equipment becomesflaky or nonfunctional is par for the course.

If yowd like to eliminate every glitch and every shred of troubleshooting inconve-
nience, limit your add-on gear to products on Microsoft’s Hardware Compatibility
List (HCL), which appears at www.microsoft.com/hcl. Each item onthis list has been
tested andcertified to work flawlessly with Windows XP.

Now,this list doesn’t include everything that works with Windows XP. Hundreds of
products that workjust fine with Windows XP don’t appearonthelist (perhaps be-
cause they haven’t been submitted for Microsoft’s certification process). If you have
some cherished piece of gear that youre reluctantto replace and that doesn’t appear
on the compatibility list, try it out with Windows XPbefore giving up hope.
 

Tip: Many drivers that were certified for compatibility with Windows 2000 and Windows Me work with
Windows XP. Butif all you have for a particular gadget is Windows 98 (and earlier) driver software, you're
probably outof luck. 

Hardware Connections

Partof the installation process for a new piece ofhardware is ensuringthat it doesn’t
interfere with any of your other components(see the box on the facing page). Fortu-
nately, Microsoft’s Plug and Play technology is designed to avoid such conflicts.

Virtually every modern computer add-onis Plug and Play-compatible. (Look for a
“Designed for Windows” logo on the box.) Chances are good that you'll live a long
and happylife with Windows XP withoutever having to lose a Saturday to manually
configuring new gizmosyoubuyforit, as your forefathers did.

 
But gadgets that were designed before the invention of Plug and Play are another
story. These so-called legacy devices often require manual configuration. Fortunately,
Windows XP comeswith wizards to walk you throughthis process, makingitslightly
less difficult.

 

438 WINDOWS XP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 452
———SSS



HP Inc. - Exhibit 1007 - Page 453

 

 

 
 
 
 
 

 
 
 
 
 
 
 

 
 

  

installing Cards in Expansion Slots es
Wheninstalling a new piece of hardware, you either connectit toa port (a connec-
tor usually on the back of your computer) orinsert it into an expansion slot on the
motherboard (the computer’s main circuit board).

Modemsand adapter cards for video, sound, network cabling,disk drives, and tape
drives, for example, generally take the form ofcircuit boards,or cards, that youinstall
by inserting into an expansionslotinside your PC’s case. Theseslots are connected to
your PC’s bus, an electrical conduit that connectsall the components of the machine
to the brains of the outfit: the processor and memory.

The two common(and mutually incompatible) kindsofslots are called ISA and PCT.
TheISA bus (Industry Standard Architecture) has been aroundsince the dawn of the
PC in the early 1980s, PCI (Peripheral Component Interconnect} is comparatively
new, and offers much better speed. Most of the computers in use today have both
kindsofslots. There may be some museumpiecesfloating aroundthat have only ISA
slots inside; in fact some manufacturers have begun to eliminate ISAslots from their
new computers, relying completely on PCI. ,

There’s also a third type ofslot in manyoftoday’s computers,called AGP (Accelerated
Graphics Port). Thisslot is almost always occupied by a graphics card.
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Hardware Knowingthe characteristics of the different bus types isn’t especially important.
POUt) Whatis important is knowing whattypeofslots your computer has free, so you can

purchasethe correct type of expansion card. To dothis, you'll have to open your PC’s
case to see which type of slots are empty:

* Theplastic wall around anISAslotis usually black. it has metal pinsorteeth in the
center and a small crossbar about two-thirds of the way down theslot. On some
older computers, there maybe shorter-length ISA slots with no divider.

- The plastic wall arounda PCIslotis usually white or off-white, and shorter than
an ISA slot. A PCIslot has a metal center and a crossbar about three-quarters of
the way alongits length.

Installing a card usually involves removinga narrowplate (the slot cover) from the back
panel of your PC, which allows the card’s connector to peek throughto the outside
world. After unplugging the PC and touching something metal to discharge static,
unwrap the card andcarefully pushit intoits slot until it’s fully seated.
 

Nofe: Depending on the type of card, you may haveto insert one endfirst and then press the other end
down with considerable forceto getit into the slot. A friendly suggestion, however: Don't press so hard that
youflex and crack the motherboard. 

External Attachments

Whenyoubuya printer, scanner, digital camera, or somethingelse that plugs into
connectors on the PC,you're actually buyinga peripheral, in the lingo of PC maga-
zines and clubs everywhere. Overthe years, various engineering organizations have
devised an almostsilly numberofdifferent connectorsfor these peripherals (Figure
14-1 showsa typical assortment). The back panel—orfront, or even side panel—of
your PC mayincludeanyof these connectorvarieties:

+ FireWireport. You probably don’t havethe special, rectangle-with-one-V-shaped-
end jack unless you special-ordered it with your PC,butit’s a winner neverthe-
less. (Various companies mayalso call it IEEE-1394 or i.Link.) It’s an extremely
high-speed connectorthat’s hot-pluggable, meaning that you don’t have to turn
the computer off when connecting or disconnectingit. At the moment, what most
people plug into a FireWire port are digital camcorders (for video editing), and
external hard drives.

USB (Universal Serial Bus) port. This compact, thin, rectangular connector ac-
commodates a huge variety of USB gadgets: scanners, mice, keyboards, printers,
palmtop cradles, digital cameras, Zip drives, and so on. Most modern PCs come
with two or more USBports,often on both the front and back panels.If that’s
not enoughto handle all your USB devices, you canalso attach a USB hub (with,
for example, four or eight additional USB ports), in order to attach multiple USB
devices simultaneously. USB is the most moderntypeof connectorandtherefore
gaininginpopularity; all USB devices are Plug and Play—compatible and hot-plug-
gable, and feature a faster connection than their older counterparts.
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Note? Some USB gadgets (and some PCs) offer faster, enhanced connectors called USB 2. Theoriginal
version of Windows XP couldn't recognize them, but thanksto software patches, it does now. (Automatic
Updates, described on page 331, should download the necessary software automatically, or you can just
install it using theinstallation disk that comes with your USB 2.0 appliances.)

 
  
  

 
 

 

 
 Figure 14-1;

The backpanelof the

iypical PC. Not every PS/2 port (keyboard, mouse)
computer has everykind
ofjack, and the standard—_SB ports (cameras, printers,
assortmentis evolving over scanners, palmtop cradles,
time. But these days, you disk drives, etc.)
can generally count of a
basic collection like the one
shown here.

 

   
  
  
   Parallel port (printer)

 
  

 
 

  
 

 
 

  Serial (COM) port (older
mouse, modem,
camera, scanner, etc.}

Video VGA) port (monitor}

Ethernet port (office network)

Microphone, speakers

Miedern and phoneline

-’* Bluetooth adapters. Bluetooth isa fascinating newwireless technology. Don’t think
__.ofitasa networking scheme—it’s intendedfor theeliminationofcable clutter. Once

“you've equipped yourprinter, PC, and Palm organizer with Bluetooth adapters,
. your computer can print to the printer, or HotSync with your Palm, from up to
30 feet away.
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Pe Theoriginal version ofWindows XP Pro didn’t workwith Bluetooth. But Microsoft
btTee) added Bluetooth smarts to XP first in late 2002 (in the form of a software patch)

and again in 2004 (as part of Service Pack 2).

° Wireless (Infrared) port. You'll find this kind of port most often on laptops.It
lets your computertalk to similarly equipped gadgets (such as infrared-equipped
printers, PalmPilots, and so on) through theair, via infrared or RF communica-
tion, An infrared portis a small, translucentplastic lens; RF ports looklikelittle
antennas.

» PC card slot. This kind ofslot, too, is primarily found on laptops. It accommo-
dates PC cards, which looklike metal Visa cards. Each card addsa useful feature
to your laptop: an Ethernet port, a modem,a wireless networking antenna, and
so on. Expect this technology to be aroundfor a while since there’s currently no
otheralternative.
  

Tip: Because they‘re so new,al! USB, FireWire, and PC card equipments Plug and Play-compatible, meaning
that you caninstall the necessary driver software simply by connecting a gadget to the PC. 

* Video (VGA)port. A narrow female portwith fifteen holes along three rows. Your
monitor plugs in here.

* GamePort. This connector, which is usually part of a sound card,is a wide female
port that accepts such gamingdevicesas joysticks and steering wheels.

* SCSI port. Here’s another onethat’s fairly rare on everyday Windows worksta-
tion PCs (as opposed to industrial-strength server machines). You generally have
an SCSI port onlyif it was installed as part of an add-on card. Unlike FireWire,
though,its popularity is fading in the home market.

SCSIis a high-speedinternal andexternal bus that’s more commononlarge servers
than workstations. This kind of (there are various sizes and shapes) connectoris
designed to accommodate scanners, hard drives, CD-ROMs, magnetic tape drives,
and so on. SCSI can be somethingofa diva technology,since setting up a chain of
devices, connecting and disconnecting them, and configuring them correctly can
be a fussy and temperamental business.

PS/2. A small, round,female connector (known in PC circles as a 6-pin mini-DIN
connector). Not all PCs have PS/2 ports; but if yours does, it probably has two,
one for the keyboard and the other for the mouse. As USB grows in popularity,
these ports will vanish from new computersin the future.

Parallel (DB-25) port. A wide female port with two rows ofholes. It’s usually
connected to a printer (which is why it’s sometimescalled the printer port). You
can plug some other kinds of equipmentin here,including Zip or Jaz drives,tape
drives, and other drives. Here again, parallel ports are dying out, having been
replaced by the more popular (and muchfaster) USBports.
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+ Serial port. A male connector with nine or 25 pins. It connects to a serial device,
such as a mouse, modem, camera, scanner, or serial printer; it can also connect
your PC to another one, port-to-port.

Most computers have twoserial ports, which are also called COM ports—but not
for long.Serial ports,too,will probably also go the way of dinosaurs as USB ports
take over the earth.

* Keyboard port. This round, 5-pin (DIN) female connector, similar to a PS/2
connectorbutlarger, is becoming one ofthe rarest ofall. It was designed to fit
keyboards that don’t use a PS/2 connection, and is yet another obsolete port in
the USB era.

Connecting New Gadgets
In books, magazines, and online chatter about Windows,you'll frequently hear people
talk aboutinstalling a new component. In manycases, they aren't talking about physi-
cally hookingit up to the PC—they’re talking aboutinstalling its driver software.

The truth is that you generally have to install both the hardware and the software.
Theritual goes like this:

1. Run the installer on the setup disk, if one came with the new equipment.

That's right: Install the software first. Doing so copies the driverfile to your hard
drive, where Windowswill be able to findit in the later steps of the installation.

2. Physically connect the gadget,

Thatis, connectit to the inside or outside of the computer, according to the in-
structions that accompanied the equipment.

The beauty of USB gadgets, FireWire gadgets, and PC cardsis that they identify
themselves to WindowsXP theinstant they’re plugged in. For this kind of gizmo,
there is no step 3.

Other kindsof gear aren’t so lucky. In general, you mustturn off your PC before
connecting or disconnecting components from other kinds of connectors. When

». you turn it on again (after hooking up the new gadget), Windows XP examines
“every connector, port, and slot on your machine, checking to see whether or not
_<it’s now occupied by a piece of equipmentit hasn’t seen before.

’: 3. Install the driver software into Windows.

If your new gear is Plug and Play—compatible (if its box bears a “Designed for
.. Windows”logo, for example), then skip this step. The simple act of connecting
/ the equipment inspires Windowsto find the driver—either the one you copied

to the drive in step 1, or one from its own databaseof drivers. (For non—Plug and
Play gadgets, this step can require a considerable amountofeffort, as described
later in this chapter.)
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Note: Windows XP comeswith the driversoftware for thousands ofdifferent pieces of gear. It keeps many
brace of these drivers, in compactedform, right there on your hard drive (ina file called Driver.cab). The Windows

XP CD comes with hundreds of others.

All of these included drivers have beentested to work perfectly with WindowsXP. Furthermore, Microsoft
addsto this collection as new products appear, and sends you these new drivers via the Automatic Update
feature described on page 331.

In either case, your gear is now completely installed—both its hardware andits soft-
ware—and ready to use.

When Plug and Play Doesn't Work
If, when you connect a new component, Windows XP doesn’t display a messagelike
the oneat top in Figure 14-2,it probably can’t “see” your new device.

* If you'veinstalled an internal card, makesurethatit’s seated in theslot firmly (after
shutting down your computer, of course).

- If you attached somethingexternal, make sure thatit has power and is correctly
connected to the PC.

In eithercase, before panicking,try restarting the PC. If youstill have no luck,try the
Add New Hardware Wizard described in the next section. (Andif even that doesn’t
work,call the manufacturer.)

If your new gadget didn’t come with a disk (or maybejust a disk with drivers, but
no installer), then hooking it up may produce the “Found New Hardware”balloon
shownat top in Figure 14-2. Click the balloon to make the New Hardware Wizard
appear (Figure 14-2, bottom). In thatcase, proceedlike this:

* If you have the drivers on a disk from the manufacturer. Select thefirst option,
“Install the software automatically,”insert the driver disk if it’s not already in the
machine, and then click Next. Windowseither finds the compatible driver and
installs it automatically, or offers you a choiceofseveral.

FREQUENTLY ASKED QUESTION

Teeswe CeCereBe)
BeeyacesadaeRhgAoencClA LURAY Plug and Play detection, but you can up-
Oe LANGenaOe UnLeCeecL date the drivers after Windows XP has installed your new

newer, better, drivers from the manufacture’. How act SCACaeKom (ROR UaeRe Device Manager, desctibed
FieUHeNtAeeeOOO RCOLCoY
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Yip: If you have drivers on a floppy, and this technique fails to find them,try the next option. The “install from
a list or specific location”option often works when the“Install the software automatically” choice doesn't. 

* If you've downloadedthe driver from the Web.Select the second option,“Install
fromalist or specific location,” and click Next. You should now turn on both of
the checkboxes shown in Figure 14-2, and then click the Browse button to navigate
to, and select, the driver you downloaded.
 

Figure 14-2:
Top.You're halfway home.
Windows XP hasat least

acknowledged that you've
pluggedsomething in, Click =
the balloontoproceed with Found New Hardware
the software installation Palm Handheld
(ifyou didn’t install the
software first. as you should
fave).

Bottom: The Found New
Hardware Wizard. You'll

rarely use the bottom option,
“Dorrt search. | will choose
the driverto install.”it’s

primarily used to over-
tide Windows XP's own,
preinstalled driver in favor of
another one-for example,
one that came from the

original manufacturer that
you've been told offers more
features than the official
Microsoft driver.

Weicome to the Found New
Hardware Wizard
 
 

 
This wizard helps pou install saftware for
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baalam Nofe: If you run the Found Hardware Wizard but don’t, in fact, have drivers of anykind to feedit, Windowsu offers you the opportunity to register a kind of electronic complaint-something like an emailed record of
your unsuccessfuldriver search.

Asthefirst screen of the Get Help with Your Hardware Device Wizard makes clear, receiving help entails sending
details of your PC and its configuration to Microsoft. If enough people agree to send in reports in this way,
Microsoft will put pressure on thenegligent manufacturer,in hopes of one day producing an XP-compatible
driverthat will be sent back to your PC automatically (via the Automatic Updatesfeature).

Using the Add Hardware Wizard
The Add Hardware Wizardfulfills someofthe functionsof the Found New Hardware
Wizard, but comes in handy in different circumstances. You can use it whenever
Windowsfails to notice that you've blessed it with new components, for example, or
to update the original driver when a better one becomesavailable.
Begin by connecting the new gear (turningoff the computerfirst, if necessary). Turn
the machineon again and then open the Add Hardware Wizard program in the Control
Panel (Chapter 8). Click Next to move past the Welcomescreen.

The search for Plug and Play
Thefirst thing the wizard wantsto dois search for a Plug and Play device. You already
knowthat it won’t find one—afterall, if the hardware you're trying to install were
Plug and Play—compatible, Windows XP would have foundit already.
Unfortunately, you can’t stop the Hardware Wizard juggernaut. You have no choice
butto click Next and proceed asoutlined in the next section.

Add Hardware Wizardsearches for non-Plug and Play devices
If the search for Plug andPlay hardwarefails, a new wizard window opens and asks
you if the new equipmentis already connectedto the PC. Ifyou answerno, the wizard
closes—its subtle way oftelling you that you were supposed to have connected the
gadget before even opening the wizard.

FREQUENTLY ASKED QUESTION

ahan ease

Which is better: the drivers that come with Windows XP. with Windows. However, you should still usethe drivers that
PraenaernTomeauralvereelm icerasia ian teresen(eca10pega MummRTcALEOAN Peed manufacturer wheneverpossible,
eestiaed BeiselWA ACeIeeOM Cuneta LEC IRCNSecsmNaL

They’te likely to be newerversions than the ones that came
; ‘ TDcam ROE inS, aAn many cases,they're the same thing. The rivers induded ereens
with Windows XP usually did comefrom the hardware's
manufacturer, which ge ze them to Microsoft for Latesal
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If you select “Yes, I have already connected the hardware.”on the other hand, youre Waotrent
taken toa list of every componentthat’s already in your computer (Figure 14-3). Scroll DTaT
to the very bottom ofthelist and select “Add a new hardware device” Click Next.
 

Figure 14-3:
Why does the wizard display
a list ofcomponents you've
already successfully installed?
Because you can also use
the AddHardware Wizard to Se Sa ain
troubleshoot PC components
you'vealready installed, using
this very screen, Furthermore,
Windows mayhave detected,
but notprecisely identified,
something you'veinstalled.
For example, ifyoujust
installed a network adapter,
andthelist contains a generic
NetworkAdapter entry with a
question mark and a yellow
! circle, you can select it to
install the correct driver.

AddHardware Wizard 

 
 

 

 
   

From the list below. select an installed hardware device, then click Nest ta check
properties or troubleshoot a problem you might be having,  

 To add hardware not shownin thelist, click "Add a new hardware device." 
 
  

  Installed hardware: — f f
i a TexasInstruments PCI-1220 CardBus Controller
| 9 ECPPrinter Port (LPT1)
| on Communications Port (COM1) |

 
   
 | E> Intel) 82371AB/EB PCI to USB Universal Host Controller

| ©PUSB Root Hub   
    
 

pepe M Hata aiepen 
   

 
 

 
  

Nowthe wizard asks you to makeyet another decision:

* Search for and install the hardware automatically. Ifyou choosethis option and
click Next, Windows makesyet another attempt to detect the new equipment and
install its driver. If a happylittle “Found New Hardware”balloon appears in your
notification area,all is well; the wizard’s work is done.

If the search succeeds, you've saved a couple of keystrokes; if it fails, you move on
to the second option anyway.

* Install the hardwarethat I manually select from a list.If you choose this option
and click Next (orif the previous optionfails), the wizard displaysa list of device
types (top left in Figure 14-4). From thatlist, find andselect the type ofhardware
you wantto install—“Imaging devices”for a digital camera or a scanner,for ex-
ample, “PCMCIA adapters”for a PC card, and so on. (Click Show All Devices if
you can’t figure out which category to choose.)

Thenclick Next. Now Windows XP opensa two-paned windowlike the one shown
at bottom in Figure 14-4,

To complete theinstallation,click Next to forge on through the wizardpages. You
may be askedto select a portor configure other settings. When youclick the Finish
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When Plug and
bararemaye§

button on thelast screen, Windowstransfersthe drivers to your hard drive. (Along
the way, you maybe instructedto insert the Windows XP Professional installation
CD.) As a final step, you maybe askedto restart the PC.
  

 
 
  
 

PUT ebUiccimate)

From the Hst below, sefect the type of hardware you are installing

 
 
  

 
  

IFyou do not'see the hardware category you want, click Show All Devices.

 
 

B bacHete > =~ ~ oe
GANT Apm/Legacy Support wl

ME Add Hardware Wizard
 

Select the device driver you want to inctall for this hardware.

 
 

  

 

Select the manufacturer and model of your hardware device and then click Next. ftyou
have a disk that contains the diver you want to install, click Have Disk.

franTarm chineseconn SUesasemcirl aos
©Manufacturer | Mode|2
| 5g Databook ISA PEMCIA Contolier if
{ Inte Databook Plug and Play PCMLIA Contioller based on DBGSCM SwapBox

Vadem

| VLBI

 

   

  
  

Qatabook Plug and Play PCMCLA Contioller based on DBE
ei. Se 2 :eeeea atereason LeeRen

aS This dhiver is dighsty signed,

  

Driver Signing

|
Figure 14-4:
Top left: Specify which
kind ofcomponent
you're adding.

Bottom:Scroll down

theleft paneto find the
nameofyour hardware
manufacturer(in this
case, a PC cardis the
hardware). The right
pane of the window
changesto display
aff the models the
manufacturer offers,
or at least the models
that Windows XP knows
about. If you can't find
your model number,
check the hardware’s
documentation to see

ifselecting one ofthe
listed models would

workjust as well.

 
Every now and then, when youtryto install the software for one new gadget or an-
other, you'll see the warning box shown in Figure 14-5. It’s telling you that Microsoft
has nottested this driver for Windows XP compatibility and programmingsolidity.
(Technically speaking, Microsoft has notputits digital signature on that driver;it’s
an unsigned driver. )

If the message shown in Figure14-5 appears before you, yourfirst instinct should be
to contact the manufacturerorits Website to find outif a newer XP-certified driver
is now available.

Ifnot—for example,if the manufacturerhas goneto that great dot-com in the sky—
you mayas well try to install the driver anyway. If it seemsto make your system slower
or less stable, you can always uninstall it, or rewind yourentire operating system to its
condition before you installed the questionable driver. (You would use System Restore
for that purpose, which is described on page 475. Windows XP automatically takes a
snapshotofyour workingsystem just before youinstall any unsigned driver.)
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Tip:\f you'd rather not contend with the “unsigned driver” message every time youinstall something, you
canshut it up forever. Conversely, you can close up Windows like a vault, so that it will never accept unsigned
drivers, for maximum, conservative safety. (Instead, you'll see a message declaring thattheinstallation has
been “biocked.”} Instructionsfor setting up both scenarios are on page 296.

Figure 14-5:
The moststable and smoothly operating PC is
one whose components use nothing butdigitally
signed drivers. On the other hand, just because
a driver isn’t signed doesn’t meanit’s no good:
it maybe thatthe manufacturer simply didn’t
ponyupthe testing fee requiredby Microsoft's
Windows Hardware Quality Labs. 

The Device Manager
The Device Manageris an extremely powerful tool that lets you troubleshoot and
update drivers for gear you've alreadyinstalled.It’s a masterlist of every component
that constitutes your PC: floppy drive, CD-ROM drive, keyboard, modem, and so on
(Figure 14-6). It’s also a status screen that lets you know which drivers are working
properly, and which ones need someattention.

You can open the Device Managerin any of three ways:

- * Right-click My Computer(inyour Start menuor on the desktop); choose Properties
_ from the shortcut menu.In the Systems Properties dialog box, click the Hardware

tab, and then click the Device Managerbutton.

"+ Choose Start>Control Panel; open the System icon. Once again,click the Hardware
tab to find the Device Manager button.

* Choose Start—Run.In the Run dialog box, type devingmt.msc and press Enter.

In each of these cases, you now arrive at the screen shown in Figure 14-6.

Red X’s and Yellow !'s: Resolving Conflicts
A-yellow exclamation point next to the name indicates a problem with the device’s
driver. It could mean that either you or WindowsXP installed the wrong driver, or
that the deviceis fighting for resources being used by another component.It could
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The Device also meanthata driver can’t find the equipmentit’s supposed to control. That’s what
birty happensto your Zip-drive driver, for example,ifyou've detached the Zip drive.

, A red X next to a component's name, meanwhile, indicates thatit just isn’t working,
or thatyou've deliberately disabledit, as described in amoment. At other times, the X
is the resultofa serious incompatibilitybetween the component and your computer,
or the componentand WindowsXP.In thatcase, a call to the manufacturer’s help
line is almostcertainly in your future.
  

Tip: Tofind out which company actually created a certain driver, double-click the component's namein the
Device Manager. In the resulting Properties dialog box,click the Driver tab, whereyou'll see the nameof the
company,the date the driver was created, the versionof the driver, and so on.  

   

SUVS Me EN eS§=The Device Managerlists types of equip-
ment: to see the actual model(s) in each
category, you must expand each sublist by
clicking the + symbol. A devicethat's having

| problems is easy to spot, thanks to the red

es Eertnnies “| X's and yellow exclamation points.gi Computer i
) @e Disk drives
a Display adapters
Sg DYDJCD-ROM drives

(=) &} Floppydisk controllers
i ~ 3% EEREEc Reteeaecaelives
Be IDE ATA/ATAPIcontrollers
|G) Intel(r) 82371AB/EB PCI Bus Master IDE Controller

- ZY Primary IDE Channel
: “Gy Secondary IDE Channel
Sa» Keyboards

aMice and other pointing devices
bea Modems
i Monitors

-/ Network adapters
a4 Other devices
A. USB Serial Port

| Bi@ PCMCIA adapters
|) 2Y Ports (COM &LPT)aaeeseerrrecenereetnies—

 

     
 

Duplicate devices
Ifthe Device Managerdisplays iconsfor duplicate devices (for example, two modems),
removeboth of them. (Right-click each and then choose Uninstall from the shortcut
menu.) Ifyou remove only one, Windows XP will find it again the next time the PC
starts up, and you'll have duplicate devices again.

If Windows XP asks if you wantto restart your computer after you remove thefirst
icon, click No, and then delete the second one. Windows XP won't ask again after you
remove the second incarnation; you haveto restart your computer manually.
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Whenthe PCstarts up again, Windowsfinds the hardware device andinstalls it (only ri riie
once this time). Open the Device Manager and makesure thatthere’s only one of Manager
everything.If not, contact the manufacturer’s help line.

Resolving resource conflicts
If the “red X” problem isn’t caused by a duplicate component, double-click the
component's name, and thenclick the Resources tab. Here you'll find an explanation
of the problem,which is often a conflict in resources (see Figure 14-7).

Click the nameof the resource that’s having the conflict, and thenclick the Change
Setting button.(If the Change Setting buttonis grayed out, turn off the “Use auto-
matic settings” checkbox.)

Click the up/down control arrows next to the resource value, keeping an eye on the
message in the Conflict Information box. Whenyouselect a value that has no conflict
(as indicated by the Conflict Information box), move on to the next resource that
indicates a conflict, and then click OK.

Figure 14-7:
The Resources tab should have alf the

information you need to resolve a problem.
Any resource with a conflict is marked with a

redX “not working”icon. Selecting a resource ee Edlsent\winladerwith @ problem displays information about the |
conilict.

Lucent Win MovemProperties:

» General; Modem ' Diagnostics | Advanced!’ Driver | Resources |

Resource settings:

iF Resource type Setting ; c
(WHO Range 02FS- O2FF
if 03
‘W/O Range 0130-0137

 

Use automatic settinas

Conflicting devicelist:
, Interrupt Request 11 used by:
| Creative ENSONIO AudioPC!
| Interrupt Request 11 used by:
| IPO Holder for PCI Steering 
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Nofe: When WindowsXPinstalls a Plug andPlay device,it can modify the settings for both the device and
ais its driver in orderto find a combination that works. Windows might even have to reconfigure other devices

in the computer, so that the new device canfunction properly.

But when you're working with a non-Plug and Play device, Device Manager can change the hardware
settings only for the driver, not the device itself. In some cases, the driver may not be able to workwith
the device's settings. In these cases, you have to modify the settings of the hardware deviceitself using a
program supplied by its manufacturer—orforreally old gadgets, you'll haveto flip jumpers or DIP switches
right on the device itself.

Orjust sell the whole thing and move to the Amish country.  

Turning Components Off
If you click to select the name of a component, the iconsat the top of the Device
Managerwindowspringto life. The one onthefar rightis the Disable button (Figure
14-6), which makes your PC treat the componentin question as thoughit's not even
there. (You'll be asked to confirm your decision.)

This feature is mostly used to create hardware profiles (see page 453), but you can
also use this function to test device conflicts. For example, if a red X indicates that
there’s a resource conflict, you can disable oneof the two gadgets, which may clear
up a problem with its competitor.

Whenyoudisable a component, a red X appears next to the component's listing in
the Device Manager. To undoyour action,click the device’s name andclick the Enable
button in the toolbar (formerly the Disable button).

Updating Drivers with the Device Manager
Ifyou get your handson a new, more powerful (or morereliable) driver for a device,
you can use the Device Managertoinstall it. Newer isn’t always better, however; in
the world ofWindows, the rule “Ifit ain’t broke, don’t fix it” contains a grain of truth
the size of Texas.

In the Device Manager,click the + button for the appropriate type of equipment, and
then double-click the component’s nameto openits Properties box. On the Driver tab
(see Figure 14-8), click the Update Driver button. The Update Device Driver Wizard
walks you through the process.

Alongthe way, the wizard will offer to search for a better driver, or display a list of
drivers in a certain folder so you can make your own selection. Ignorethe “Install the
software automatically (Recommended)”option; you know wherethe driveris, and
it’s faster to find it yourself. Select “Install fromalist or specific location (Advanced),”
and then click Next.

If the newerdriveris on a disk, turn on the top checkbox (“Search removable media”),
and then click Next. If you've downloadedit, turn on “Includethis location in the
search,” andthenclick the Browse button to find and selectit. In either case, you may
haveto restart the PC to put the newly installed driver into service.
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Driver Rollback

Suppose that you, the increasingly proficient PC user, have indeed downloaded a new
driver for some component—yourscanner, say-—and successfully installed it using

 
the instructions in the previous paragraphs.Life is sweet—~until you discover that
your scanner won't scan except in black and white.

In this situation, youd probably give quitea bit for the chanceto returnto the previous
driver, which, though older, seemed to work better. That’s the beauty of the Driver
Rollback button. To find it, open the Device Manager (page 449), double-click the
component in question,click the Driver tab in the resulting Properties dialog box,
and then click the Roll Back Driver button (shown in Figure 14-8).

WindowsXP,forgiving as always, instantly undoestheinstallation of the newerdriver,
and reinstates the previous driver.

Figure 14-8:
When you double-click a componentlisted in
your Device Manager and then click the Driver
tab, you find four buttons and a fot ofinforma-
tion. The Driver Provider information, for
example,lets you know who is responsible for
your current driver~Microsoit or the maker of
the component. Click the Driver Details button
to find out where on your hard drive the actual
driverfile is, the Update Driver button to install
a newer version, the Rolf Back Driver button
to reinstate the earlier version, or the Uninstalf
button to remove the driver from your system
entirely—a drastic decision.

Hardware Profiles

E Driver Details... J

esties|Advanced! Driver | Resources!

Lucent win Madera

Driver Provider:

Driver Date:

Driver Version:

Digital $ ignet: 2 :

_ Update Driver... f°

Foil Back Driver if.”

_Uriretal| Microseft

3/9/2000

5.0.2- / :
" Microsoft Wwindows 4P Publisher a

To view details about the chiver files.

To update the chiver for thisdavide,

If the devicefails after updating the driver, roll...
back ta the previously installed criver.

To uirinstall the driver tAdvanced), , 7

vied hen Faneel 4

Hardwareprofiles are cannedsetsofsettings for particular equipmentconfigurations,
By switching from oneprofile to another, you can quickly inform your computer
that you've gota different assortmentof gear connected—afeature that, as you can
probablytell, is primarily useful for laptop owners.
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Perecu If your laptop hasa bay that can hold either a CD-ROM drive or a floppy drive, for
et example, you mightcreate two hardwareprofiles, one for each ofthe drives. Or maybe

you connect yourlaptop to a dockingstation at work; in that case, you could create
one hardware profile for the equipmentavailable on the docking station (including
a monitor), and another hardwareprofile for use when you're undocked.

To create a hardware profile, open the System Properties dialog box (see page 294).
Then click the Hardware tab, and click the Hardware Profiles button (see Figure

14-9),
 

 
an ee
clEe Every computeris equipped with a hardware

profile named Profile 1. Creating a new profile is
so You can set up hardware profiles for different hardware 6 A wt 7a configurations. At startup, you can choose the profile you stply a matter of copying the existing pirotile,wantto use. creating a new namefor the copy, and mak-

4 : ing changesto it. Use the option buttonsattheAvailable hardware profiles: 7 A

ee bottom to specify how long you want Windows‘Profile urrent < -
|Docked at home | af to display the menuofprofiles at system startup
'Docked at the office | need time.

| | Plprelatasr=rel 
es

 
| Properties | f Copy | Delete |

Hardware profiles selection
When Windows starts:

() Wait until I select a hardware profile

©) Select theFirst profile listed if I don't select a profile in
| seconds

(aCes)

 
 

The quickest way to create a new profile is to duplicate an existing one, and then make
changesto it. Proceedlike this:

1. Click the nameofan existingprofile,click the Copybutton, namethe newprofile,
and then click OK.

The new profile appears in the list shown in Figure 14-9.

2. Click to select the new profile, and then click OK.

You return to the Hardware tab.

3, Click the Device Manager button.

The Device Managerdisplaysalist of all the various hardware gadgets you've
installed into, or attachedto, this machine.
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4, Click the + symbol, and then the nameofthe component you wantto turnon or _

off in this profile.

The Disable button on the Device Manager toolbar becomesavailable.

5. Click the Disable button on the toolbar(see Figure 14-6). Click Yes when you're
asked to confirm.

After the Device Managerlist collapses and expands, updatingitself, you'll see a
little red X on the icon ofthe componentyou've turnedoff. (That’s what you'll see,
thatis, if the computer doesn’ttell you thatit first needs to be restarted.)

6, Repeat steps 4 and 5 for any other devices youd like to enable or disable for this
profile, and then click OK.

Hereafter, whenever you start your computer, you'll see, on a black, DOS-like screen,
a list of the hardwareprofiles you've created. Onlyafter you've selected one, following
the instructionsin Figure 14-10, does WindowsXPfinish its startup process.
 

|gue 14-10:
Every time you turn on
your Windows PC, you'll
be shown this listing of
hardwareprofiles. Highlight
the profile you want by
pressing the up and down
arrow keys;press the Enter
key when you've highlighted
ihe one you want Windows
loads only the drivers for the
hardware you've turned on
in the selectedprofile.
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CHAPTER

15

Joining, Compressing,
and Encrypting Disks

iles and folders, as youve probably noticed, have a tendency to multiply. Cre-
ating new documents,installing new software, and downloadingnewfiles can
fill up even thelargest disk drives in no time—especiallyif, as Microsoft fer-

vently hopes, you get heavily into music, pictures, and video. Fortunately, Windows
XP Professional offers a number of ways to expand the amountof space on your
drives: schemescalled dynamic disks and disk compression.

For many people, security is another concern. Files on your drives may contain
confidential financial data for your company,top-secret government research, or—
worse—theholidaygift list for your family. Windows XP Professional has a solution
for this problem too, called the Encrypting File System (EFS).

You can skip this entire chapter, if you wish, and get along quite well without using
any of these features. They're strictly optional. But if you aspire to wear the Power
User T-shirt, read on.
 

Note: Dynamicdisks, disk compression, and EFSall require the WW7FSfile system on your computer's disk
drives; they're absent if you've chosenthe FAT 32 file system instead. To find out the benefits and drawbacks
of NTFS,as well as how to convert FAT 32 drives to NTFS, see AppendixA.

Dynamic Disks

Suppose you've run out of space on yourfirst hard drive, and haveinstalled a second
one to collect the overflow. Thanks to a Windows XP Profeature called dynamic
disks, you don’t have to movefiles to the new drive or reorganize yourfolder scheme.
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Meaecs Instead, you can makethe new drivefold its space seamlessly with thefirst’s, so that
you suddenly have moredisk space on your “one” combodrive.

How Dynamic Disks Work
If this setup intrigues you, a bit more technical explanation is required.

Whenyou(oryour PC maker)first installed WindowsXP, it configured each drive as
a basic disk—a disk with its own driveletter. But before you can combinetwoactual
drives into one volume, you mustfirst convert them into a more flexible format that
Microsoft calls a dynamic disk.

The good newsisthatyou can convertabasic disk into a dynamic diskwithoutlosing
any data on the drive. (The actual steps, as you'll find out shortly, are easy indeed.)
The bad newsis that you can’t change a dynamic disk back to a basic disk, unless you
erase all of the data stored there.

And whywould you wantto? Because dynamicdisks,forall their flexibility, also have
somelimitations. Before you proceed with converting basic disks to dynamic disks,
assumea reclining position and read the following fine print:

« Once you've combined two physical disks into an iiber-disk (technically called a
spanned volume), a fatal problem ononeofthe two harddriveswill make you lose
all of the data on both drives—an eventthat can ruin your whole morning. Keep-
ing regular backups of your spanned volumeis critically important (see Chapter
16).

+ Dynamic disks are a specialty ofWindows XP Proonly. No other version ofWin-
dows can read them (not even Windows XP HomeEdition).

UP TO SPEED

Volumes Defined

458

You won't get far in this chapter, or at PC user group
meetings, without understanding a key piece of Windows
terminology: volume.

For most people, mostof the time, volume means ia(see
ielra ceaplaestiynlpreiaaiea into)(eRe tae MuLaTeiceoRs i(itLedenittcy
eenieneaerMBeva onsenmanesm elorenata iy
Ree

If you open your My Computer window, you'll see that
SeledmeCent yn TON mnOa sreCLmOMinmiaelsmile Megcomtia Or
SalmerClivepeliacelaAMaeA Misamegtcaqserelal \uroes\s2ts18-1(Rel

is possible that you, or somebodyin charge of your PC, has
split a single drive into multiple partons (Appendix A), each

with a Separate icon anddriveletter. Clearly, the world needs
EE Colany olmercran (601i)(ouciaINROO LEDIUPR y/oLain}
EMivaremelaceticlame cat ic(e2p,=3

in Windows XP Pro, you can do more thanpartition one hard
drive into multiple volumes-you can also do the reverse, as
describedin this chapter. if you've installed more than one
hacd drive; you can actually request that Windows represent
them on the screen as.one volume. This way, you can have

as manyhard disk drives in your computer as you want and
combine their storage space into a unit, represented by one
iconand driveletter,
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» Adynamicdisk can contain only one operating system. You can’t dual boot (choose

which of two operating systemsto use each time you turn on the PC), as you can
with basic disks.

* To convert a hard drive to a dynamic disk, it mustset aside an invisible storage
area to hold a dynamic disk database. If you partitionedthe drive using Windows
2000 or XP Professional, then Windows already reserved enough spacefor this
purpose. Butif the drive waspartitioned with another operating system, you may
have to erase it before converting it to a dynamic disk.

* Dynamic disks don’t work on laptops, removable disks, disks connected by USB
cables or IEEE 1394 (FireWire) cables, or disks connected to shared SCSI buses.
If your disks fall into any of these categories, Windows XP won’t let you convert
them to dynamic disks.

Converting a Basic Disk to a Dynamic Disk
If you haven't yet been scared off by afl of these cautions, and are ready to convert
your basic disks to dynamic disks, the procedureis simple. First, back up the disk
you plan to convert. You probably won't needit, butit’s a good idea to back up a disk
before performing any kindof traumatic surgerytoit.

Next,log on to the computeras its Administrator (page 517), and exit any programs
that might be running onthedisk you plan to convert.

You convertdisks and manage the dynamic volumes on them usinga special window
called the Disk Management console. To openit, use any of these methods:

* Choose Start>Control PanelAdministrative Tools~-»Computer Management.
In the resulting Computer Management window, double-click Disk Management
in thelist at the left side.

Figure 15-1!
The Disk Management
consoleis the central HB ie Action. Mien window. He
toolbox for aff ofyour

dynamic disk-related omputerManagement (Lo| |tapoutType.Status.tasks. This is where you HG, System Tools Heese3
convert basic disks to al Event Viewer ]@3Niew volume (E:) Perti... Basic Healthy
dynamic disks, and 2 Shared Folders=Jcwiekp Pro (Dit Simple Dynarsic Healthy (Boot). Local Users and Grav |

createthe ayHaRC al Perforrsance Logs ari
volumes on your disks. 2), Device Manager

storage
Removable Storage tees C Drive (C:) WIAXP Pro (D:4.88 GB NTFS 4.88 GB NTFS

# Disk Defragmenter Online: =
ogg) Disk Management, eee

: MB Services and Applications "Disk 1

 

Simple Dynamic Healthy (System)
ey

4, 8B= 3.08 GB
S14M6 509 MB
4,036B 2.31 GB 
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Petah.cd « In the Start menu, right-click My Computer. From the shortcut menu, choose
Manage. Once again, double-click Disk Managementin thelist at theleft side.

* Choose Start>Run;type diskmgmt.mse and press Enter.

Oncethis windowis before you,follow these steps:

1. Click the Disk Managementicon underStoragein the left pane of the Computer
Managementconsole.

You see a display of your drives and the partitions on them, as shown in Figure
15-1.

Thetop part ofthe windowlists the partitions on your computer. The bottom part
containsa horizontal box representing each drive on your computer, with smaller
boxes inside indicating the partitions on each drive. Notice that the header box for
each drive indicates the numberofthe drive in your system,its capacity, whetheror
notit’s online, and the word “Basic”(indicating thatit’s currently a basic disk).

2. Right-clickthe headerboxfor the drive, as shown in Figure 15-2; from the shortcut
menu, choose Convert to Dynamic Disk.

A Convert to DynamicDisk dialog box appears (Figure 15-2, bottom left), in which
you select the disk(s) you want to convert.
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Figure 15-2:
Top: To convert a basic

=I Computer Management. _  
 
 
 
 

 
 
 
 
 

 

 

disk to a dynamic disk,
oa right-click the header box

is Cunands sige) 32868 20858 for the drive and choose
ee ee ee Eee eae Convert to Dynamic Disk: eta from the shortcut menu.

Don’t right-click one ofthe
 

  

 
 
  

, Poe) _— partitions—you must click
Sees Bie cb:Sie isan” 28 the header box.eS 5 ae Sark: taal Systerit ny sy alerated

’ Bottom left: The Convert

to Dynamic Disk dialog
boxlists the drives that

 
are eligible for conversion
to dynamic disks. You can
even select and convert
several disks at once.

Bottom right: The Disks
to Convert dialog boxlists
the dynamic volumesthat
Windows XP will automati-

cally create on your newly
converteddrives,

The disks that vill be made dyeranvic are shown in the following fel
Ditks:

Name | Disk Conterta Wil Convett
| Disk T Yes :

   

 (Com)
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3, Click OK.  Ifyou're convertinga disk that containsbasic partitions, a Disks to Convert dialog

box appears (Figure 15-2, bottom right).

If you click a disk and then click Details, a Convert Details dialog box appears,
listing the dynamic volumesthat you're aboutto create. (All of the standard parti-
tions on the drive are converted into simple dynamic volumes—thatis, they aren’t
yet combined into spanned volumes.Thatstep comeslater.)

4. Click the Convert button.

IfWindows XP detects other operating systems on yourdisk, you'll be warned that
they won't be ableto start up the PC after the conversion.Ifyou're converting the
disk that contains Windows XP Proitself, you'll have to restart the PC.

Otherwise, though,the conversion process takes only a few seconds. After restarting
(if necessary), log on and open the Disk Management console again. As shown in
Figure 15-3, the conversion is complete.   
Figure 15-3:
Now the header box

for your disk says
“Dynamic”rather than
“Basic,”and what used

io be partitions on the ae ce
disk (with blue header 514M8 509 MB
bars) are now simple so ak auscs 2
volumes (with red
header bars). 
  

Three Uses for Unaliocated Space
Ifyou've installed a new harddrive,you'll see, in the Disk Management window,that
it consists of unallocated space—disk space that doesn’t belong to any volume yet. It’s
just sitting there, unaccounted for, unusable, waiting for you to make it part of one
volumeor another.

Wheneveryoufind yourself with unallocated space, you get to discover the flexibility
of dynamic disks, If you right-click an unallocated area in oneofthe disk boxes and
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Dynamic Disks choose New Volume from the shortcut menu,you'll see that you can choose anyof
three options: Simple, Spanned,or Striped (see Figure 15-4). Here’s a rundown of
each:

ae Figure 15-4:
HeAdres The Select VolumeType screen

Select Volume Type if of the New Volume Wizard
There are five types of volumes: simple, spanned, striped, mirrored, and RAID-5. , displays the dynamic volume

Be types that you can create on
aayour computer, Click one to

Select the volume you wantto create: read a description at the bot-
)Simple tom of the dialog box.
<3 Spanned

 
©) Striped

Description

A simple volume is made up of free space on a single dynamic disk. Create a
simple volumeif pou have enoughfree disk space for your volume on one disk.
‘You can extend a simple volume by adding free space from the same disk oranotherdisk.

< Back New>|| Cancel |

 
 

 

cceaaammenceinaia Figure 15-5:
jetSsAe : : On the Select Disks screen,

Select Disks a you specify where you wantto
You can selectthe disks and set the disksize for this volume. = get the unallocated space that

the wizard will use to create

the dynamic volume. When

  

Select the dynamic disk you wantto use, and then click Add. creating a simple volume,
Available: Selected: you can only select one disk,
i ii as scr but for spannedorstriped

| volumes, you can select up
to 32.

|

| < Remove All | |

Total volume size in megabytes (MB):

Maximurn available spacein MB:

Select the amount of space in MB:
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Creating a simple volume
Asimple volume, on a dynamic disk,is a lot like a partition on a basic disk. It’s a sub-
division of the hard drive that looks and acts exactly like a separate disk, complete
with its own drive letter and icon in your My Computer window.

PETtabs)ts(£3

To make one, follow these steps, beginning with the New Volume Wizard screen
shown in Figure 15-4:

1, Click Simple (Figure 15-4) and then click Next.

The Select Disks screen appears (Figure 15-5).

2. Specify the size of the volume you wantto create (in megabytes) in the “Select
the amountof space in MB”box.

Often, you'll want to leave the maximum numberhere,so that you turnallof the
unallocated space into a single new volume—butyou don’t have to. You can chop
up the space into a numberofdifferent volumes,if youlike.

POWER USERS’CLINIC

Extending a Volume

One big advantageof dynamic disks is that you can extend
an existing volume whenever youfeellike it, just by allocating
additional disk space to.it. If, for example, you run outof
space on avalume you've
PINCH BEe\CresIE eM aU
have some unallocated

eiire@saelg SORNOTOMee
you can simply add it to
the Data volume to make

it bigger, The unallocated == i
EyrsCeomn Tot texte Vas ce |
comes a permanent part Ee) i_Bapovet| Daa
of the Data volume. (Note Treketesenee moe nyegebyees (HH

Lrempeeosceneattoe
Once you've added free

extend the system volume, nor any volume that was origl-
al acN MmetartaeReainNICMASpCRGIES

To extend an existing dynamic volume, right-click it in
the Disk Management
window: choose Extend
Volume from the shortcut

menu, The Extend Volume

Wizard appears, consisting
of nothing but a Select
OTSCesareanames

When you've made your
selections, click Next and

then Finish to complete
Lemire

eur eaitn | tard 4
Solect Disks

‘You can use space on one ortore dynamic disks bo ewend the vohime.

Select the dnonus disks you waril to uae, and then clickAdd.

Ayaletie. Selecteda

Maxinur avaiable space in MB:
Select the amount of space in MB:

space to a dynamic vol-
NieslomniebelnwoacmetdEte)
that volume permanenily,
or at feast until-you delete the volume~andits data—and
Ucmaesr)tal9)

Thedisk space you use to extend the volume can come from
either the samedisk or another dynamic disk (in which case
pKalCer- eaeeteyeenolelaMN (olConLOUam rmee Lectay

 

When you look at the

Disk Managementdisplay,
the new space you've al-

located appears at first to be an entirely new volume, with
oreomLGLEN ILMMSU39],-)A RevelarbrecouecigaiIe
however, and you'll see that bath the original volume and
the newone havethe samedrive letter. Furthermore, when
you look at the drive list atthe top of the window, the volume
appears only once, with the capacity reflecting the totalofthe
original volume and the extension you just created, ”
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3. Click Next.

The Assign Drive Letter or Path screen appears (Figure 15-6, top).

4, Specify the drive letter you wantto assign to the volume.

If you like, you can also turn the volumeinto a sub-folder of an existing NTFS
folder (a technicaltrick described on page 490).

5. ClickNext. On the Format Volumescreen (Figure 15-6, bottom), specifythe NTFS
file system. Type a namefor your new volumeinto the “Volumelabel”box.Click

  
Next, and then Finish.
  

eetbapatp 
  
 

 
Assign Drive Letter or Path

For easier access, you can assign a drive letter or drive path to pour volume.

 

 
 
  
 

(@) Assign thefollowing drive letter:

C) Mount in the following empty NTFSfolder:

New Volume Wizard

 
 Format YVolume

To store data on this volume, you must format it first.

 
  
  
  
 

  

 

Choose whether pou wantto formatthis volume, andif so, what settings you want to use,

 

 

 

©) Do notformat this volume  

© Format this volume with the following settings:

File system:

Allocation unit size: : Defauk
New VolumeVolume label:

[1] Perform a quick format ("] Enablefile and folder compression

(oma)

Figure 15-6:
Top: On the Assign Drive Let-
ter or Path screen, you specify
whatdrive letter you wantto
use for the new volume. Alter-
natively, you can mountit as
a folder on an NTFSdrive.

Bottom: The Format Volume
screen lets you format your
new dynamic volume as soon
asit’s created, as well as
specify a volume name and
turn on disk compression. Be-
cause this is a dynamicdisk,
NTFSis the only file system
available for formatting.
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Presto: Whatusedto be unallocated space (denotedbya black headerbar in the Disk
Management window) is now a simple volume (with a red header bar). The new
volume now appears in your My Computer window—and everywhere else—with
the drive letter you assignedtoit. It’s ready to store data.
  

Tip: You can delete a dynamic volumeas easily as you createdit. Just right-click it in the Disk Management
window and select Delete Volumefrom the shortcut menu. Doingso deletes the entire volume,erasing all
the data on it and removingits space from any spanned or striped space on otherdisks. 

Creating a spanned volume

Suppose you've managed to shoehornevery byte of data youpossibly can onto your
PC’s one hard drive. You decide to install a second hard drive, to give you more
space.

But then what? You don’t want to spoil the carefully organized folder structure on
your old hard drive by movingpartsofit to the new drive; youjust wantto continue
to build on your foldersas they are.

The solution, as you know if you read the beginning of this chapter, is to create a
spanned volume,a single disk icon (anddriveletter) that’s actually composed ofthe
space from both your old and newdrives.

Thefirst order ofbusiness(after restarting the computer) is to make sure thatWindows
XP has recognized the new drive. Messages inform you that the operating system has
located a new hardware device andidentifiedit as a hard drive. When you launch the
Disk Managementconsole, a new drive appearsin thelist, with a great big block of
unallocated space for youtofill, as shown in Figure 15-7,
  

Figure 15-7:
When youinstall a
new hard drive in

your computer, it
appearsin the Disk
Management console
as a large block of
unallocatedspace. Of
course, you quickly
notice that the new

drive is a basic drive;
therefore, aff you can :
do is create a basic ic rN
partition on it Mereara

 

 
fe disk 1

Basic
514 MB
Online

B Unallocated

—

7514 MB Hl| Unallocated i
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Before you can use the new drive to enlarge yourexisting volume, you must convert
it to a dynamicdisk, just as described on page 459.At that point, you'refreeto right-
click your original volume(in the Disk Managementwindow)andopen the Extend
Volume Wizard.

Whenthe Select Disks screen appears (Figure 15-8, top), you'll see that the only
available unallocated space in your computer is on your new drive. Select it in the
Available column and click Add to addit to the Selected column.Specify how much
of the new drive you wantto add to the volume(or, to addall of it to your original
drive, do nothing). Finally, click Next and then Finish.
 
 

HaeCCE Colt=mcatee ‘ Figare 15-8:
Top: When extending
a volume to another
disk, click its name in
the Available column

Select Disks
‘You can use space on one or more dynamic disks to extend the volume.

Select the dynamic disks you want to use, and then click Add. before addingit to the
Selected Selected column.

| si SOE Bottom: A dynamic
| volume extended to
—— another disk appears

| <Removeall | in the Disk Manage-
‘) ment console with the
"same color header bar

Maximum available space in MB: ries ' and the samedrive
Select the amount of space in MB: 515 | letter. Note, 100, that

: oe i the volumelist in the
| upper-right quadrant
~_ofthis dialog box

identifies this volume

as “Spa...” (which,
if you could see the

  
  ~, ‘i |

ae i | piso aES =TO shin <herane | POMDatC (CDrive (C:) | WinXP Pro (D2 ‘New Volume (F:, whole word, would
Remaveble Storage | 19,08 GB A88GBNTFS—|4,88GBNTFS 9.32 GBNTFS say “Spanned”).
isk Geiragmente | Online Healthy (System: | !Healthy (Boot) | HealthyRick Mane t enoes tee

Services and Apical disk 1 in
i Dynamic : New Volume (F:) i

515 MB | S15 MB NTFS il
Online | Healthy ik  | MlUnallocated§Simple volume[IfSpannedvolume

 

Notice nowthatyouroriginal volumeandyour newdrive both have a purple header
bar and use the samedriveletter, as shown at bottom in Figure 15-8. You now have
a spanned volumeusing space on both of your hard drives. Your hard drive is now
effectively bigger, and you can continue to amass newfiles at your accustomedrate.
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Creating a striped volume

As you now know,a spanned volumeis like a virtual hard drive made up of storage
space from two to 32 dynamic disks. When Windows XP saves data onto a spanned
volume, it completelyfills up the allotted space on onedrive, then proceeds to the
next drive in the volume, until the allotted space on all of the drivesis full.

A striped volumeis similar,in thatit’s a single volume made up of space from several
actual disks, but the way Windows XPsaves data to the drivesis different. Instead of
filling up one drive and proceedingto the next one, Windows XPsaves pieces of each
file on more than one disk. Because more than one hard driveis saving and reading
data in parallel, a speed benefit can theoretically result. 

Thetruthis, though,that the differences are measured in milliseconds—thousandths
of a second—soit’s generally not worth creating striped volumes on everyday PC
workstations. (On corporatefile servers that handle hundredsor thousandsoffile
access requests per minute,it’s a different story. The cumulative savings in access
times can besignificant.) 
Ifyoure still tempted to create a striped-volumeset, the processis nearly identical to
creating a new spanned volume(see the box below). The onlydifference is that you
must use the same amountof space on each of the drives youselect, For example,
if you have one gigabyte of unallocated space on Disk 0 and five gigabytes of unal-
located space on Disk 1, your striped volume can benolarger than two gigabytes,
one from each drive.

 

Compressing Files and Folders

Although the hard drives made these days have greater capacities than ever, programs
and files are muchbigger, too. Runningoutof disk spaceis still a common problem.
Fortunately, Windows XP Prois especially effective at compressing files and folders
to take upless disk space.
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Compressing files and folders can also be useful when you wantto email files to
someone without doomingthem toanall-nightmodem-watchingsession. That's why
Microsofthas endowedWindowsXP with two different schemesfor compressingfiles
and folders: NTFS compressionforstoringfiles on yourharddrive, and zippedfolders
for files that might have to be transferred.

CetetaaCty
and Folders

NTFS Compression
IfWindowsXP Pro wasinstalled on your PC whenyou boughtit, or ifyou upgraded
your PC fromWindows2000,orifyou erased your harddrive before installingWin-
dows XP, then your hard drive is probably formatted usinga file system called NTFS
(short for NTfile system; see page 636for details).

Most people canlive along and happylife without knowing anything about NTFS.If
you workin a corporation, you mightbe grateful for the additional security it offers
to Windows XP Pro fans (Chapter 17), andleaveit at that. Now andthen, however,
you'll read aboutotherfeaturesthatare available only ifyour hard drive was prepared
using NTFS—andthisis one of those cases.
eS

Tip: To find out whetheror notyour hard drive uses NTFS formatting, choose Start—>My Computer. Right-
dlick the hard drive icon; choose Properties from the shortcut menu.In the resulting dialog box, you'll see
either“File system: NTFS”or “File system: FAT 32.”(\f it says FAT 32, you probably upgraded yourPC from
Windows 98 or WindowsMe.) Unfortunately, special NTFSfeatures like automatic compression aren't avail-
able to you, but you can upgrade yourdrive formatting to NTFS without havingto erase it. See page 638
forinstructions. 

The NTES compression schemeis especially likable becauseit’s completelyinvisible to
you. Windows XP Pro automatically compresses and decompresses your files, almost
instantaneously. At some point, you may even forget you've turnedit on. Consider:

UP TO SPEED

Data Compression

468

DETeoaeteyonceerm ceteM Mcelacsomel C91(eatatUS
material in a file with shorthand symbols. For example,if
Eleaca MMOAUon slate Maesie inoe tee NKR ereae CZRNCCE
21 times, a compression schemelike the one in. NIFS may
replace each occurrence with a single symbol, making the
file that much smaller. When you reopen thefile later,
fareictenyeoctielieselNSeiicinsesarees
original, expanded material.

The degree to which a file can be compressed depends on
what kind of data the tile contains and whether it’s already

been compressed by another program. For example,
programs (executable files) often shrink by half when

compressed. Bitmapped graphics like TIFF files squish down
fo as little as oné-seventh their original size, saving a great
deal more space.

The GIF and JPEG graphicsfiles so popular on the Web,
however, are already compressed Gwhich is whythey're so
popular—they takerelatively little time to dawnload), and
OMseeMaanUTIs!en Veeninmo Neeiin|kocoMcan
manually. That's one ofthe main rules of data compression:
data can only be compressed once!

In short, there's no way to predict justhow much disk space
you'll save by using NTFS compression on yourdrives. It all
depends on what you have stored there,
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* Wheneveryou open a compressedfile, Windowsquickly andinvisibly expandsit esis tisd
to its original form so that you can readoredit it. When youclosethefile again, cutie
Windowsinstantly recompressesit.

* If you send compressedfiles (via disk or email, for example) to a PC whose hard
drive doesn’t use NTFS compression, WindowsXP once again decompresses them,
quickly and invisibly.

* Anyfile you copy into a compressedfolder or disk is compressed automatically.(If
you only moveit into such a folder from elsewhere on the disk, however, it stays
compressed or uncompressed—whicheverit wasoriginally.)

Compressing files, folders, or disks
To turn on NTFS compression,right-click the icon for thefile, folder, or disk whose
contents you wantto shrink. Choose Properties from the shortcut menu.Click theAd-
vancedbutton,andin theresulting dialog box, turn on“Compress contents to save disk
space”(Figure 15-9). Ifyou haveselected a folder for compression, you are prompted
as to whetheryou also want to compressthefiles and subfolders within it.

Many Windowsveterans wind up turning on compressionfor the entire hard drive.
  

Figure 15-9:
If you don’t see the “Compress contents to save
disk space” checkbox (highlighted here), then your
hard drive probably doesn't use the NTFS format-; bts
ting scheme.

. a eeyirry T. “2 tee bese F i$e indexing Se =e t6 index this feate

Compress or Encrypt attributes

[] Compress contents to save disk space
[_]Encrypt contents te secure data

  
 

It can take WindowsXP several hours to perform theinitial compression of every
file on thedrive. (If you plan to go see a movie while Windows is working, though,
quit all your programsfirst. Otherwise, the compression process will halt whenever
it encounters an openfile—waitingfor youto closethefile ortellWindowsto ignore
it—andyou'll find the job only half done whenyoureturn.)

 

CHAPTER15: JOINING, COMPRESSING, AND ENCRYPTING DISKS 469

HP Inc. - Exhibit 1007 - Page 483 |



HP Inc. - Exhibit 1007 - Page 484

Compressing Files
and Folders

When Windowsis finished compressing, the compressedfile and folder icons appear
in a different color, a reminder that Windows is doingits part to maximize your disk
space.(If they don’t change color, then somebody—maybe you—musthave turned
off the “Show encrypted or compressed NTESfiles in color” option described on
page 87.)

Whenyoulookat the Properties dialog box for a compressedfile (right-click thefile
and choose Properties from the shortcut menu), you can see two file sizes. The Size
value indicates the actual (uncompressed)size of the file, and the Size On Disk value
is the compressedsizeofthefile, that is, the amount of disk spaceit is occupying.

Zipped Folders
As noted above, NTFS compressionis great for freeing up disk space while you're
working at your PC. But when you email yourfiles to somebodyelse or burn them to
a CD, Windows XP always decompresses them right back to their original sizes first.
And,of course, NTFS compressionisn’t even an optionifyour hard drive doesn’t use
NTESformatting (page 636).

Fortunately, there’s another way to compress files: Zip them.If you've ever used Win-
dows before, you've probably encountered Zip files. Each oneisa tinylittle suitcase,
an archive, whose contents have beentightly compressed to keep files together, to
save space, and to transfer them onlinefaster (see Figure 15-10). Use Zip files when
you wantto email something to someone,or whenyou wantto pack up a completed
project and removeit from your hard drive to free up space.
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Creating zipped folders
In Windows XP, you don’t even need a shareware program like PKZip or WinZip to
create or open Zipfiles. You can create a Zip archive in either of two ways:
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* Right-click any blank spot on the desktop or an open window. From theshortcut
menu, choose New—»Compressed(zipped) Folder. Type a name for your newly
created, empty archive, and then press Enter.

Now,each time you draga file or folder onto the archive’s icon (orintoits open
window), Windows automatically stuffs a copy ofit inside.

Ofcourse, you haverrt actually saved any disk space, since now you have two copies
of the original material (one zipped, one untouched). If yowdrather movea file
orfolder into the archive—in the process deleting the full-size version and saving
disk space—right-dragthefile or folder icon onto the archive icon. Now from the
shortcut menu, choose Move Here.

* To turn an existingfile or folder into a zipped archive, right-click its icon. (To zip
up a handful of icons, select them first, then right-click any one of them.) Now,
from the shortcut menu, choose Send To—Compressed (zipped) Folder. You’ve
just created a new archivefolder and copiedthefiles or foldersintoit.

Tip: At this point, you can right-click the zippedfolder’s icon and choose Send To—>Mail Recipient. Windows
automatically whips open your email program,creates an outgoing message ready for you to address, and
attaches the zippedfile to it—which is now set for transport.-_TT —SSSSSSSSSFSFSFFFFFMMFFFeFee

Working with zippedfolders
In manyrespects, a zipped folder behavesjustlike any ordinary folder. Double-click
it to see what’s inside.

If you double-click one of thefiles you find inside, however, Windows opens up a
read-only copy of it—thatis, a copy you can view, but not edit. To make changes to
a read-only copy, you must use the File>Save As command andsave it somewhere
else on your hard drive.

Note:Be sure to navigate to the desktop or the My Documents folder, for example,before you save your
edited document. Otherwise, Windowswill saveit into an invisible temporary folder, where you may never
see it again.————————
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PeceealaCy To decompress only someofthe iconsin a zipped folder, just drag them out of the
and Folders archive window;they instantly spring back to their original sizes. Or, to decompress

the entire archive, right-click its icon and choose Extract All from the shortcut menu
(or, if its window is already open,click the “Extractall files” link on the task pane). A
wizard asks youto specify where you wanttheresulting files to wind up.

Encrypting Files and Folders
If your My Documentsfolder contains nothing but laundrylists andletters to your
mom,data security is probably not a major concernfor you. Butif there’s somestuff
on yourhard drive that you'd rather keep private—you know whoyou are—W°indows
XP Professional can help you out. The Encrypting File System (EFS) is an NTFSfeature
that stores your data in a coded format that only you can read.
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The beauty of EFSis thatit’s effortless and invisible to you, the authorized owner.
Windows XP automatically encrypts your files before storing them on the drive, and
decrypts them again when you wantto read or modify them. Anyoneelse who logs
on to your computer, however, will find these files locked and off-limits.

Ifyou've read ahead to Chapter 17, of course, you might be frowningin confusion at
this point. Isn’t keeping private files private the whole point ofXP’s accounts feature?
Don't XP Pro’s NTFS permissions (page 544) keep busybodiesout already?

Yes, but encryption provides additional security. If, for example, you are a top-level
agent assigned to protect your government’s mostclosely guarded egg salad recipe,
you can use NTFSpermissionsto denyall other users accessto thefile containing the
information. Nobodybut you can open thefile in Windows XP.

However, a determined intruder from a foreign nation could conceivably boot the
computer using another operating system—one that doesn’t recognize the NTFS
permissions system—andaccess the hard drive using a special program that reads
the raw data stored there. If, however, you had encryptedthefile using EFS, that raw
data would appearas gibberish,foiling your crafty nemesis.

Using EFS
You use EFS to encrypt your folders andfiles in much the same way that you use
NTFS compression. To encrypta file or a folder, you openits Properties dialog box,
click the Advanced button,turn on the Encrypt Contents To Secure Data checkbox,
andclick OK (see Figure 15-11). (For a quicker way, see page 667.)

Depending on how much data you'veselected,itmay take sometimefor the encryp-
tion process to complete. Oncethe folders andfiles are encrypted, they appear in a
different color from your compressedfiles (unless, once again, you've turnedoff the
“Show encrypted or compressed NTFSfiles in color” option).
 

Compressing Files
Ealey

 

 

Figure 15-11:
To encrypta file or folder using EFS, turn on the
Encrypt Contents To Secure Data checkbox(at the = : ;
bottom ofits Properties diafog box). If you've se- sofEl Choosethe settings you wantforthis Folder
lected a folder, a Confirm Attribute Changes dialog |
box appears, asking ifyou want to encryptjust that
folder or everything insideit, too. Archive and Index attributes

(1 Falderis ready For archiving

Compress or Encrypt atbibutes

[_] Compress contents to save disk space
Encrypt contents to secure data

 
 

  

CHAPTER15: JOINING, COMPRESSING, AND ENCRYPTING DISKS

Whenyou apply these changes youwill be asked if you want the
changes to affect all subfolders andfiles as well.

{#] For Fast searching, allow Indexing Service to index this folder  
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eetaad Nofe: You can't encryptcertain files and folders: system files, or any files in the system rootfolder (usually
Prurd the WINNTor Windows folder). You can’t encrypt files and folders on FAT 32 drives, either.

| Finally, note that you can’t both encrypt and compress the same file or folder. If you attempt to encrypt a
compressedfile or folder, Windows XP will decompress itfirst. You can, however, encryptfiles that have been
compressed using another technology, such as Zip files or compressed imagefiles. 

After your files have been encrypted, you may be surprised to see that, other than
their color change, nothing seemsto have changed. You can open them the same way
you always did, change them,andsave them as usual, WindowsXP is just doingits
job: protecting these files with minimum inconvenience to you.
Still,ifyou're havingdifficultybelieving thatyour files are nowprotectedby an invisible
force field,trylogging offand back on again with a different user name and password.
Whenyoutry to open an encryptedfile now, a message cheerfully informs you that
you don’t have the proper permissionsto access thefile. (For more on Windows XP
security, see Chapter 17.)

EFS Rules

Anyfiles or folders that you move into an EFS-encrypted folder get encrypted,too.
But dragginga file out of it doesn’t un-protect it; it remains encrypted as longas it’s
onan NTFSdrive. A protected file loses its encryption only when:

- You manually decryptthefile (by turningoff the corresponding checkboxin its
Properties dialog box).

* You moveit to a FAT 32 drive.

- You transmitit via network or email—an importantpoint. It meansthatif some-
body can access your hard drive from across the network, they can open your
encrypted files, even without knowing your account password! To protectfiles
from prying eyes across the network, you must also use NTES permissions, as
described on page 544.

By the way, EFS doesn’t protect files from being deleted. Evenifpassing evildoers can’t
open your private file, they can still delete it—unless you've protected it using XP’s
permissions feature (Chapter 17). Here again,truly protecting important material
involves using several security mechanisms in combination.

GEM IN THE ROUGH

Recovering Encrypted Data
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 Maintenance, Backups,
and Troubleshooting  

preventive maintenance. Fortunately, Microsoft has put quite a bit of effort
into equipping WindowsXP withspecial toois, all dedicatedto the preservation

of what Microsoft calls PC Health. Here’s a crash course in keeping your PC—and
its hard drive—humming.

[ ike you, its human sidekick, your computer requires periodic checkups and

System Restore

As you get more proficient on a PC, pressing Ctrl+Z—the keyboard shortcut for
Undo—eventually becomes an unconsciousreflex. In fact, you can sometimes spot
veteran Windowsfans twitching their Ctrl+-Z fingers even when they’re not near the
computer—after knocking over a cup of coffee, locking the car with the keysinside,
or blurting out something inappropriate in a meeting.

WindowsXPoffers one feature in particular that you might think of as the mother
of All Undo commands: System Restore. This feature alone can be worth hours of

: your time and hundredsof dollars in consultantfees.

" Thepattern ofthings going wrong in Windowsusually workslike this: The PC works
. fine for a while, and then suddenly—maybefor no apparent reason, but most often
» following an installation or configuration change—itgoesonthefritz, At that point,

wouldn't it be pleasantto be able to tell the computer: “Go back to the way you were
: yesterday, please”?

_ System Restore does exactly that: It “rewinds” your PC back to the condition it was
. in before you, or something youtried to install, messed it up.
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Sci Ofcourse, somepeoplewill say that this is what backupsare for. But System Restore
isn’t the same thing;it takes onlyyouroperatingsystem backto its previous condition.
It doesn’t touch your email, Internet Explorer History or Favoriteslists, Web cookies,
files in your Windows—Downloaded Program Files folder, My Documentsfolder, or
any standard documenttypes(.doc,.xls, graphicsfiles, and so on).

Andbesides: if you don’t like your PC after restoring it, you can always restore it to
the way it was befere you restored it—back to the future. 

Tip: \f your PC manages to catch a virus, System Restore can even rewindit to a time beforetheinfec-
tion—sometimes. Unfortunately, you can’t count on your PC havingthat function.By thetime you discover
it, the virus may have infected your documents, which System Restore doesn’t touch. An up-to-date antivirus
program is a much moreeffective security blanket.

About Restore Points

System Restore works by taking snapshots ofyour operating system.In fact, your copy
of Windows XP has been creating these memorized snapshots,called restore points,
ever since you've been runningit. When the worst comesto pass, and your PC starts
acting up, you can use the System Restore calendar (see Figure 16-2) to rewind your
machinetoits configurationthelast time you remember it workingwell.

AsFigure 16-2 illustrates, Windows XP automatically creates landing points for your
little PC time machineat the following times:

* Thefirst time you boot up Windows XP.

» After every 10 hours of operation.

» After every 24 hoursofreal-world time (unless your PC is turnedoffall day; then
you get a restore point the next timeit’s turned on).

+ Every time you install a new program (provided it uses a recent version of the
Microsoft WindowsInstaller or InstallShield).

« Every time the Automatic Update feature (see page 331) updates a componentof
your operating system.

* Wheneveryoufeel like it—forinstance,just before you install some new compo-
nent. (To create oneofthese manual checkpoints, choose Start—Help and Support.
Click “Undo changes to your computer with System Restore.” On the next screen,
click “Create a restore point,” and thenclick Next; name your new checkpoint and
click OK.) 

Note:Whenyourhard drive is running low on space,System Restore turns off automatically, without notice.
It turnsitself back on when you free up somespace. 

As you can well imagine,storingall of these copies of your Windows configuration
consumesquite a bit of disk space, especially since the factory setting for the amount

 

476 WINDOWS XP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 490
———



HP Inc. - Exhibit 1007 - Page 491

of space that System Restore can use is 12 percent of every hard drive. That adds up noe
quickly—on a 60 GB harddrive, that’s 7.2 GB.

Fortunately, you can control exactly how much disk space is dedicated to this func-
tion—orturn the functionoffentirely—asdescribedin Figure 16-1. (Note that turning
off System Restore, even momentarily, wipes outall existing restore points.) 

Tip: Ever wonder where Windowsis storingthis backup copyof your operating system? It’s in a foldercalled
System Volume Information that sits in your Local Disk (C:) window.Inside are individualfolders for each
restore point. (System Volume Information is generally an invisible folder, but you can makeit visible fol-
lowing theinstructions on page 84. You still won't be allowed to move, rename,or delete it, however—thank
goodness.) 

That’s why Windows XP automatically begins deleting restore points after 90 days
(or whenit’s running out of disk space)—as well as any chanceof rewinding your
system back thatfar. That’s also why the System Restore feature stops working ifyour
hard driveis very full.

Andthat’s also why you should run the System Restore feature promptly when your
PC acts strangely.

 

 Figure 16-1:
To specify how much disk space System
Restore is allowed to use (and therefore
how many“rolling back" opportunities you
have), open the System program in Control
Panel. Click the System Restore tab, and “54. System Restore can track and reverse harmful changes te your
then drag theslider to change the amount of.=|| == compute’.
disk space you're willing to sacrifice for this
feature. (If you have severalhard drives, you
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Tip: When youvaluehard drive space more than the opportunity to return your PC to a distant momentof
health, you can use an obscurebutton (Figure 16-3), to delete all but the most recent system restore point. To
get there, choose Start—All Programs—Accessories—System Tools—>Disk Cleanup.Click the More Options
tab, and then click the “Clean up” button in the System Restore section.

Re CaOl

 

Performing a System Restore
If something goes wrong with your PC,here’s how toroll it back to the happy, bygone
days of late last week:

1. Choose Start—>Help and Support.

The Help center appears.

2. Click“Undo changes to your computer with System Restore.” On the next screen,
confirm that “Restore my computerto anearlier time”is selected, and then click
Next.

Now you see the System Restore calendar (Figure 16-2). The calendar squares
containing boldface numbersindicate the days on which Windows memorized
your operating system condition.

GEM IN THE ROUGH

Automatic System-File Replacement

478

One of Windows XP’s best PC-health features has no control

panel, no window, and no icon ofits own.It's a behind-
the-scenes, automatic feature that may have already saved
your PC's hide a time or two without your knowledge.It's
System File Protection.

Ordinarily, you can’t see the icons of extremely important
Windows system files. Years of calls to Micrasofi’s help center
have taught the companyto keepthesefiles hidden from the
Tilespretpisia mereMLigicaalsODEIu-TECC UNH NI Nedaos

But if you make these files visible again (see page 84) and
drag one of the vital files in the Local Disk (C)->Windows
folder to the Recycle Bin, you won'teven get the satistac
ColMe) ARSoe isa (Olu ImeaeLaaniaemnaichsevel ese¢Pmacln ara0g
you can close and open the Windows folder again, the
CSEaeselgUMECSSNLeoCMNTeme(eclCclegmScra |ARNt
pertect, fresh copy.

This feature also solves the age-old “My-application’s-in-
staller-replaced-an-important-systemn-file-with-an-older-ver-

sion-and-now-nothing-works!” snafu, Simply put, Windows
XP won't allow an application to replace a Windows XP? file
with an older version. True, this means thaf some older

Popgesceea nasa (OHO GUT fea0ye|bCcHum@nRoLeMMGLARCH Gagag mRnTcIN
yourentire PC.

incidentally, Windows XP uses a similar technique to keep
your system updated with Service Packfiles. (Service Packs
are periodic updates that Microsoft releases to address
problems in the operating system.)

in the old days of Windows NT, if you installed some new.
SPSCncaUiieceiCminelUse wsteny ecapotegaa
had to install the Service Pack again to ensure that the new
feature was using all the latest files. Winclows XP saves you
this hassle by storing the Service Pack files right on your
hard drive. Whenever applications need new-versions. of the
operatingsystem files, Windows installs them automatically,
using the downloaded Service Packfiles for reference.
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3. Click the boldface calendar square closest to the last day you remember your PC System Restore
working correctly.

Nowyousee, in the right pane, the restore points that were created on that day,
complete with a description.

4, Click one of the checkpointslisted on the right side, and thenclick Next.

You're now warnedto close all your documents and programs. Right-click each
window button on your taskbar (except the System Restore button,of course),
choosing Close from each shortcut menu until System Restoreis the only program
left running.

Figure 16-2: aes
Top: To change the month,
click the < or > button at
either endofthe calendar.

When youclick a calendar

square containing a bold The following calendar displays in bold all of the dates that haverestore points avaiable. The fist displays the
number, the pane on the restore points that are available far the selected cate.
rfight shows the restoration Possible types of restore points are: system checkpoints (scheduled restore paints created by your computer),
points available for that manual restore points (restore points created by you}, and installation restore points (automatic restore points
date. You may find “Manual created when certain programs are installed),
Checkpoint aCich is one 1. On Ehis calendar, click ahold date. 2. On this list, click a restore point.
that you created yourself;
“System Checkpoint,” which is 2a;
one that Windows XP created|25]_26]27]2aa2 fe

automatically (a “just in case” arerestore point); “Update toeg Ml ial3
|2528)

ie:

Select a Restore Point

an unsigned driver,” which
means you installedsoftware
that Microsoft hasn't inspected
(as described on page 448);
‘Automatic Updatesinstall,”
which is a Windows patch that
XP downloadedand that you
approvedfor indcdatiarond (gence)
50 On.

Bottom:After a restart,you're
back in business. This mes- 2

sage reminds you that you
can even rewind the rewind-

ing, if it didn’tproduce the
results you were seeking.

vy Restoration Complete

Your computer has been successfully restored to:
Friday, March 24, 2662
Unsigned driver install

Jf this restoration dogs nat correct the problem, you can:
© Choose another restore point
© Undo this restoration
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ect 5, ClickNext.
NowWindowsgoesto town,reinstating your operating system toreflectits condi-
tion on the date you specified. Leave your PC alone while this occurs.

When the process is complete, the computer restarts automatically, and the message
shown in Figure 16-2 (bottom) appears. Welcome back to the past.
 

Tip: \f rewinding your system to the golden days actually makes matters worse, you can always reverse the
entire Restore process. To do so, open Start—»Help and Support again. Once again, click “Undo changes to
your computerwith System Restore”—but this time, select “Undo mylast Restoration.” Click Next, click OK,
dick Next, and wait for the process to reverseitself. 

Disk Cleanup

As you use your computer, Windowsplaces numerous temporary files on your hard
drive. Programs,utilities, and Websites litter your hard drive with disposablefiles.
Trouble is, Windows doesn’t always clean them up whenthey're no longer needed.
If you could see your hard drive surface, it would eventually looklike the floor of a
minivan whose ownerseata lot of fast food.

Choose Start->All Programs—>Accessories—System Tools—Disk Cleanup to open
Windows XP’s built-in housekeeper program.(Or, ifyoufindit faster, right-click the
icon for your hard drive in your My Computer window,and choose Properties from
the shortcut menu. Then,on the General tab,click the Disk Cleanup button.)

The program dives rightin,inspecting yourdrive and reportingonfilesyou can safely
remove(Figure 16-3). It’s like getting a bigger hard driveforfree.
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Start by selecting the drive you wantto clean, and then wait while Disk Cleanup exam-
ines variousfiles. The Disk Cleanup dialog box shown in Figure 16-3 (at left) appears
whentheinspection is over. Turn on the checkboxesofthefile categories youdlike
to have cleaned, and then click OK to send them to thedigital landfill.

Tip: The More Options tab ofthis dialog box (Figure 16-3, right) provides links to three other Cleanuppro-
grams of WindowsXP. Its three “Clean up”buttonstake youto the Add or Remove Windows Components
window (which lets you delete Windows modules you don’t use), the main Add and Remove Programs
window (which reveals which programs you haven't used in a while) and a confirmation boxthatlets you
deleteal but the latest restore point, described earlier in this chapter. 

Disk Defragmenter
When you save a new file, Windowsrecords its information onto the hard drive in
small pieces called blocks. On a new PC, Windowslays the blocks end-to-end on the
hard drive surface. Later, when you type more data into a document(thus enlarging
it), the file no longerfits in the same space. Windows XP puts as much ofthefile in
the original location as can fit, but may have to store a few ofits blocks in the next
empty spot on the hard drive.

Ordinarily, you'll never even notice that your files are getting chopped upin this way;
since they open promptly and seamlessly. Windows keepstrack ofwhereithas stored
the various pieces, and reconstitutes them when necessary.

As your drivefills up, the free space that’s left is made up of smaller and smaller
groupsofblocks. Eventually, a new file may notfit in a single “parking place” on the
hard drive surface, since there are no free spacesleft that are large enough to hold
it. In fact, Windows may haveto storea file in several different areas of the disk, or
even hundreds.

Whenyoulater try to open such a fragmentedfile, the drive heads (which read the
disk) must scamperall over the disk surface, rounding up each blockin turn, which
is slower than reading contiguous blocksoneafter the other. Over time, thisfilefrag-
mentation gets worse and worse and may eventually result in noticeable slowdowns
when you openorsavefiles.

Thesolution: Disk Defragmenter, a program thatputs together piecesoffiles that have
become fragmented(split into pieces) on your drive. The “defragger”also rearranges
thefiles on yourdrives to make the operating system and programs load more quickly.
Although Disk Defragmentertakes sometimeto doits thing,a freshly defragged PC
feels faster and more responsive than a heavily fragmented one.
  

Tip: Fragmentation doesn’t becomenoticeable except on hard drives that have been very full for quite a
while. Don't bother defragmenting yourdrive unless you've actually noticedit slowing down. The time you'll
spend waiting for Disk Defragmenter to doits job is much longerthanthefractions of seconds caused by
a little bit of file fragmentation. 
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Defragmenting a Drive
Before you run Disk Defragmenter, exit all programs, disable your antivirus soft-
ware, empty the Recycle Bin, and plan some time away from the PC—remember,
defragging is time-consuming. Depending onthesize of your drive, the number of
files on it, how fragmentedit is, and especially how much free spaceis available, the
Disk Defragmenter can take all day to run,

Defragmenting also puts your hard drive into a temporarily delicate condition.
Therefore, don’t defragmentif your hard driveis ailing, if there’s a thunderstorm,
when your laptop is running on battery, or when you've set up the Task Scheduler
(see page 473) to trigger automatic tasks. 

Tip: During the defragmentation process, Windowspicks up pieces of yourfiles and temporarily sets
them downin a different spot, like somebodytrying to solve a jigsaw puzzle, If your hard drive is very full,
defragmenting will take a lot longer than if you have some empty space available—andif there's less than
fifteen percent free, Windows can't do the job completely. Before you run Disk Defragmenter, then, use Disk
Cleanup and make as muchfreedisk space as possible, 

To open the Disk Defragmenter program, log on using an Administrator account
(page 499), and then use any of these techniques:

* Choose StartAll Programs—Accessories—System Tools—Disk Defragmenter.

* Choose Start>My Computer. Right-clickthe icon ofa hard drive; fromthe shortcut
menu, choose Properties. In the Properties window,click the Tools tab, and then
click Defragment Now.

* Choose Start—Run. Type dfrg.mse and press Enter. 

Tip:Throughout Windows,and throughoutitsbook and magazineliterature, disks are referred to as volumes.
Usually, volume meansdisk. But technically,it refers to anything with its own disk icon in the My Computer
window-—including disk partitions (page 470),Zip disks, DVDs, and so on. Page 440 hasdetails. 

The Disk Defragmenter window opens,listing your hard drives.

1. Click the drive you want to work on.

Unless you have multiple hard drives, the C: drive is already selected.

2. Click Analyze.

The program takes a minute to study the condition ofthe files on your harddrive.
If, in its considered opinion, defragmentingisworth the time andeffort, a message
will tell you so (see Figure 16-4).

3, Click Defragment.

DiskDefragmenter worksbyjugglingfile segments,lifting some into memory and
depositing them elsewhere on the drive, then moving smallerfiles into the newly
created free space. This shuffling process goes on for sometime, asfile fragments
and whole files are moved around until everyfile lies on the drive in one piece.
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Technically, in fact, Defragmenter doesn’t rejoin file fragments randomly. In
restoring them, Disk Defragmenter tries to organize the files better on the hard
drive surface, using logic to position them so that applications will open up as
quickly as possible.

 
 

 

 
 
 
 
 
 
 
 

 
 

Figure 16-4:
Windows lets you know whether or not you'll
gain anything by defragmenting your hard
drive (top). Ifyou're terminally curious, click
View Report, A dialog box then appears (like
ihe one here at bottom), listing each indi-
vidual file on your hard drive and revealing
the extent ofits ragmentation.  

 

  
 

Volume size == 16,61 GB
Cluster size = 16KB
Used space = 9,11 GB
Free space = 9.50 ¢B
Percent free space = 81%   

 
  

A progress bar at the bottom of the window lets you know howfaralongitis. You
can wander away to watch TV—or,if you're fascinated by this kind of thing, you
can watch the colorful graphs (Figure 16-5).

For best results, leave your PC alone while the defragmenting process is going on.If
you absolutely must perform a task at your computer during the defragging process,
click Pause,

 
  

Ifyou saveafile while the drive is being defragmented (whether you pause the program
or not), Disk Defragmenter starts the process over from the beginning,
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Note: Disk Defragmenterisn’t the only toolfor this job. Programslike Norton Utilities include additional
features. For example, becausethey track how often you usethe various files on your drive, they can store
the most frequently used files at the beginning of the disk for quicker access. In some programs, you can
even choose whichfiles go at the beginningof the disk.

Dothese additionalfeatures actually produce a measurable improvementover WindowsXP's built-in defragger?
That's hard to say, especially when you rememberthe biggest advantage of Disk Defragmenter: it’s free,

—ee
 

 

Searaieneensnc ; . aeoa of the
| defragmentation process helps

you understand what Disk
Soot nee Defragmenteris doing. The color

| File System Capacity Free Space %Free... of each fittle square shows what's
] aesca PeeepUled Ecsite Beer going on, as the program juggles

softwarefiles, system files, and data
files to put each file in the bestpos-
sible place. At that point ofperfec-

Estimated disk usage before defragmentation: tion, Disk Defragmenter announces
ae victory over fragmentation and asks

if you wantto close the program.
Say Yes unless you have another
hard drive that needs defragging.

 
Estimated disk usage after defragmentation: 

View Report

WE Fragmented files fi) Contiguousfiles Unmovable files [_] Free space 

 
Hard Drive Checkups

Every time you shut down the computer, Windowstidies up, ensuringall files are
saved properly on the drive. Whenall is well, Windowsturns off the machine(or,
on older computers, displays a message on your screentelling youit’s OK to shut off
your computer manually). The time that elapses between your Turn Off Computer
commandandthe actual power-down momentis the “tidying up” period.

But sometimes, thanks to a system crash, power outage,or toddler playing with your
surge suppressor, your computer gets turned off without warning—and without
the usual shutdown checks. In the days before WindowsXP,restarting the PC after
such a dirty shutdown would automatically run a program called ScanDisk,a utility
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designed to detect and, when possible, repair drive damage that may have occurred
as a result of an improper shutdown.

ScanDisk doesn’t exist in WindowsXP,butits functions have beenreincarnated. You

get to this feature by right-clicking the icon of the hard drive you wantto check (in
the My Computer window). From the shortcut menu,choose Properties; click the
Tools tab, and click Check Now (Figure 16-6, top).
 

Note: Geeks fondly refer to the feature described here as chkdsk (apparently named by someonewith no
vowels onhis keyboard). You canalso get to it by choosing Start—sRun, typing chkdsk, and pressing Enter.

chC ait

Checkups

But the method described here is much better-looking. 

As shown in the middle of Figure 16-6, a box appears, offering two options:

» Automaticallyfix file system errors. Clearly, you wantthis option turned on,so
that any problems Windowsfindsare taken care ofautomatically.Ifyou’re check-
ing the system drive (the drive on which WindowsXP is installed), you'll see the
dialog box shown at bottom in Figure 16-6. Click Yes to defer the actual scan until
the next time you restart the computer. (Other drives get scanned immediately.)

Scan for and attemptrecovery of bad sectors, If you turn on this option, when-
ever the scan finds a damagedsection of a drive,it'll move anyfiles located there
elsewhere on the drive. Then the program surroundsthat hard-disk area with the
digital equivalentofa yellow “Police Line—Do Not Cross”tape, so that Windows
won't use the damaged area for storingfiles in the future.

FREQUENTLY ASKED QUESTION

WhenGood Drives Go Bad

i was surprised when the Check Disk didlog box found
some problems with my hard drive. | dont understand
what could have gone wrong. | treat my PC with respect
CClGLa erentPEATcle]Con ATTLLLELCER LAAN OIC aLA
KCMelHemeraMila].s'2y

All kinds of things can cause problems with yourhard drive,
but the most common are low. voltage, power outages,
voltage spikes, and mechanical problems with the drive
controller or the driveitself.

An inexpensive gadget called a line conditioner (sold at
computer stores) can solve the low-voltage problem. A more
PSHn aranlel daeeCeN eANUIETRMDaries(ede)(arg vt2)a1
{UPS) maintains enough backup battery power to keep your
computer going when the power goes out completely—for
a few minutes, anyway, so that you can shut down the
computer properly. The more expensive madels have line

 

CeoheT6NOescaeLtefeA OLRAIORsLueTnGSanto el=
CONG}Lota Createaeovals9) mIRN 08Leta} toxck

Voltage spikes are the most dangerous to your PC. They
frequently occur during thefirst seconds when the power
RaorTroieiPYei@ Tela csi LO)elmOMAESCPs\nxccxtOly
is the logical defense here, But remember that the very
cheap devices often sola as surge suppressors are actually
litte more than extension cords. Furthermore, someaf the

models that do provide adequate protection are designed
to sacrifice themselvesin battle. After a spike, you may have
to replace them:

ILyou care about your computer(orat least about the money
oli selanlaeMOMoU Meare(eRecmAUelytraoma
UetoauengowentecM NMA RAUrcIe- iccien tatsMea LeTGSpel19)
will replace your equipment (up to a certain dollar value) if
the unit fails to provide adequate protection.
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Pea Before you begin the scan, quit all other open programs; otherwise, Windowswill
report that it was “unable” to complete the scan. Finally, click the Start button in the
Check Disk dialog box to begin the scan. Whenall phases of the check are complete
(“Phase 1, Phase 2”..), a dialog box lets you know how things turned out. 

Nofe: if you elected to format your hard drive with the N7ESfile system, described on page618, you'll find
hard-drive glitches fixable by ScanDisk and its descendant to be extremely rare, because NTFS drives are
designed to be self-repairing.

if you still use the FAT 32 formatting scheme, however,it's a goodidea to perform this kind of check once
every few months, so that it can check your hard drive for any nascent problems.

Local Disk fenehontce vale: i Figure 16-6; ;
napeye 55 a Top:Click Check Now in

General] Tools |Hatdware | Sharing) Quolaj a the Properties dialog box
Erorohecking ~ “ | : for your hard drive.

aes, ReGencoereselrs of Middle: Click Start to be-
gin the scan, which checks
thefile structure, folders,
files, and other elements
on your drive.Checkdisk options

Automatically fic file system errors . | Bottom: You may beDefragment Now... if .
[Seen for and attempt recovery of bad sectors iE asked to restart the PC, so

:f that the Son ofScanDisk
ie cc! thas adn, ip can doits thing during

the startup process. Ifyou
[ BackupNow. | | | click Yes, nothing seems to

happen atall. Windowsis
just holdingits breath until

aan —_— ss you actually restart. Dur-
Cee itedNrOm Odsal MereEE fd eh ing the lengthyprocedure,

w The disk check could not be performed because the disk check utility needs exclusive access tc some Windows Hes on [P onscreen messages Serve
iJ the disk. These les can he accassed only by restarting Windows. Oo you want to schedule this disk check ko occur | up Status reports. Whenthe next time you restark the computer? "

it’s over, the computer
[Lm] | restarts

 
Disk Management
“Disk management”isn’t just a cool, professional-sounding skill—it’s the name of
yet anotherbuilt-in Windows XP maintenance program,onethat may be familiar to
Windows 2000 veterans, but is completely new to people who are used to Windows
Meandits predecessors.

To open this technical database of information about yourdisks and drives, you can
use any of three methods:
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* Choose Start>Control Panel—Administrative Tools—>Computer Management.

In the resulting Computer Management window, double-click Disk Management
in thelist at theleft side.

 
«In the Start menu, right-click My Computer. From the shortcut menu, choose

Manage. Once again, double-click Disk Managementin thelist at the left side.

* Choose Start—Run; type diskmemt.mse and press Enter.

In anycase, you arrive at the window shownin Figure 16-7. Atfirst glance,it appears
to be nothing more than a table of every disk (and partition of every disk) currently
connected to your PC.In truth, the Disk Management windowis a software toolkit
that lets you operate on these drives, too. For example, Chapter 15 describesin detail
how youcan use this window to slice and dice the free space on yourdrives into new,
combined “virtual disks” (volumes),

Figure 16-7;
The Drive Management
window is part af the
much bigger, much
moretechnicalentity
known as the Computer
Management console.
You accessit by clicking
Disk Management (in
the jeft-side pane). Then
you can operate on your
drives by right-click-
ing them. Don't miss
the View menu, by the
way, which lets you
change either the top
or the bottom display.
For example, you can
make them display aif
ofyour disks instead of
your volumes(there’s a
difference).

Change a Drive Letter

La ef]

HG System tosis Barkin Basic NTFSEvent viewer BED cena: ae rete
Hal Shaved Folders

“A Performance Logs and
A Device Manager

a Storage
a Removable Storage

P Disk. Defragmenter
a Disk Managenient
fe Services and Applications

  "> Healthy

 

Healthy (System) 44,5968 1.42 dR
aot Me OMB

As you've probably noticed, Windowsassigns a drive letter to each disk drive associ-
ated with your PC. The floppydisk drive is always A:, the primary internal hard drive
is generally C:, and so on. Amongother places, you see these letters in parentheses  
following the namesofyourdrives, as when you choose Start-—>My Computer.
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Disk Management Windowsgenerally assignstheseletters in the order that you install new drives to yourcbse system. You're not allowed to change thedrive letter of your floppy drive or primary
hard drive (usually the C: drive). You can, however, override the standard, unimagina-
tive Windowsletter assignmentseasily enough, as shownin Figure 16-8.
   

Note: \f Windows XPis currently usingfiles on the disk whose drive letter you're trying to change, Disk
Management might create the new drive letter assignment but leave the old oneintact until the next time
yourestart the computer. This is an effort not to pull the rug out from under any openfiles. 
  

Figure 16-8:
Right-click a drive
icon as shown in

Figure 15-7, From
the shortcut menu,
choose Change
Drive Letter and
Paths.

Left: In this dialog
box, click Change.

Change Drive Letter or Pattcalcd]
Allow access to this volume by using the following diveletter and paths:

Change Drive Letter-and Paths for D: ()   
 
 
 

  

Entet a new driveletter or path for D: ().

(@) Assign the following ditve letter:   
Right: Then choose
a letter that hasn't

already been as-
signed. Click OK,
and then approve
your action in the
confirmation box.

 
 

Partition a New Drive

The vast majority of Windows PCshave only onehard drive, represented in the My
Computer window as a single icon.

Plenty of powerusers, however, delight in partitioning the hard drive—dividing
its surface so that it appears on the screen as two different icons with two different
names.At that point, you canlive like a king, enjoying the following advantagesjust
like people who have twoseparate hard drives:

the other, so that you can switch between the twoat startup time. (You may hear
this feature called dual booting, a procedure described on page 617.)

+ Life is mucheasier if you frequently install and reinstall the operating system, or
different versions of it. Doing so allows you to keepall yourfiles safely on one

- You can keep Windows XP on one of them and Windows Me(for example) on

partition, confiningall the installing/uninstalling activity to the other.

+ You can use multiple partitions to keep your operating system(s) separate from
folders andfiles. In this way, you can performacleaninstall ofWindows(page 616)

  

4&8 WINDOWSXP PRO: THE MISSING MANUAL |

HP Inc. - Exhibit 1007 - Page 502



HP Inc. - Exhibit 1007 - Page 503

onto one partition without having to worry about losing any of your important
files or installation programs.

Unfortunately, partitioning a hard drive using the tools built into Windows XP re-
quiresfirst erasing the hard drive completely. Andthat, of course, involves copyingall
of your files and programs onto somekind of backup disk first—and then copying
them back onto the hard drive when the process is over. Ponder this compromise,
weighingit against the advantagesofpartitioning. 

Tip: You canpartition your hard drive without having to erase everything on it—just not for free. Commercial
programs like PartitionMagic (immpowerquest. com) create, resize, merge, and convert partitions without
disturbing any of yourfiles. 

The Disk Management program included with Windows XP, therefore,is best suited
for creating new partitions on new or empty hard drives. Ditto for FDISK, a DOS
utility that can also do the job (as described in Appendix A).

In the Disk Managementwindow,free space (suitable for turningintoa partitionofits
own) shows up with a black bar andthelabel Unallocated, Figure 16-7, for example,
depicts a brand newhard drive that hasn't yetbeen namedor sliced upinto partitions.
The whole thingis still “unallocated.”

To create a new partition, right-click one of these unallocated segments. From the
shortcut menu, choose New Partition. A wizard appears, whosescreensask you:

* Whatkindofpartition you wantto create. (You'll usually want Primary.)

* How big you wantthe partition to be. Ifyou're dividing up a 60 GB drive,for ex-
ample, you might decide to makethefirst partition 20 GB and the second 40 GB.
You'd begin by creating the 20 GB partition (right-clicking the big “Unallocated”
bar in Figure 16-7); when that was over, you'd see a smaller “Unallocated” chunk
still left in the Disk Management window. You'd right-click it and choose New
Partition again, this time accepting the partition size the wizard proposes (which
is all the remaining free space).

* Whatdrive letter you wantto assign toit.

* What disk-formatting scheme you want to apply to it (you'll usually choose
NTFS—see page 618).

Whenthe wizard is through with you,it’s safe to close the window. A quick look at
your My Computer window will confirm that you now have new “disks” (actually
partitionsof the same disk), which you can usefor different purposes. 

Note:Partitioning and disk managementcan go evenfarther. You can resize yourdisk volumes, combine
the space from multiple disks into one large volume, and perform other advancedstunts, as described in
Chapter15.  

 

CHAPTER 16:4 MAINTENANCE,BACKUPS, AND TROUBEESHOOTING|at 1007 - Pag6503nc. -

teenEyert'

 
 
|



HP Inc. - Exhibit 1007 - Page 504

Turn a Drive into a Folder
Talk about techie: Most people couldgotheirentirelives without needingthisfeature,
or even imagining thatit exists. But Microsoft loves powerusers, and this one’s for
them.

Usingthe Paths feature of Disk Management,you can actually turn a hard drive (or
partition) into a folder on another hard drive (or partition). Each of these disks-
disguised-as-foldersis technically known as a mounted drive, junction point, or drive
path. See Figure 16-9 for details.

This arrangementaffords the following unique possibilities:

- In effect, you can greatly expand capacity of your main hard drive—by installing
a second hard drive that masqueradesas a folder onthefirst one.

» You can turn a burned CD into a folder on your main hard drive, too—a handy
wayto fool your programsinto thinkingthatthe files they’re looking for are stillin
the sameoldplace on your harddrive. (You could pull this stunt in a crisis—when
the “real” folder has becomecorruptedor has been thrown away.)

- Ifyou're apower poweruserwith lots ofpartitions, disks, and drives, you may fee]
hemmedin bythelimitation of only 26 assignableletters (A through Z). Turning
one of your disks into a mounted volume bypasses thatlimitation, however. A
mounted volumedoesn’t need a driveletteratall.

: A certain disk can be madeto appear in more than one place at once. You could
put all your MP3files on a certain disk or partition——and then make it show up
as a folder in the My Musicfolder of everyone whouses the computer.
 

Note: Youcan only create a mounted volume on an WFS-formatted hard drive (page 618). 

To bring aboutthis arrangement, visit the DiskManagementwindow,and then right-
click the icon of the disk or partition that you wantto turn into a mountedvolume.
From the shortcut menu, choose Change Drive Letter and Paths.

In the Change Drive Letter and Paths dialog box, click Add; in the next dialog box,
click Browse. Navigate to and select an empty folder—the one that will represent
the disk. (Click New Folderif you didn’t create one in advance, as shown atright in
Figure 16-9.) Finally, click OK.

Once the deed is done,take time to note a few special characteristics of a mounted
volume:

* The mounted volume may behavejustlike a folder, but its icon is a dead giveaway,
sinceit still looks like a hard drive (or CD drive, or DVD drive, or whatever).

Still, if yowre in doubt about whatitis, you can right-click it and choose Proper-
ties from the shortcut menu.You'll see that the Type information says “Mounted
Volume,” and the Targetline identifies the disk from which it was made.
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» Avoid circular references, in which you turn two drives into folders on each other.
Otherwise, you risk throwing programsinto a spasm ofinfinite-loop thrashing.

brErtiy

* To undo your mounted-driveeffect, return to the Disk Managementprogram
and choose View—>Drive Paths. You're shownalistofall the drives you’ve turned
into folders; click one and then click Remove. You'vejust turned thatspecial, “I’m
really a drive” folder into an ordinary empty folder.
 

 
 
 
 
 
 
 
 
 
 
  
 

 

Figure 16-9:
Left: Man, howmany CD
drives doesthis guyhave?Just 5 ee eS
one. But through the miracle sack - E> cP joSearch 2
ofmounted volumes, it’s ap-
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pearing in as manydifferent
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Task Scheduler

The Scheduled Tasks window lets you set up Windows XP to open certain programs,
utilities, and documents according to a schedule that you specify. Unfortunately, all
it can do is open programs and documents on cue. Unless you're prepared to type in
the special codes, called switches, the Scheduled Tasks window can’t actually make
them do anything once they’re open.Thetutorial on page 494 offers more informa-
tion about switches.

To open the Task Scheduler(see Figure 16-10), choose Start—All Programs—> Acces-
sories—>System Tools—Scheduled Tasks. The Scheduled Tasks windowopens,atfirst
containing onlyasingle icon (unless a program you've installed hasalready scheduled
a task), called Add Scheduled Task.

Addinga Task to the Scheduler
To add a task to the schedule, double-click the Add Scheduled Task icon. A wizard
appears;click Next. A list of programs now appears on your PC (Figure 16-10, bot-
tom left). If the one you wantto scheduleis listed,click it. If not, click Browse, find
and openits folder, and double-click its icon.
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To create a drive: path, select an empty folder. To create a folder,
in the folowing fist.
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Task Scheduler Now you're asked how often you wantthe new task to run:every day, every week, andParecoalae| so on. Makea selection, then follow the wizard’s prompts to schedule yourtask. For
example, if you chose Monthly, you can tell the wizard which day of the month, and
at which time (Figure 16-10, bottom right).

& Scheduled Tasks Pe i b4 Figure 16-10:
Top: The Task Scheduler

——— keeps a calendar for
[SthediedTasks Windows XP. Tasks

; Schedule appearin the schedule
{ladd Scheduled Task - ae when you enter them

z Disk Cleanup At 2:30 PM every Sun of every weak, oo. 3000 PM 3... manually, or when other
G Conti<d Perel . 4 Backup At 12:10 SM every day, starting 3/31)... 12:10:00 4M .., programs (such as the

i Cy My Documents Maintenance Wizard)
Be ) Shered Docunvents ‘ set them up. You can
PS My Network Places use the Task Scheduler

(careers Sasa window to add, modify,
or remove tasks. (Make
sure your computeris

aa eee turned on during the
Scheduied Task Wizard ie time anytask is sup-

“ zs posedto run.)

Fie Edt View Favorites Tools Advanced Help
Search

   
Click the program you want Windows to run. *
To see mote pregiams. click Browse, . i

SelectUe tine and day you wartthis tank tostat | Bottom: The wizard
; [Agpieaion FTVesion JB gta tire | asks you what you want
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Finally, because Windows XP can accommodate multiple user accounts (see the next
chapter), and can even run your tasks while somebodyelse is logged in and using the
computer, you'll have to enter your user name and password.

Completing the wizard means you've successfully added a new iconto the Scheduled
Tasks window (Start—>Control Panel—Scheduled Tasks).If the windowis in Details
view, tidy little columnstell you what each task’s schedule is and when it will run
next.

Changing Scheduled Tasks
Double-clicking a task’s listing in the Task Scheduler window opensits Properties
dialog box (Figure 16-11), where you can make several kinds of changes:

492 WINDOWSXP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 506
 



HP Inc. - Exhibit 1007 - Page 507

 
 
 
 

 
 
 

« Cancel a scheduled task. You can, of course, stop a certain scheduled task from run-
ning just by deleting the task entirely—throwing awayits icon from the Scheduled
Tasks window. In manycases, however, you mightfind it more flexible to simply
turn off its Enabled checkbox (on the Task tab of the Properties dialog box). The
Jatter method leaves the task in the Task Scheduler window, so that you can turn
it back on at a later date.

Change the schedule for a task. Click the Schedule tab of the Properties dialog
box to change the schedule for a task.

Changethe settings for a scheduled task. Using the Settings tab of a task’s Proper-
ties dialog box, you can design certain automated tasks to run, or not, according
to certain conditions (see Figure 16-11). For example, you might want to turn on
“Onlystart the task if the computer has been idle for at least__ minutes,” so that
your processor-intensive task doesn’t fire itself up when somebodyelse (using
another account) is rendering 3-D movie scenes.

Figure 16-37:
Some of the factory settings for scheduled tasks
are a bit ridiculous. For example, it's probably
a good idea to stop a task if if runs longer than
4 or 5 hours, not 72 hours. in fact. except for
defragging the hard drive, most scheduled

"tasks should take fess than an hour. The bot-

tom section of the dialog box applies to laptop
computers.

 
 

) Start a Task immediately
~ To trigger oneofthelisted programsright now,right-clickits listing in the Scheduled

» Tasks window and choose Run from the shortcut menu.(Thetask will run again at
-* its next scheduled time.)
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Task Scheduler Pause All Scheduled Tasks
If a schedule-triggering eventis taking place on your PC while you're trying to work,
thus slowing down the proceedings, you can suspend those background operations
until your work is complete. Just open the Scheduled Tasks window and choose Ad-
vanced—>Pause Task Scheduler.

Whenyouthinkit’s OK for those background-scheduled tasks to carry on, “unpause”
the scheduler by choosing Advanced—Continue Task Scheduler.

Stop Using Task Scheduler
Ifyou don’t wantanytasks to run,ever, open the Scheduled Tasks window and choose
Advanced—Stop Using Task Scheduler. Doingso prevents the scheduler from starting
up when you turn on the computer. (Choose Advanced—Start Using Task Scheduler
to turn it back on.)
 
 

Note:You can request that Windows XP notify you, the next time you log on, whena task didn’t run at
its appointed time (because the PC wasturedoff, for example). To set this up, open the Scheduled Tasks
window and then choose Advanced—Notify Me of Missed Tasks. 

A Disk Defragmenter Example
Before the invention of the mouse, menus, and icons, computer geeks operated their
machinessolely at the command line—a black windowwhere you had to type cryptic
commandsto get anything done.

Windows XP still has a commandline (Start—All Programs—>Accessories—
Command Prompt). Most everyday Windowsfans don’t even know it’s there—but
it comes in handy every now andthen. You need the commandline, in fact, to use
the Task Scheduler.

To make matters evenless user-friendly, remember thatWindowsdoesn’tcall programs
by the same namesyoudo. (Microsoft Word,for example,is really a program called
winword.exe.) To run a program from the commandline, you have to call it by the
same name Windowsuses. You can find whatthatis by right-clicking the program’s
icon in the Start menu,choosing Properties from the shortcut menu, and looking at
the Targetfield in the Properties dialog box.

That’s only one ingredient you'll need to run a program from the commandline—the
others are command parameterscalled switches. These are usually dashes or slashes
followed by letter and number combinations,like the secondpart of the command
ping —t, andtheytell the program what to do once you've openedit. Task Scheduler
runs programsby executing commandlinestrings like this.
Putting together the correct switches to trigger the activity you wantis not for the
technically timid. But ifyou'd like to knowwhat youregettinginto, here’s an example
that demonstrates how to schedule DiskDefragmenter to run at a specific time (when
youresleeping,for example, and won't care thatit’s slowing down your PC). In fact,
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this is one of the most commonusesof the Task Scheduler: usingit to trigger com-
mon maintenance tasks without your involvement.

Programming Disk Defragmenter
To schedule a program like Disk Defragmenter, you mustfirst learn what switches
it understands.

To discoverwhich switches are available in aWindows XP program, open a Command
Promptwindow (Start—All Programs—>Accessories—>Command Prompt). Then type
the nameofthe program,followedby eitherthe -h or-? switch. (Both of these mean
“help.”) For example, you can find out which switches drive Disk Defragmenter by
typing this:

Defrag -?

When youpress Enter, a help screen like this appears:

Usage:

Defrag <volume> [-a] [-f] [-v] [-?]

volume Drive letter or mount point d:\ or d:\vol\mountpoint
-a Analyze only

-f£ Force defragmentation even if free space is low

-v Verbose output

-? Display this help text

From this, you might discern that the command necessary to run the Disk
Defragmenter on your hard drive (C:) is this:

Defrag C:\ -£

which means, “Use the defrag command on my C:drive; defragmentit even if I don’t
have muchfree space.”

Always test your commandline before youscheduleit to run unattended.If the com-
mand behavesitself while you're watching, you can be confident that it will do the
same when Task Scheduler runs unattended.

To schedule the command, open the Scheduled Tasks program in the ControlPanel.
Double-click the Add Scheduled Task icon. The Scheduled Task Wizard appears;click
Next to see thelist ofprograms that the Task Scheduler offersto trigger.

However, Disk Defragmenterisn’t listed, so you must click Browse and navigate to
the Local Disk (C:)>Windows—System32folder, where you'll findit (the program’s
real nameis defrag.exe). Double-click it, and then proceed with the wizard screens
that let you specify a schedule and record your account password. You can schedule
the program to run onceorat regular intervals, and even create multiple schedules
for the sametask. (Ifyour user account doesn’t have a password assigned, you'll have
to create one, following the instructions on page 519.)

Onthefinal wizard screen, don’t click Finish until you've first turned on “Open ad-
vanced properties for this task when I click Finish.” After you click Finish, a special
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Pyeye summarywindow appears,listing the program to be run: C:/WINDOWS/SYSTEM32/
defrag. exe. Click in the Run boxat the end of the command,press the Space bar, and
then type C:\ (or whatever the drive letter is), another space, and then -f, as shown
in Figure 16-12. Click OK.

  
Figure 16-12:
Disk Defragmenteris readyto roll. You've just
told Disk Defragmenter to defrag the E: drive,
and-thanksto the “-f" switch-to run whetherit

en EAWINDOWS\Tasks\defragjob | thinks you need it or not.
Task | Schedule | Settings|

Aun: EAWINDOWS\epstema2\defragexeENF

, Browse...

Startin FEAWINDOWS\aystem32_— 
Comments:

 
j

Run as: [CZ3xP\Administrator Set password...

Enabled (scheduled task runs at specified time}

   
Finally, you’re asked to type in your password—twice. When you click OK, your
work is done. An icon for your scheduled task appears on the screen for the Disk
Defragmenterschedule that you've just added,andit’s prepared to run automatically
at the times you specified.

Interpreting Results
If you switch the Scheduled Tasks window into Details view by choosing View
Details, the Last Result column is supposed to tell you whether or not the tasks you
scheduled were completed. Unfortunately, Task Scheduler doesn’t translate the nu-
merical result codes into English, so whatyousee in this column is typically a cryptic
hexadecimal value like 0x0.

All you have to know aboutsuch exit codesis that, in most cases, a value of 0 (or 0x0)
means that the program ran withouta hitch. Anythingelse represents some kindof
error message.If that’s what youget, you, or somebodywho knowsaboutthis kind of
thing, should try running the commandin the Command Prompt windowin hopes
of discovering whyit’s not workingcorrectly.
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Microsoft Backup

Consider this: The proximity of your drive’s spinningplatters to the head that reads
them is roughly the same proportion as the wheelsof anairliner flying at 500 miles
per hour, twelve inches off the ground.It’s amazing that hard drives work as well,
and as long, as they do.

 
Still, because a hard drive is nothing more than a mass of movingparts in delicate
alignment, every now and then disaster strikes. That's why backing up your data
(making a safety copy) on a regularbasis is an essential part of using a PC. Evenif
computers aren't your career, there’s probably a lot of valuable stuff on your hard
drive:all ofyour digital photos, the addresses and phone numbersyou've spenthours
typing into your Contactslist, a lifetime’s worth of email, the Web sites in your Fa-
vorites folder, and so on.

Now,ifyou use XP Pro in a corporation—a distinct possibility, consideringits target
audience—you probably don’t even have to think about backing up your stuff. A
network administrator generally does the backing up for you and your co-workers.
(You're probably instructed to save yourfiles on a network server PC instead of your
own, so that the administrator can back up all of the employees’files in one swift
move.) In that case, you can flip to more interesting sections of this chapter.

If you use Windows XP at home,or in a smaller company that doesn’t have network
nerds running around to ensure your files’ safety, you mightbe grateful for Microsoft
Backup, a very simple backup program that comes with WindowsXP. It lacks some of
the specialized features of commercial backup programs, butatleast it lets you back
up entire drives or selected files and folders, at times and under the conditions you
specify, to other disks or tapes. You can even scheduleit to run at regular intervals
(using the Task Scheduler program), so that you always have a recent copy of your
data on hand.

Backup Hardware
An external hard drive makes an extremely convenient backup system,since it
spares you the hassle of inserting and tracking multiple removable disks (like Zips
or CDs).

Still, removable disks are the safest disksofall, because you can store them somewhere
else: in a fireproof box, a safe deposit box at the bank, or the trunk of your car—any-
where but in your office, making your data safe even in the case of fire or burglary.

Here’s a rundown of popular removable backup disks:

* Floppy disks. Forget it. Unless you work with nothing more than a few text files,
your stuff will never fit onto floppies.

* Zip, Jaz, Peerless. When it comes to removable cartridge drives like these from
lomega, consider capacity and expense. The older Zip cartridges, which hold 100
or 250 MB, may be too small for most backup purposes. The newer 750 MBdrives
are a better bet.
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ieeeairtelg Jaz and Peerless cartridges can hold a lot more, but they’re expensive. Divide the
numberofmegabytes by the cartridge price to figure out which is the most cost-
effective.

: * Recordable CD. Burning your backups onto blank CD-R and CD-RW (or even
blank DVD) disks is another viable alternative—especially since blanksare dirt
cheap. Unfortunately—andincredibly—theWindows XP Backup program doesn’t
recognize CD-ROM or DVD-ROMdrives as backup devices.

Manyother backup programs do, however. Your CD/DVD burner may even have
comewith one. As long as you don’t have manygigabytesoffiles to back up, this
system can workwell.

* Tape cartridges. Magnetic tapes are economical, retain their data for years, and
offer huge capacity in a compact package.Better yet, Microsoft’s Backup program
works with them. Tape drives are available in either external USBversionsor in-
ternal units that you install yourself.

The main drawback ofa tape system is that you can’t useit for anything other
than backups. You can’t get to a file at the end of the tape withoutfast forward-
ing through all of the data that precedesit, so you wouldn’t wantto use these as
everyday disks.

Creating a Backup Job
To launch the Backup program, choose Start—All Programs—Accessories—System
Tools—»Backup. A wizard walks you through the process ofsetting up a backupjob,
like this:

Backup or restore?
Thefirstwizard screen (Figure 16-13, top) wants to knowwhetheryou wantto back up
your files (because you're a shrewd, confident, happyperson in a time ofPC health) or
restore them (because you're a desperate, unhappy person whosefiles have somehow
been deleted or corrupted).

To back up yourfiles, of course, click “Backup files and settings” and then click
Next.

Create a backupjob :
Thenext wizard window asks what you want to back up:

* My documents andsettings, Everyone’s documents and settings. These options
assume that you're using a PC shared byseveral people, each with a separate ac-
count (see the next chapter). It’s asking whether you want to back up just your
files and settings, or those of every account holder. (If you're the sole proprietor
of your machine,just use the first option.)

+ All information on this computer. This option tells Backup to copy every single
file and folder on your drive(s), including almost two gigabytes ofWindowsitself.
This is a massive project—and,in general, an unnecessary one.Afterall, you already
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have a backup ofWindowsitself (on your Windows CD) and ofyour programs (on
the original software disks), so there may not be much point in making another
copy.

* Let me choose what to back up. This option leads to a Windows Explorer—like
display (see Figure 16-13, bottom) that lets you choose the specific folders and
files to be backed up.
 

Tip: If you choosethis option, don’t miss the System State icon.Selecting this icon backs up the Windows
XP registry {page 661) andothervital system components that are otherwise inaccessible because they‘re
in use while the backup is running. In case of disaster, only people who backed up the System State will be
able to completely restore their PCs to their original conditions,

Figure 16-13:
Topleft: Microsoft Backuplets
youeither back up or restore
yourfiles.

Bottom right: Expandthe listing
of drives and folders by clicking
the plus signs. Turn on the
checkbox next to any folder
orfile that you want backed
up. To deselectafile, turn off
its checkbox. Don’t forget that
you can drag the gray, verticat
divider bar to widen the left

panel,

Seiect the backup medium

Backup er Restore
‘You can back up Fles and settings, or restore them fram a previaus backup.

Items to Back Up
‘You can back up any combination of drives, folders, of files.

3 My Computer

a
FRIES: Little Nations

i

My Documents
ie Fas

ie My Music
ge My Pictures

i ba

21 BlCaptiva Island O04.
) Bal 3 CaptivaIsland 006...
. me #9 Captiva tsland O06...

G&A lef Cantiva island O07...

The next screen asks where you wantto store the backup files you're aboutto cre-
ate. The drop-down list starts out suggesting that you back up your hard drive onto
floppy disks—not exactly a forward-thinking choice. Considering the massive size of
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